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Preface

How to Use This Guide

About the System  The guides listed below are shipped with the Applied Biosystems StepOne™ and
Documentation  StepOnePlus™ Real-Time PCR Systems (StepOne™ and StepOnePlus™ systems).

Guide Purpose and Audience PN
Applied Biosystems StepOne™ and Explains how to perform experiments on the StepOne and 4376786
StepOnePlus™ Real-Time PCR Systems StepOnePlus systems. Each Getting Started Guide functions as
Getting Started Guide for Genotyping both:
Experiments e A tutorial, using example experiment data provided with the
Applied Biosystems StepOne™ and ASpplleOd BTlMosy?tems StepOne™ Real-Time PCR Software 4376787
StepOnePlus™ Real-Time PCR Systems (StepOne ™ software).
Getting Started Guide for e A guide for your own experiments.

Presence/Absence Experiments Intended for laboratory staff and principal investigators who

perform experiments using the StepOne or StepOnePlus

4376785
system.

Applied Biosystems StepOne™ and
StepOnePlus™ Real-Time PCR Systems
Getting Started Guide for Relative
Standard Curve and Comparative Cy

Experiments

Applied Biosystems StepOne™ and 4376784
StepOnePlus™ Real-Time PCR Systems
Getting Started Guide for Standard Curve
Experiments

Applied Biosystems StepOne™ and Explains how to install and maintain the StepOne and 4376782
StepOnePlus™ Real-Time PCR Systems StepOnePlus systems.
Installation, Networking, and Maintenance

Guide Intended for laboratory staff responsible for the installation and

maintenance of the StepOne or StepOnePlus system

Applied Biosystems StepOne™ and 4376783
StepOnePlus™ Real-Time PCR Systems
Installation Quick Reference Card

Applied Biosystems StepOne™ and Provides information about the reagents you can use on the 4379704
StepOnePlus™ Real-Time PCR Systems StepOne and StepOnePlus systems, including:
Reagent Guide

¢ An introduction to TagMan® and SYBR® Green reagents

e Descriptions and design guidelines for the following
experiment types:

— Quantitation experiments
— Genotyping experiments
— Presence/absence experiments
Intended for laboratory staff and principal investigators who

perform experiments using the StepOne or StepOnePlus
system.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard vii
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How to Use This Guide

Guide Purpose and Audience PN

Applied Biosystems StepOne™ and Explains how to prepare your site to receive and install the 4376768
StepOnePlus™ Real-Time PCR Systems StepOne and StepOnePlus systems.

Site Preparation Guide Intended for personnel who schedule, manage, and perform the

tasks required to prepare your site for installation of the StepOne
or StepOnePlus system.

Applied Biosystems StepOne™ Real-Time | Explains how to use the StepOne software to: NA

PCR Software Help e Set up, run, and analyze experiments using the StepOne and

StepOnePlus systems.
e Monitor networked StepOne and StepOnePlus instruments.
e (Calibrate StepOne and StepOnePlus instruments.

e \Verify the performance of StepOne and StepOnePlus
instruments with an RNase P run.

Intended for:

e Laboratory staff and principal investigators who perform
experiments using the StepOne or StepOnePlus system.

e Laboratory staff responsible for the installation and
maintenance of the StepOne or StepOnePlus system.

Assumptions This guide assumes that you:
* Are familiar with the Microsoft Windows® XP operating system.
* Are familiar with the Internet and Internet browsers.
* Know how to handle DNA and/or RNA samples and prepare them for PCR.
» Understand data storage, file transfer, and copying and pasting.

* Have networking experience, if you plan to integrate the StepOne or StepOnePlus
system into your existing laboratory data flow.

Text Conventions This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

* [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File » Open.

User Attention  Two user attention words appear in Applied Biosystems user documentation. Each word
Words implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! — Provides information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

viii Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
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How to Obtain More Information

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection, you need a valid user ID.

Safety Alert  Safety alert words also appear in user documentation. For more information, see “Safety
Words Alert Words” on page xiii.

How to Obtain More Information

Related Other StepOne and StepOnePlus System Documents

Documentation The documents listed in the table below are not shipped with the StepOne or

StepOnePlus instrument.

Document PN

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376791
Installation Performance Verification Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376790
Installation Qualification-Operation Qualification Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376788
Planned Maintenance Protocol

Documents Related to Genotyping Experiments

Document PN

Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212

Card

Custom TagMan® Genomic Assays Protocol 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204

Performing a Custom TagMan® SNP Genotyping Assay for 96-Well Plates Quick 4371394
Reference Card

Performing a TagMan® Drug Metabolism Genotyping Assay for 96-Well Plates 4367636

Quick Reference Card

Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214

TagMan® Drug Metabolism Genotyping Assays Protocol 4362038

TagMan® SNP Genotyping Assays Protocol 4332856
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard iX
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Documents Related to Presence/Absence Experiments

Document PN
DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal 4343586
Swabs Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol
PrepMan® Ultra Sample Preparation Reagent Protocol 4318925

Documents Related to Relative Standard Curve and Comparative C; Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859

Documents Related to Standard Curve Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
X Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
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Documents Related to the Reagent Guide

Document PN

Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Custom TaqgMan® Genomic Assays Protocol: Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Power SYBR® Green PCR Master Mix and RT-PCR Protocol 4367218
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
Primer Express® Software Version 3.0 Getting Started Guide 4362460
SYBR® Green PCR and RT-PCR Reagents Protocol 4304965
SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol 4310251
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® Exogenous Internal Positive Control Reagents Protocol 4308335
TagMan® Fast Universal PCR Master Mix (2X) Protocol 4351891
TagMan® Gene Expression Assays Protocol 4333458
TagMan® Gene Expression Master Mix Protocol 4371135
TagMan® Genotyping Master Mix Protocol 4371131
TagMan® SNP Genotyping Assays Protocol 4332856
TagMan® Universal PCR Master Mix Protocol 4304449
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Using TagMan® Endogenous Control Assays to Select an Endogenous Control 127AP08
for Experimental Studies Application Note

Note: For more documentation, see “How to Obtain Support” on page xii.

Obtaining The StepOne Software Help describes how to use each feature of the user interface.
Information from  Access the Help from within the software by doing one of the following:
the Software Help . pss FI.
* Click @ in the toolbar.
+ Select Help » StepOne Software Help.

To find topics of interest in the Help:
* Review the table of contents.
» Search for a specific topic.
» Search an alphabetized index.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard Xi
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How to Obtain Support

Send Us Your Applied Biosystems welcomes your comments and suggestions for improving its user
Comments documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and
suggestions relating to documentation. To order documents, download PDF files, or for
help with a technical question, go to http://www.appliedbiosystems.com, then click the
link for Support. (See “How to Obtain Support” on page xii).

How to Obtain Support

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click the link for Support.
At the Support page, you can:

» Search through frequently asked questions (FAQs)

* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents

* Download PDF documents
* Obtain information about customer training
» Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers
to contact Applied Biosystems Technical Support and Sales facilities.

IMPORTANT! When directed to do so by this guide, or when you need to schedule
maintenance for your StepOne™ or StepOnePlus’" instrument (such as annual planned
maintenance or temperature verification/calibration), contact the Applied Biosystems
Care Center. To obtain a phone number for or to send an email to the center, go to
http://www.appliedbiosystems.com/support/contact.

Xii Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
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Safety Conventions Used in This Document

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below.

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

A (o:.\UI{e]N] — Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to alert against unsafe practices.

AWARNING — Indicates a potentially hazardous situation that, if not avoided,

could result in death or serious injury.

A PL\[e]338 — Indicates an imminently hazardous situation that, if not avoided,

will result in death or serious injury. This signal word is limited to the most extreme
situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems
instruments (see “Safety Symbols” on page xv).

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard Xiii
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Symbols on Instruments

Examples

IMPORTANT! You must create a separate sample entry spreadsheet for each 96-well

plate.

_ (.\1)i[e]]] CHEMICAL HAZARD. TagMan® Universal PCR Master Mix

may cause eye and skin irritation. Exposure may cause discomfort if swallowed or
inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.

AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the

the heated cover and sample block can reach temperatures in excess of 100 °C.

A L[] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation. Never operate the system with the grounding conductor disconnected.

Symbols on Instruments

Electrical

Symbols Applied Biosystems instruments.

Symbol

Description

Symbol

The following table describes the electrical symbols that may be displayed on

Description

Indicates the On position of the
main power switch.

Indicates the Off position of the
main power switch.

CO-—

Indicates a standby switch by
which the instrument is switched
on to the Standby condition.
Hazardous voltage may be
present if this switch is on

L

S

Indicates a terminal that may be
connected to the signal ground
reference of another instrument.
This is not a protected ground
terminal.

Indicates a protective grounding

terminal that must be connected
to earth ground before any other
electrical connections are made
to the instrument.

Indicates a terminal that can

standby. o receive or supply alternating
current or voltage.
Indicates the On/Off position of a Indicates a terminal that can
push-push main power switch. = receive or supply alternating or
direct current or voltage.
Xiv Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
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Symbols on Instruments

The following table describes the safety symbols that may be displayed on

Applied Biosystems instruments. Each symbol may appear by itself or with text that
explains the relevant hazard (see “Safety Labels on Instruments” on page xvi). These
safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that
occur in the text of this and other product-support documents.

Symbol

Description

Symbol

Description

/N
AN

Indicates that you should consult
the manual for further information
and to proceed with appropriate

caution.

Indicates the presence of a hot
surface or other high-temperature
hazard and to proceed with
appropriate caution.

> B B

Indicates the presence of moving
parts and to proceed with
appropriate caution.

Indicates the presence of an
electrical shock hazard and to
proceed with appropriate caution.

Indicates the presence of a laser
inside the instrument and to
proceed with appropriate caution.

Environmental

The following symbol applies to all Applied Biosystems electrical and electronic

Symbols products placed on the European market after August 13, 2005.

Symbol

=,
X
()
]

Description

Do not dispose of this product as unsorted municipal waste. Follow local
municipal waste ordinances for proper disposal provisions to reduce the
environmental impact of waste electrical and electronic equipment (WEEE).

European Union customers:

Call your local Applied Biosystems Customer Service office for equipment pick-up
and recycling. See http://www.appliedbiosystems.com for a list of customer

service offices in the European Union.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard XV
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Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in the

preceding section.

English

Francais

CAUTION Hazardous chemicals. Read the
Material Safety Data Sheets (MSDSs) before
handling.

CAUTION Hazardous waste. Refer to
MSDS(s) and local regulations for handling
and disposal.

CAUTION Hot surface.
DANGER High voltage.

ATTENTION Produits chimiques
dangeureux. Lire les fiches techniques de
sUreté de matériels avant la manipulation des
produits.

ATTENTION Déchets dangereux. Lire les
fiches techniques de sireté de matériels et la
régulation locale associées a la manipulation
et I'élimination des déchets.

ATTENTION Surface brilante.
DANGER Haute tension.

WARNING To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside.

AVERTISSEMENT Pour éviter les risques
d'électrocution, ne pas retirer les capots dont
I'ouverture nécessite |'utilisation d'outils.

Refer servicing to Applied Biosystems
qualified service personnel.

L’instrument ne contient aucune piéce
réparable par I’ utilisateur. Toute intervention
doit étre effectuée par le personnel de service
qualifié de Applied Biosystems.

CAUTION Moving parts. ATTENTION Parties mobiles.

DANGER Class 3B (lll) visible and/or invisible | DANGER Rayonnement visible ou invisible
LED radiation present when open and d’un faisceau LED de Classe 3B (Ill) en cas
interlocks defeated. Avoid exposure to beam. | d’ouverture et de neutralisation des
dispositifs de sécurité. Evitez toute
exposition au faisceau.

Locations of The StepOne and StepOnePlus instruments contain a warning at the location shown
Warnings below:

[\ CAUTION HOT

XVi Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
Curve Experiments
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General Instrument Safety

Moving and
Lifting the
Instrument

Moving and
Lifting Computers
and Monitors

Operating the
Instrument

Cleaning or
Decontaminating
the Instrument

A \WZ:GUII[e] PHYSICAL INJURY HAZARD. Using the instrument in a manner

not specified by Applied Biosystems may result in personal injury or damage to the
instrument.

A (o:\0)1[e)')] PHYSICAL INJURY HAZARD. The instrument is to be moved

and positioned only by the personnel or vendor specified in the applicable site
preparation guide. If you decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or lifting an
instrument may require two or more persons.

AWARNING Do not attempt to lift or move the computer or the monitor without

the assistance of others. Depending on the weight of the computer and/or the monitor,
moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

» Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.
+ Keep your spine in a good neutral position while lifting with your legs.

+ Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Ensure that anyone who operates the instrument has:

* Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page xviii.

A (O.\I[e]\] Before using a cleaning or decontamination method other than those

recommended by the manufacturer, verify with the manufacturer that the proposed
method will not damage the equipment.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard Xvii
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Chemical Safety

Chemical Hazard AWARNING CHEMICAL HAZARD. Before handling any chemicals, refer to

Warning the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all
relevant precautions.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

Chemical Safety To minimize the hazards of chemicals:

Guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page xviii.)

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For more safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For more safety
guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

+ Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to

replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free
MSDSs 24 hours a day. To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field of the MSDS Search page:

a. Type in the chemical name, part number, or other information that you expect
to appear in the MSDS of interest.

b. Select the language of your choice.

xviii Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
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c. Click Search.

3. To view, download, or print the document of interest:
a. Right-click the document title.

b. Select:
* Open — To view the document

+ Save Target As — To download a PDF version of the document to a
destination that you choose

* Print Target — To print the document

4. To have a copy of an MSDS sent by fax or e-mail, in the Search Results page:
. Select Fax or Email below the document title.

a
b. Click RETRIEVE DOCUMENTS at the end of the document list.

2]

. Enter the required information.

d. Click View/Deliver Selected Documents Now.

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

Chemical Waste Safety

Chemical Waste A (X[l HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
Hazard local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard Xix
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Electrical Safety

XX

Waste Disposal

Fuses

Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For more safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For more safety
guidelines, consult the MSDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and
health regulations.

If potentially hazardous waste is generated when you operate the instrument, you must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.

A PJ:\\[e]33] ELECTRICAL SHOCK HAZARD. Severe electrical shock can

result from operating the StepOne or StepOnePlus instrument without its instrument
panels in place. Do not remove instrument panels. High-voltage contacts are exposed
when instrument panels are removed from the instrument.

AWARNING FIRE HAZARD. Improper fuses or high-voltage supply can

damage the instrument wiring system and cause a fire. Before turning on the instrument,
verify that the fuses are properly installed and that the instrument voltage matches the
power supply in your laboratory.

AWARNING FIRE HAZARD. For continued protection against the risk of fire,

replace fuses only with fuses of the type and rating specified for the instrument.
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Power A p\e]3i] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A PLWel3i] ELECTRICAL HAZARD. Use properly configured and approved

line cords for the voltage supply in your facility.

A pE\[e]1F38 ELECTRICAL HAZARD. Plug the instrument into a properly

grounded receptacle with adequate current capacity.

Overvoltage The StepOne and StepOnePlus instruments have an installation (overvoltage) category
Rating of II, and they are classified as portable equipment.

LED Safety

To ensure safe LED operation:

* The system must be maintained by an Applied Biosystems Technical
Representative.

+ All instrument panels must be in place on the instrument while the instrument is
operating. When all panels are installed, there is no detectable radiation present. If
any panel is removed when the LED is operating (during service with safety
interlocks disabled), you may be exposed to LED emissions in excess of the
Class 3B rating.

* Do not remove safety labels or disable safety interlocks.

Biological Hazard Safety

General &WARNING BIOHAZARD. Biological samples such as tissues, body fluids,

Biohazard infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national
regulations. Wear appropriate protective equipment, which includes but is not limited to:
protective eyewear, face shield, clothing/lab coat, and gloves. All work should be
performed in properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines and/or
regulatory requirements in the following:

+ U.S. Department of Health and Human Services guidelines published in Biosafety
in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
http://bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; http://www.access.gpo.gov/ nara/cfr/waisidx_01/
29¢fr1910a_01.html).
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* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

More information about biohazard guidelines is available at:

http://www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

ACAUTION MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:
» Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and The StepOne and StepOnePlus instruments have been tested to and comply with
Canadian Safety standard:

Standards .,/ 1010A-1/CAN/CSA C22.2 No. 1010.1-92, “Safety Requirements for Electrical
c UI. Equipment for Measurement, Control, and Laboratory Use, Part 1: General
sLjUs Requirements.”

UL 61010A-2-010/CAN/CSA 1010.2.010, “Particular Requirements for Laboratory
Equipment for the Heating of Materials.”

FDA “Radiation Control for Health and Safety Act of 1968 Performance Standard 21
CFR 1040.10 and 1040.11,” as applicable.

Canadian EMC This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial,
Standard Scientific, and Medical Radio Frequency Generators.”

European Safety Safety

Sand dE N(I:IC This instrument meets European requirements for safety (Low Voltage Directive
tandards 73/23/EEC). This instrument has been tested to and complies with standards EN 61010-
c € 1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and
Laboratory Use, Part 1: General Requirements.”
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Safety and Electromagnetic Compatibility (EMC) Standards

EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of
Materials.”

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic
Laboratory Equipment for Analysis and Other Purposes.”

EN 60825-1, “Radiation Safety of Laser Products, Equipment Classification,
Requirements, and User’s Guide.

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 89/336/EEC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Chapter 1

n Get Started

This chapter covers:

M About the StepOne™ and StepOnePlus™ Systems . .. ....................... 2
B Supported Consumables . .. ...t 4
B About Standard Curve Experiments. . .. ............iuirinirenenenenan .. 6
B HowtoUse This Guide. .. ... ..ot 9
B About the Example Experiment . . ............. ... ...t 10
B Example Experiment Workflow .. ........ ... ... .. .. ... .. .. .. . ... 12

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.
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About the StepOne™ and StepOnePlus™ Systems

There are two models available for this Real-Time PCR System:

System Features
Applied Biosystems StepOne™ Real-Time ¢ 48-well platform
PCR System (StepOne™ system) e Three-color system
Applied Biosystems StepOnePlus™ Real- ¢ 96-well platform
Time PCR System (StepOnePlus™ system) « Four-color system

* VeriFlex™ sample blocks

The StepOne and StepOnePlus systems use fluorescent-based polymerase chain reaction
(PCR) reagents to provide:

» Quantitative detection of target nucleic acid sequences (targets) using real-time
analysis.

* Qualitative detection of targets using post-PCR (endpoint) analysis.

* Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs
post-PCR).

About Data The StepOne and StepOnePlus systems collect raw fluorescence data at different points
Collection during a PCR, depending on the type of run that the instruments perform:

Run Type Data Collection Point

Real-time runs | Standard curve The instrument collects data following each
extension step of the PCR.
Relative standard
curve

Comparative Cy

(AAGy)
Post-PCR Genotyping The instrument collects data:
(endpoint) runs Presence/absence Before the PCR (For presence/absence

experiments, data collection before the PCR is
optional, but recommended.)

e (Optional) During the PCR. The instrument can
collect data during the run (real-time); collecting
data during the run can be helpful for
troubleshooting.

e After the PCR

Regardless of the run type, a data collection point or 7ead on the StepOne™ or
StepOnePlus™ instrument consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

Notes
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2. Emission — The instrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image collected by the device consists only
of light that corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The StepOne'™ software stores the
raw fluorescent image for analysis.

After a run, the StepOne software uses calibration data (spatial, dye, and background) to
determine the location and intensity of the fluorescent signals in each read, the dye
associated with each fluorescent signal, and the significance of the signal.

About the Filters The StepOne and StepOnePlus systems use the following filters:

StepOne system StepOnePlus system
Filter Dye Filter Dye
1 | FAM™ dye 1 | FAM™ dye
SYBR® Green dye SYBR® Green dye
2 | JOE™ dye 2 | JOE™ dye
VIC® dye VIC® dye
3 ROX™ dye 3 TAMRA™ dye
NED™ dye

4 | ROX™dye

About the The StepOnePlus instrument contains six independently thermally regulated VeriFlex™
VeriFlex™  blocks to help you optimize your thermal cycling conditions. You can set a different
Technology temperature for one or more of the VeriFlex blocks, creating up to six different zones for
samples, or you can set the same temperature for each of the VeriFlex blocks.

For More For information on:

Information + The StepOne and StepOnePlus systems, refer to Applied Biosystems StepOne"

Real-Time PCR Software Help.

Note: To access the Help, select Help » StepOne Software Help from within the
StepOne software.

+ Genotyping experiments, refer to Applied Biosystems StepOne'" and StepOnePlus"™
Real-Time PCR Systems Getting Started Guide for Genotyping Experiments.

* Presence/absence experiments, refer to Applied Biosystems StepOne'" and
StepOnePlus" Real-Time PCR Systems Getting Started Guide for Presence/Absence
Experiments.

+ Relative standard curve and/or comparative C (AAC;) experiments, refer to
Applied Biosystems StepOne"" and StepOnePlus™" Real-Time PCR Systems Getting
Started Guide for Relative Standard Curve and Comparative Cp Experiments.

Notes
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Supported Consumables

StepOne System  The StepOne system supports the consumables listed below. These consumables are for
use with both standard and Fast reagents/protocols.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the StepOne and StepOnePlus systems, even when performing an experiment with
standard reagents.

Consumable Part Number
¢ MicroAmp™ Fast Optical 48-Well Reaction Plate e 4375816
¢ MicroAmp™ 48-Well Optical Adhesive Film e 4375323 and
4375928
¢ MicroAmp™ Fast 8-Tube Strip e 4358293
¢ MicroAmp™ Optical 8-Cap Strip e 4323032
* MicroAmp® Fast Reaction Tube with Cap e 4358297
¢ MicroAmp™ Fast 48-Well Tray e 4375282
e MicroAmp™ 48-Well Base Adaptor o 4375284
¢ MicroAmp™ 96-Well Support Base e 4379590

Consumable

MicroAmp™ Fast Optical 48-Well Reaction Plate
MicroAmp™ Fast 48-Well Tray
MicroAmp™ 96-Well Support Base

MicroAmp™ Optical 8-Cap Strip

MicroAmp™ Fast 8-Tube Strip

MicroAmp® Fast Reaction Tube with Cap
MicroAmp™ 48-Well Optical Adhesive Film
MicroAmp™ 48-Well Base Adaptor

I O m m o O W >» %

Notes

4 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
Curve Experiments



Chapter 1 Get Started n

Supported Consumables

StepOnePlus The StepOnePlus system supports the consumables listed below. These consumables are
System for use with both standard and Fast reagents/protocols.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the StepOne and StepOnePlus systems, even when performing an experiment with
standard reagents.

Consumable Part Number

¢ MicroAmp™ Fast Optical 96-Well Reaction Plate with e 4346906 and
Barcode 4366932

¢ MicroAmp™ Optical Adhesive Film e 4360954 and
4311971
¢ MicroAmp™ Fast 8-Tube Strip e 4358293
e MicroAmp™ Optical 8-Cap Strip e 4323032
¢ MicroAmp® Fast Reaction Tube with Cap e 4358297
e MicroAmp™ 96-Well Tray for VeriFlex™ Blocks e 4379983
e MicroAmp™ 96-Well Support Base e 4379590
¢ MicroAmp™ Adhesive Film Applicator e 4333183
¢ MicroAmp™ Cap Installing Tool (Handle) e 4330015

Consumable

MicroAmp™ Fast Optical 96-Well Reaction Plate
MicroAmp™ 96-Well Tray for VeriFlex™ Blocks

MicroAmp™ 96-Well Support Base
MicroAmp™ Optical 8-Cap Strip
MicroAmp™ Fast 8-Tube Strip

MicroAmp® Fast Reaction Tube with Cap

@/ mMm m O O W > *

MicroAmp™ Optical Adhesive Film

Notes
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About Standard Curve Experiments

Real-Time PCR Standard curve experiments are real-time PCR experiments. In real-time PCR
Experiments experiments:

* The instrument monitors the progress of the PCR as it occurs (Kwok and Higuchi,
1989).

* Data are collected throughout the PCR process.

* Reactions are characterized by the point in time during cycling when amplification
of a target is first detected (Saiki et al., 1985).

Note: In this guide, the term experiment refers to the entire process of performing a run
using the StepOne or StepOnePlus system, including setup, run and analysis.

About Standard The standard curve method is used to determine the absolute target quantity in samples.
Curve With the standard curve method, the StepOne software measures amplification of the
Experiments target in samples and in a standard dilution series. Data from the standard dilution series
are used to generate the standard curve. Using the standard curve, the software
interpolates the absolute quantity of target in the samples.

Components
The following components are required when setting up PCR reactions for standard
curve experiments:

* Sample — The sample in which the quantity of the target is unknown.

* Standard — A sample that contains known standard quantities; used in quantitation
experiments to generate standard curves.

* Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

* Replicates — The total number of identical reactions containing identical samples,
components, and volumes.

* Negative Controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

PCR Options When performing real-time PCR, choose between:
* Singleplex and multiplex PCR (below)
and
* l-step and 2-step RT-PCR (page 7)

Singleplex vs. Multiplex PCR

You can perform a PCR reaction using either:

» Singleplex PCR — In singleplex PCR a single primer set is present in the reaction
tube or well. Only one target or endogenous control can be amplified per reaction.

or

Notes
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* Multiplex PCR — In multiplex PCR, two or more primer sets are present in the
reaction tube or well. Each set amplifies a specific target or endogenous control.
Typically, a probe labeled with FAM™ dye detects the target and a probe labeled
with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye
as a reporter or quencher with the StepOne system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus system.

= O BEm [ Target Primer Set
=
o 3 00 (O Endogenous Control
- Primer Set
, ~~ cDNA
Singleplex PCR Multiplex PCR

1- vs. 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether you
are performing 1- or 2-step RT-PCR:

* In 1-step RT-PCR, RT and PCR take place in one buffer system, which provides the
convenience of a single-tube preparation for RT and PCR amplification. However,
you cannot use Fast PCR master mix or the carryover prevention enzyme,
AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

o 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-
transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful
for detecting multiple transcripts from a single cDNA template or for storing cDNA
aliquots for later use. The AmpErase® UNG enzyme can be used to prevent
carryover contamination.

Note: For more information on AmpErase® UNG, refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent Guide.

Notes
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Supported TagMan® and SYBR® Green Reagents

Reagents

Applied Biosystems offers TagMan® and SYBR® Green reagents for use on the StepOne

and StepOnePlus systems. Both reagent types are briefly described in the table below.

Reagent Type

Process

TagMan® reagents or kits
Description

TagMan reagents use a fluorogenic probe to
enable detection of a specific PCR product as
it accumulates during PCR cycles.

Advantages

¢ Increased specificity with the addition of a
fluorogenic probe.
e Provides multiplex capability.

e Preformulated assays, optimized to run
under universal thermal cycling conditions,
are available.

Limitations

Requires synthesis of a unique fluorogenic
probe.

SYBR® Green reagents
Description

SYBR Green reagents use SYBR® Green | dye,
a double-stranded DNA binding dye, to detect
PCR products as they accumulate during PCR
cycles.

Advantages

e Economical (no probe needed).

¢ Allows for melt curve analysis to measure
the Tm of all PCR products.

Limitations

Binds nonspecifically to all double-stranded
DNA sequences. To avoid false positive
signals, check for nonspecific product
formation using melt curve or gel analysis.

e (Can be used for either 1- or 2-step RT-PCR.

e (Can be used for either 1- or 2-step RT-PCR.

PCR and Detection of cDNA

a. Assay Components
we
3 Probe / Reverse primer
Forward primer B G <
3%\7 CDNA Template ’;(,(25
T T )
& *55 ~— CDNA
3 5
b. Denatured Template and Annealing of Assay Components
3 5 X
S j Reverse primer LEGEND
e T T T T
e
Probe / $ rm™dre
™ &G
Forward primer Q Quencher
s AU I T R,
& = ves  Minor Groove
3 5 Binder
c. Signal Generation AmpliTaq Gold®
DNA Polymerase
3‘%\ 5
LTI, Probe
Reverse primer N
=== Primer
Forward primer Mes
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3 5' Extended Primer
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-
B
@
,.,
‘
() ()
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Step 1: Reaction setup
The SYBR® Green | dye
fluoresces when bound to
double-stranded DNA.

Step 2: Denaturation

When the DNA is denatured into
single-stranded DNA, the

SYBR® Green | dye is released and
the fluorescence is drastically reduced.

Step 3: Polymerization
During extension, primers
anneal and PCR product
is generated.

Step 4: Polymerization completed
SYBR® Green | dye binds to the
double-stranded product,

resulting in a net increase in
fluorescence detected by the
instrument.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA dye as a
reporter or quencher with the StepOne system. TAMRA dye may be used as a reporter or
quencher with the StepOnePlus system.

Notes
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Other Reagents

You can use other fluorescent-based reagents on the StepOne and StepOnePlus systems,
but note the following:

* You must design your experiment using Advanced Setup instead of the Design
Wizard. (See “Advanced Setup Workflow” on page 116.)

* For Applied Biosystems TagMan and SYBR Green reagents, the StepOne software
automatically calculates reaction volumes in the Reaction Setup screen.

For More For more information on real-time PCR experiments, PCR options, and reagents, refer to
Information the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent
Guide.

How to Use This Guide

This guide functions as both a tutorial and as a guide for performing your own
experiments.

Using This Guide By using the example experiment data provided with the StepOne software, you can use
as a Tutorial this guide as a tutorial for performing a standard curve experiment on a StepOne or
StepOnePlus system. Follow the procedures in Chapters 2 to 5:

Chapter Procedure
2 Design the experiment using the Design Wizard in the StepOne software.
3 Prepare the experiment, using the reagents and volumes calculated by the

Design Wizard in Chapter 2.

4 Run the experiment on a StepOne or StepOnePlus instrument (standalone or
colocated layout)

5 Analyze the results.

For more information, see “About the Example Experiment” on page 10.
Using This Guide After completing the tutorial exercises in Chapters 2 to 5, you can use this guide to lead

With Your Own you through your own standard curve experiments. Each procedure in Chapters 2 to 5
Experiments includes a set of guidelines that you can use to perform your own experiments.

Notes
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Additionally, you can use one of the other workflows provided in the StepOne software to
perform your experiments. The table below provides a summary of all the workflows
available in the StepOne software.

Workflow Description See...

Design Wizard | Set up a new experiment with guidance from the software. | Chapter 2
The Design Wizard walks you through best practices as
you create your own experiment. The Design Wizard is
recommended for new users.

Note: Design options are more limited in the Design
Wizard than in Advanced Setup.

Advanced Set up a new experiment using advanced options. page 116

Setup Advanced Setup allows design flexibility as you create
your own experiment. Advanced Setup is recommended
for experienced users.

QuickStart Run a new experiment with no plate setup information. If page 117
desired, you can add all design parameters after the run.

Template Set up a new experiment using setup information from a page 119
template.
Export/Import Import experiment designs from ASCII text files that page 121

contain experiment setup information.

About the Example Experiment

Notes

10

To illustrate how to perform standard curve experiments, this guide leads you through the
process of designing, preparing, running, and analyzing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize
yourself with a StepOne or StepOnePlus system.

Description  The objective of the standard curve example experiment is to determine the quantity of
the RNase P gene in two populations.
In the standard curve example experiment:
* The samples are genomic DNA isolated from two populations.
* The target is the RNase P gene.

* One standard curve is set up for the RNase P gene (target). The standard used for the
standard dilution series contains known quantities of the RNase P gene. Because a
single target is being studied, only one standard curve is required.

Note: In experiments where multiple targets are being studied, a standard curve is
required for each target.

» Three replicates of each sample and each dilution point in the standard curve are
performed to ensure statistical significance.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
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* The experiment is designed for singleplex PCR, where every well contains a
primer/probe set for a single target.

* Reactions are set up for 2-step RT-PCR.

* Primer/probe sets are from Applied Biosystems RNase P assay.

Note: The human RNase P FAM™ dye-labeled MGB probe is not available as a
TagMan® Gene Expression Assay. It can be ordered as a Custom TagMan® Gene
Expression Assay (PN 4331348).

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA dye as
a reporter or quencher with the StepOne system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus system.

Reaction Plate The standard curve example experiment was created for a StepOne instrument. For the
Layout StepOne instrument, the software displays a 48-well reaction plate layout:

| ElshuwinWEHsv | V\EWLEgEﬂd | |

1 [ 2 [ 3 [ 1 [ s [ 6 [ 7 [ 8 \

popl popl pop1 pop? pop?

A | ruase [ rhase [ rnaser [0 wrase [0 mase [0 rrase [T rsse 1] rsse
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SE3 5E3 SE3

B | [ Rnase P 1E4 1E4 1E4 2563
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You can create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the 48-well reaction plate layout shown throughout
this guide. For the StepOnePlus instrument, the software displays a 96-well reaction plate

layout:
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Example Experiment Workflow

About the In this getting started guide you will use two files:

. Example * In Chapter 2, you will create a standard curve example experiment file that contains
Experiment Data setup data and save it to the experiments folder on your computer:
<drive>:\Applied Biosystems\<software name>\experiments\
Standard Curve Example.eds
* In Chapter 5, you will view results in a standard curve example experiment file that

contains run data. The data file for the example experiment installs with the
StepOne software. You can find the data file for the example experiment on your
computer:
<drive>:\Applied Biosystems\<software name>\experiments\examples\
Standard Curve Example.eds

where:

* <drive> is the computer hard drive on which the StepOne software is installed. The
default installation drive for the software is the D drive.

* <software name> is the current version of the StepOne software.

Data Files in the Examples Folder

The examples folder contains several data files that you can reference when analyzing
your own data, as listed below. The data files install with the StepOne software.

Note: Be sure to use the Standard Curve Example.eds file when performing the tutorial
procedures in this guide. The 96-Well Standard Curve Example.eds file is a different
example of the standard curve method.

StepOne Instrument StepOnePlus Instrument
Comparative CT Example.eds 96-Well Comparative CT Example.eds
Multiplex Example.eds 96-Well Multiplex Example.eds
Genotyping Example.eds | 96-Well Genotyping Example.eds
Presence Absence Example.eds | 96-Well Presence Absence Example.eds
Relative Standard Curve Example.eds | 96-Well Relative Standard Curve

Example.eds

RNase P Experiment.eds 96-Well RNase P Experiment.eds
Standard Curve Example.eds 96-Well Standard Curve Example.eds
SYBR Example.eds 96-Well SYBR Example.eds

Example Experiment Workflow

The figure on page 13 shows the workflow for the standard curve example experiment.

Notes
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Example Experiment Workflow

Start Experiment

h 4
Design the Experiment (Chapter 2)

. Create a new experiment.

. Define the experiment properties.
. Define the methods and materials.
. Set up the targets.

. Set up the standards.

. Set up the run method.

. Review the reaction setup.

. Order materials for the experiment.
0.Finish the Design Wizard.

b 4
Prepare the Reactions (Chapter 3)

1
2
3
4
5
6. Set up the samples.
7
8
9
1

Prepare the sample dilutions.
Prepare the standard dilution series.

Prepare the reaction mix for each target assay.

oD =

Prepare the reaction plate.

h 4
Run the Experiment (Chapter 4)

Prepare for the run.
(Optional) Enable the notification settings.
Start the run.

Monitor the run.

o 0N~

Unload the instrument and transfer the data.

h 4
Analyze the Experiment (Chapter 5)

Section 1, Review Results:

Analyze.

View the standard curve.

View the amplification plot.

View the results in a table.

Publish the data.

Section 2, Troubleshoot (If Needed):

1. View the analysis settings; adjust the baseline/threshold.

o 0N~

2. View the quality summary.

3. Omit wells.

4. View the multicomponent plot.

5. View the raw data plot.

v
End Experiment

Notes
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Example Experiment Workflow

Notes
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Chapter 2

Design the Experiment

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 16
B Createa New Experiment. . .. ......... .. 17
B Define the Experiment Properties .. ........ ... .. .. ... .. .. .. .. ... ... 20
B Define the Methods and Materials . . ......... ... .. .. ... 22
B SetUpthe Targets. .. ..ot e e e e 25
B SetUpthe Standards. .......... ... . . i 27
B SetUpthe Samples. . ... 29
B SetUpthe RunMethod ........ ... ... . . i 31
B Review the Reaction Setup. ........... i 33
B Order Materials for the Experiment .. ............. .. ... .. ... 38
B Finishthe Design Wizard . . ........ ... ... .. . . i, 42

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to use the Design Wizard in the StepOne"™ software to set up
the standard curve example experiment. The Design Wizard walks you through Applied
Biosystems recommended best practices as you enter design parameters for the example
experiment.

Example The workflow for designing the example experiment provided with this getting started
Experiment guide is shown below.
Workflow
Note: Design the example experiment using the Design Wizard in the StepOne software.
When you design your own experiments, you can select alternate workflows (see “Using
This Guide With Your Own Experiments” on page 9).

Start Experiment

h 4
Design the Experiment (Chapter 2)

. Create a new experiment.

. Define the experiment properties.

. Define the methods and materials.
. Set up the targets.

. Set up the standards.

. Set up the samples.

. Set up the run method.

. Review the reaction setup.

. Order materials for the experiment.
0. Finish the Design Wizard.

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

v
End Experiment

1
2
3
4
5
6
7
8
9
1

Notes

16 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
Curve Experiments



Chapter 2 Design the Experiment m
Create a New Experiment

Create a New Experiment

Create a new experiment using the Design Wizard in the StepOne software.

Create an 1. Double-click € (StepOne software shortcut) or select
Experiment Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.
2. From the Home screen, click Design Wizard to open the Design Wizard.

IFi\e Edit Instrument Analysis Tools Help I

[E] Mew Experiment = =] Open.. [ [ TJ_“ Send Experiment to Instrument... L_'r Download Experiment from Instrument.. &30 8
Analyze
QuickStart Analyze Experiment
2
3. See “Software Elements” on page 18 for information on navigating within the
Design Wizard.
Notes
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard 17
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Create a New Experiment

Software The StepOne software elements for the Design Wizard are illustrated below.

Elements _ _ )
1. Menu bar — Displays the menus available in the software:

* File

« Edit

* Instrument
* Analysis
* Tools

* Help

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
* Close
» Send Experiment to Instrument

* Download Experiment from Instrument

3. Experiment header - Displays the experiment name, experiment type, and reagents
for the open experiment.

4. Navigation pane — Provides links to all screens in the Design Wizard:
* Experiment Properties
* Methods & Materials
» Targets
» Standards
* Samples
* Run Method
» Reaction Setup
* Materials List

Note: The Design Wizard initially displays the Quantitation - Standard Curve
experiment type. The available Design Wizard screens may change when you select
a different experiment type. For example, the Relative Quantitation Settings screen
is not displayed until you select the relative standard curve or comparative C;
(AACy) experiment type.

5. Experiment tab(s) — Displays a tab for each open experiment.

Notes
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Create a New Experiment

:Fi\e Edit Instrument Analysis Tools Help

1 [Z] New Experiment ~ =] Open... H =) Close ‘;5_“ Send Experiment to Instrument... ’-?l, Download Experiment from Instrument... _@

N —

1A. Define: Experiment Properties Experiment Properties Help @)

1. Define
a Instructions: Enter an experiment name, selectthe instrumenttype, then selectthe type of experiment to design.

How do you want to identify this experiment? = Required

* Experiment Name:

* Experiment
Properties

Barcode (Optional): ‘

|
|
User Name (Optional): ‘ |

2. SetUp Comments (Optional) ‘ ‘
v

Which instrument are you using to run the experiment?

[ StepCnePlus™ Instrument (96 Wells) ] { + StepCne™ Instrument (48 Wells) ]

Setup, run, and analyze an experiment using a 3-color, 48-well system

What type of experiment do you want to design?

[ « Quantitation ] [ Genotyping ] [ Presence / Absence ]

Desian a gene quantitation experiment to determine the amount of target nucleic acid sequence in a sample.

3. Order ( Optional)

+ Finish Designing Experiment

5 1 v e ] Untitled <

Notes
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Define the Experiment Properties

About the
Example
Experiment

Complete the
Experiment
Properties
Screen

Notes

On the Experiment Properties screen, enter identifying information for the experiment,
select the instrument type, then select the type of experiment to design.

In the standard curve example experiment:

L]

The experiment is identified as an example.

The instrument selected to run the experiment is the StepOne instrument.
A MicroAmp™ Fast Optical 48-Well Reaction Plate is used.

The experiment type is quantitation.

. Click the Experiment Name field, then enter Standard Curve Example.

Note: The experiment header updates with the experiment name you entered.

Leave the Barcode field empty.

Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

Click the User Name field, then enter Example User.

Click the Comments field, then enter Standard Curve Getting Started Guide
Example.

Select StepOne™™ Instrument (48 Wells).

Note: The example experiment was created for a StepOne instrument. You can
create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the layout shown in this guide. The software
displays a 48-well reaction plate layout for the StepOne instrument and a 96-well
reaction plate layout for the StepOnePlus instrument. To create the example
experiment for a StepOnePlus instrument, select StepOnePlus™ Instrument
(96 Wells).

Select Quantitation for the experiment type.

Click Next >.

20 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
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Define the Experiment Properties

1A. Define: Experiment Properties Experiment Properties Help @.

n Instructions: Enter an experiment name, selectthe instrument type, then select the type of experimentto design

How do you want to identify this experiment? = Required

* Experiment Name: [ Standard Curve Example

Barcode (Optional): |

A ON =

|
|
User Name (Optional): | Example Uiser |

H Comments (Optional): SERERRETEReE b REl GO R =l e

5 Which instrument are you using to run the experiment?

i |
[ StepCneFlus™ [nstrument (96 Wells) J | + StepOne™ Instrument (48 Wells) }

Setup, run, and analyze an experiment using a 3-color, 48-well system

What type of experiment do you want to design?

6 I + Quantitation } [ Genatyping J [ Presence [ Absence J

Design a gene quantitation experiment to determine the amount of target nucleic acid sequence in a sample

Design  When you design your own standard curve experiment:
Guidelines * Enter an experiment name:

— Enter a name that is descriptive and easy to remember. You can enter up to 100
characters in the Experiment Name field.

Note: You cannot use the following characters in the Experiment Name field:
forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (), colon (:), or
semicolon (;).

— The experiment name is used as the default file name.

* (Optional) If you are using a MicroAmp"" Fast Optical 96-Well Reaction Plate,
enter a barcode to identify the barcode on the reaction plate. You can enter up to 100
characters in the Barcode field.

Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

* (Optional) Enter a user name to identify the owner of the experiment. You can enter
up to 100 characters in the User Name field.

* (Optional) Enter comments to describe the experiment. You can enter up to 1000
characters in the Comments field.

Notes
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* Select the instrument you are using to run the experiment:

— StepOne™ Instrument (48 Wells)
— StepOnePlus'” Instrument (96 Wells)

Note: You can use StepOne Software v2.0 or later to design experiments for both
the StepOne and StepOnePlus instruments. The instrument you select in the
Experiment Properties screen affects the reaction plate layout and materials list.

Note: To set the default instrument type, select Tools » Preferences, then select the
General tab (default). From the Default Instrument Type dropdown menu, select
the appropriate instrument.

* Select Quantitation as the experiment type.

For More For more information on:

Information

» Completing the Experiment Properties screen, access the StepOne Software Help by

clicking ) or pressing F1.
Consumables, see “Supported Consumables” on page 4.

Quantitation experiments, refer to the Applied Biosystems StepOne™ and
StepOnePlus™ Real-Time PCR Systems Reagent Guide.

Define the Methods and Materials

On the Methods & Materials screen, select the quantitation method, reagents, ramp
speed, and PCR template to use for the experiment.

About the In the standard curve example experiment:
E Exa..mplet * The standard curve quantitation method is used.
Xperimen + TagMan® reagents are used.
* The standard ramp speed is used in the instrument run.
* Purified gDNA (isolated from two populations) is the template type. Before using
gDNA template, you must first extract the gDNA from tissue or sample.
Complete the 1. Seclect Standard Curve as the quantitation method.
Methods &
Materials Screen 2. Select TagMan® Reagents for the reagents.
3. Select Standard (~ 2 hours to complete a run) for the ramp speed.
4. Select gDNA (genomic DNA) for the template type.
5. Click Next >.
Notes
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Define the Methods and Materials

1B. Define: Methods & Matenals Methods & Materials Help @

u Instructions: Select the quantitation method, reagents, ramp speed, and type of template for the reaktime PCR reactions.

Which guantitation method are you using?

1 } + Standard Curve | [ Relative Standard Curve } [ Comparative C1 (AACT) ]

‘With the standard curve method, you use standards to determine the absolute quantity of target sequence in a sample

Which reagents do you want to use to detect the target sequence?

2 } + TagMan® Reagents | [ SYBR® Green Reagents }

These real-time PCR reactions contain two primers and a TagMan® probe. The primers are designed to amplify the target sequence. The TaghMan probe is designed to hybridize to
the target sequence and generate fluorescence signal when the target sequence is amplified

Which ramp speed do you want to include in the instrument run?

3 }.’ Standard (~ 2 hours to complete a run)| [ Fast (~ 40 minutes to complete a run) }

For optimal results using the standard ramp spesd, Applied Biosystems racommends standard reagents for your reaktime PCR reactions.

What type of template do you want to use in the real-time PCR reactions?

[ cOMA (complementary DNA) ] [ RIMNA ] ‘ + gDMNA (genomic DNA) |

ou are adding purified gDNA to the real-tims PCR reactions. You have already extracted the gDNA from tissue or s{mple

Design  When you design your own standard curve experiment:

Guidelines » Select Standard Curve as the quantitation method. The standard curve method is
used to determine the absolute target quantity in samples. When setting up your
reaction plate, the standard curve method requires targets, standards, and samples.

» Select the reagents you want to use:

— Select TaqMan® Reagents if you want to use TagMan reagents to detect
amplification and quantify the amount of target in the samples. TagMan reagents
consist of two primers and a TagMan® probe. The primers are designed to
amplify the target. The TagMan probe is designed to hybridize to the target and
generate fluorescence signal when the target is amplified.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye
as a reporter or quencher with the StepOne™™ system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus™ system.

Notes
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— Select SYBR® Green Reagents if you want to use SYBR Green reagents to
detect amplification and quantify the amount of target in the samples. SYBR
Green reagents consist of two primers and SYBR Green dye. The primers are
designed to amplify the target. The SYBR Green dye generates fluorescence
signal when it binds to double-stranded DNA. SYBR Green dye is often part of
the SYBR Green master mix added to the reaction. If you use SYBR Green dye:

Select the Include Melt Curve checkbox to perform melt curve analysis of the
amplified target.

Select Standard as the ramp speed. A Fast master mix for SYBR Green reagents
is not available from Applied Biosystems.

Note: You can use other fluorescent-based reagents on the StepOne and
StepOnePlus systems, however, you must design your experiment using Advanced
Setup instead of the Design Wizard.

Select the appropriate ramp speed for the instrument run:

— Select Fast (~ 40 minutes to complete a run) if you are using Fast reagents for
the PCR reactions.

— Select Standard (~ 2 hours to complete a run) if you are using standard
reagents for the PCR reactions.

Select the appropriate PCR template:

— Select ¢cDNA (complementary DNA) if you are performing 2-step RT-PCR, and
you have already performed reverse transcription to convert the RNA to cDNA.
You are adding complementary DNA to the PCR reactions.

— Select RNA if you are performing 1-step RT-PCR. You are adding total RNA or
mRNA to the PCR reactions.

Note: To use the Fast ramp speed with RNA templates, you must design your
experiment using Advanced Setup instead of the Design Wizard.

— Select gDNA (genomic DNA) if you have already extracted the gDNA from
tissue or sample. You are adding purified genomic DNA to the PCR reactions.

For More For more information on:

Information .

Notes

Completing the Methods & Materials screen, access the StepOne Software Help by
clicking ) or pressing F1.

Using Advanced Setup, see “Advanced Setup Workflow” on page 116.

Using other quantitation methods, refer to the Applied Biosystems StepOne™™ and
StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative Standard
Curve and Comparative CExperiments.

TagMan and SYBR Green reagents, refer to the Applied Biosystems StepOne'" and
StepOnePlus™ Real-Time PCR Systems Reagent Guide.

PCR, including singleplex vs. multiplex PCR and 1-step vs. 2-step RT PCR, refer to
the Applied Biosystems StepOne" and StepOnePlus™ Real-Time PCR Systems
Reagent Guide.
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Set Up the Targets

Set Up the Targets

On the Targets screen, enter the number of targets you want to quantify in the PCR
reaction plate, then set up the assays for each target.

About the In the standard curve example experiment:
Example

! * One target is quantified in the reaction plate.
Experiment

* The Set Up Standards checkbox is selected. When this checkbox is selected, the
software automatically displays the Standards screen after you complete the Targets
screen. In the Standards screen, you can set up a standard curve for the target assay
(see “Set Up the Standards” on page 27).

» The Target 1 assay is set up for the target you are studying. For the example
experiment, this is the RNase P gene.

Complete the 1. Click the How many targets do you want to quantify in the reaction plate? ficld,
Targets Screen then enter 1.

Note: The number of rows in the target assays table updates with the number you
entered.

2. Select the Set Up Standards checkbox to set up standards for the target assay.

Note: The Set Up Standards checkbox is selected by default.

3. Set up the Target 1 assay:
a. Click the Enter Target Name cell, then enter RNase P.
b. From the Reporter dropdown menu, select FAM (default).
c. From the Quencher dropdown menu, select NFQ-MGB (default).
d. Leave the default in the Color field.

4. Click Next >,
Note: Leave the (Optional) Enter Gene Name field blank. You can search for the

gene/assay ID when you order your materials (see “Order Materials for the Experiment”
on page 38).

Notes
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2A Set Up: Targets Targets Help @
ﬂ Instructions: Enter the number of targets to quantify in the reaction plate, then set up the assay for each target
1 * How many targets do you want to guantify in the reaction plate? 1
For each target assay in the reaction plate, selectwhather to set up standards, enter a target name, selectthe reporter and guencher to use to detectthe target, and select a target
color, (Optional) Enter a gene name, find Applied Biosystems gene expression assays, then select an assayto fill in the Assay 1D
Set Up Standards | * Enter Target Name Reporter Quencher Color | (Optional) Enter Gene Mame and Click Assay 1D
2 | ||FAM v |NFO-MGB v‘ '\'| [ Fnat |
3a 3b 3c ad
Design  When you design your own standard curve experiment:
Guidelines » Select the Set Up Standards checkbox. Applied Biosystems recommends that you
set up a standard curve for each target assay in the reaction plate.
* Identify each target assay with a unique name and color. You can enter up to 100
characters in the Target Name field.
* Select the reporter dye used in the target assay. In the Methods & Materials screen
on page 22, if you selected:
— TagMan® Reagents, select the dye attached to the 5" end of the TagMan probe.
— SYBR® Green Reagents, select SYBR.
* Select the quencher used in the target assay. In the Methods & Materials screen on
page 22, if you selected:
— TagMan® Reagents, select the quencher attached to the 3’ end of the TagMan
probe.
— SYBR® Green Reagents, select None.
IMPORTANT! Applied Biosystems does not recommend the use of TAMRA dye as
a reporter or quencher with the StepOne system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus system.
For More For more information on completing the Targets screen, access the StepOne Software
Information  Help by clicking g) or pressing F1.
Notes
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Set Up the Standards

Set Up the Standards

On the Standards screen, enter the number of points and replicates for all standard curves
in the reaction plate. For each standard curve, enter the starting quantity and select the
serial factor.

About the In the standard curve example experiment:

Exgmple * One standard curve is set up for the target (RNase P). The standard used for the
Experiment standard dilution series contains known quantities of the RNase P gene. Because a
single gene is being studied, only one standard curve is required.
* Five points are used in the standard curve.

» Three replicates are used for each point. Replicates are identical reactions,
containing identical reaction components and volumes.

» The starting quantity is 10,000 copies and the serial factor is 1:2.

Complete the 1. Click the How many points do you need for each standard curve? field, then
Standards Screen enter 5.

2. Click the How many replicates do you need for each point? field, then enter 3.

3. Define the range of standard quantities for the RNase P assay:
a. Click the Enter Starting Quantity field, then enter 10000.

b. From the Select Serial Factor dropdown menu, select 1:2.

4. Review the Standard Curve Preview pane. The standard curve has the following
points: 10000, 5000, 2500, 1250, and 625.

5. Click Next >.

2B. Set Up: Standards Standards Help @
B Instructions: Enterthe number of points and replicates for all standard curves in the reaction plate. For each standard curve, enter the starting quantity and selectthe serial factor
Set Up Standards = Required : View Plate Layout
1 * How many paints do you need for each standard curve? B Arrange Plate by: Rows |  Place Negative Controls in
* How many replicates do you need for each point? 3 - - -
2 | | Elshowmv\lel\s v | V\ewLegend |
For each standard curve, define the range of standard quantities by entering the starting quantity and serial factor. 1 ‘ 2 | 3 ‘ 4 | 5 ‘ & | 7 ‘ a |
Sa Uenine e stanaard cuive so inatme range of standard guantities spans the expected range of quantities far the unknowns. Sample 1 Sample 1 Sample 1 Sample 2 Sample 2
Target Name Eilter Starting Quantity Select Serial Factor & |Lrw.. Cen. L. RN...| [ Rn. RN...| [ Rn. RN...
@ RNase P |\1unun 0 |12 v’: |
3b g |52me2 Hev. Han. e s e e Bew
Standard Curve Preview m RN... 1E4 1E4 1E4 5E3 5E3 5E3 25E3
Standard Curve Praview for @ RNase F . SERIS s s s s s Enls E
25E3 |25E3 (1.25E3 |1.25E3 |1.25E3 |625 625 625
1E4 I
5E3 o
4 2.5E3
1.25E3 | |
B.25E2
E
F
m 6 - Unknown D 15 - Standard D 3 - Negative Control 24 - Empty
Notes
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Notes

28

Set Up the Standards

Design
Guidelines

When you design your own standard curve experiment:

* Set up a standard curve for each target in the reaction plate. The targets are

previously defined on the Targets screen (“Set Up the Targets” on page 25).

Enter the number of points for each standard curve in the reaction plate. Applied
Biosystems recommends at least five dilution points for each standard curve.

Enter the number of replicates (identical reactions) for each point in the standard
curve. Applied Biosystems recommends three replicates for each point.

Because the range of standard quantities affects the amplification efficiency
calculations, carefully consider the appropriate range of standard quantities for your
assay:

— For more accurate measurements of amplification efficiency, use a broad range
of standard quantities, spanning between 5 and 6 logs. If you specify a broad
range of quantities for the standards, you need to use a PCR product or a highly
concentrated template, such as a cDNA clone.

— If you have a limited amount of cDNA template and/or if the target is a low-copy
number transcript, or known to fall within a given range, a narrow range of
standard quantities may be necessary.

The serial factor is used to calculate the quantities in all points of the standard curve.
If your starting quantity is the highest quantity, select a dilution factor such as 1:2,
1:3, and so on. If your starting quantity is the lowest quantity, select a concentration
factor such as 2X, 3X, and so on.

For More For more information on:

Information

+ Completing the Standards screen, access the StepOne Software Help by clicking @)

or pressing F1.

+ Amplification efficiency, refer to the Amplification Efficiency of TagMan® Gene

Expression Assays Application Note.
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Set Up the Samples

On the Samples screen, enter the number of samples, replicates, and negative controls to
include in the reaction plate, enter the sample names, then select the sample/target
reactions to set up.

About the In the standard curve example experiment:

Exa_.mple » Two samples are used: genomic DNA from two populations. The samples contain
Experiment unknown quantities of the target (RNase P).

» Three replicates are used. The replicates are identical reactions, containing identical
reaction components and volumes.

+ Three negative controls are used. The negative control reactions contain water
instead of sample and should not amplify.

Complete the 1. Click the How many samples do you want to test in the reaction plate? field,
Samples Screen then enter 2.

Note: The number of rows in the samples table updates with the number you
entered.

2. Click the How many replicates do you need? field, then enter 3.

3. Click the How many negative controls do you need for each target assay? field,
then enter 3.

4. Setup Sample 1:
a. Click the Enter Sample Name field, then enter pop1 (for population 1).
b. Leave the default in the Color field.

5. Set up Sample 2:
a. Click the Enter Sample Name field, then enter pop2 (for population 2).
b. Leave the default in the Color field.

6. Select All Sample/Target Reactions to test all targets in all samples.

7. In the Well Count pane, confirm there are:
¢ 6 Unknown wells [I]
e 15 Standard wells [£]
* 3 Negative control wells []
* 24 Empty wells
8. In the View Plate Layout tab:

a. From the Arrange Plate by dropdown menu, select Rows (default).

Notes
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b. From the Place Negative Controls in dropdown menu, select Upper Left

(default).

9. Click Next >.

2C. Set Up: Samples

Samples Help 0/

Enter the number of samples to testin the reaction plate, enter the number of sampleftarget reaction replicates, enter the number of negative controls, enter sample

: View Plate Layout

|
Arrange Plate by [Rows % |  Place Negative Controls in: |UpperLeft H
| 0| showinWells ¥ | E |
v s 4 [ s [ 8 [ 7] 8 |

A | [ rua...| [ Ria... [0 RNa...

View Legend ‘

pop1

[ ra..
E rna..

5E3

E rna..

625

pop2

[ ra..
E rna..

5E3

E rna..

625

pop2

[ ra..
E rna..

2.5E3

E rna..

625

pop1

RNa...
El rna..

5E3

E rna..

1.25E3

pop1

RNa...
El rna..

1E4

E rna..

1.25E3

pop2

E RMNa...

o |Elrya..

2.5E3

E rua... B rba...

1E4 1E4

E rua... [ rua...

2.5E3 1.25E3

——————8a
8b

When you design your own standard curve experiment:

Identify each sample with a unique name and color. You can enter up to 100

* Enter the number of replicates (identical reactions) to set up. Applied Biosystems
recommends three replicates for each sample reaction.

» Enter the number of negative control reactions to set up. Applied Biosystems
recommends three negative control reactions for each target assay.

— Select All Sample/Target Reactions to test all targets in all samples.

— Select Specify Sample/Target Reactions to specify the targets to test in each

Note: When you use the Design Wizard to set up a standard curve experiment, you
can set up only singleplex reactions (amplification and detection of one target per
well). If you want to set up a standard curve experiment with multiplex reactions
(amplification and detection of two or more targets per well), design your
experiment using Advanced Setup instead of the Design Wizard.

 If you are running the experiment on a StepOnePlus instrument and plan to edit the
Run Method (page 31) to set a different temperature for one or more of the VeriFlex

a. Design your experiment using Advanced Setup instead of the Design Wizard.

a Instructions: names, then select the sampleitarget reactions to setup
Set Up Samples = Required
1 * How many samples do you want to test in the reaction plate? 2
2 * How many replicates do you need? 3
3 * How many neaative controls do you need for each target assay? 3
For each sample in the reaction plate, enter a sample name and select a sample co
* Enter Sample Mame Colar
4 [popt |
5 [pop2 | v
Which sample/target reactions do you want to set up?
6 I + All Sample/Target Reactions ‘[ Specify Sample/Target Reactions ]
7 | " ﬁ - Unknown D 15 - Standard DS - Negative Control 24 - Emply
Design
Guidelines .
characters in the Sample Name field.
» Select which targets to test in the samples:
sample.
blocks, you need to:
Notes
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b. In the Plate Setup screen, select the Assign Targets and Samples tab, select
the View Plate Layout tab, then select the Enable VeriFlex"" Block checkbox.

IMPORTANT! If you do not select the Enable VeriFlex " Block checkbox in the
Plate Setup screen, you will not be able to set a different temperature for one or
more of the VeriFlex blocks in the Run Method screen (page 31).

For More For more information on:

Information + Completing the Samples screen, access the StepOne Software Help by clicking @)

or pressing F1.
» Using Advanced Setup, see “Advanced Setup Workflow” on page 116.

Set Up the Run Method

On the Run Method screen, review the reaction volume and the thermal profile for the
default run method. If needed, you can edit the default run method or replace it with one
from the Run Method library.

About the In the standard curve example experiment, the default run method is used with one
Example change: The reaction volume per well is changed from 20 uL to 25 pL.
Experiment

—

Review the Run
Method Screen

. Click either the Graphical View tab (default) or Tabular View tab.

2. Click the Reaction Volume Per Well field, then enter 25 uL.
3. Make sure the thermal profile displays the holding and cycling stages shown below.
4. Click Next >,

Notes
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2D. Set Up: Run Method Run Method Help @

u Instructions: Review the reaction volume and the thermal profile for the default run method. If needed, edit the default run method or select a run method from the library.

1 i Graphical ViewI Tabular View }

Reaction Volume Per Well uL

| Adastage ¥ | adostep ¥ | Delsts Selscted | 1] colsctnata v |1 gpen Run method | save Run Methoa . | El

Holding Stage Cycling Stage

Mumber of Cycles: |40 B
[ Enable AutoDelta
Starting Cycle:

100 —| 895.0°C 95.0 °C

3 10:00 100% 00:15
76 —| i
00% 60.0°C

o | 500°C giro0

- —
02:00
100%

Step 1 Step 2 Step 1 Step 2 v
< >

Legend
Data Collection Gn Data Collection Off A AutoDelta On A AutoDelta Off

Design  When you design your own standard curve experiment:

Guidelines * Enter a number from 10 to 30 for the reaction volume/well. The StepOne and
StepOnePlus systems support reaction volumes from 10 to 30 pL.

* Review the thermal profile:
— Make sure the thermal profile is appropriate for your reagents.
— Ifyou are performing 1-step RT-PCR, include a reverse transcription step.

If your experiment requires a different thermal profile, edit the thermal profile or
replace the run method with one from the Run Method library. The Run Method
library is included in the StepOne software.

 If you are running the experiment on a StepOnePlus instrument and you want to set
a different temperature for one or more of the VeriFlex blocks, you need to:
a. Design your experiment using Advanced Setup instead of the Design Wizard.

b. In the Plate Setup screen (page 30), select the Assign Targets and Samples
tab, select the View Plate Layout tab, then select the Enable VeriFlex " Block
checkbox.

IMPORTANT! If you do not select the Enable VeriFlex™ Block checkbox in
the Plate Setup screen, you will not be able to set a different temperature for
one or more of the VeriFlex blocks in the Run Method screen.

c. In the Run Method screen, select the Graphical View tab.

Notes
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d. For each VeriFlex" block you want to change, click the temperature, then enter
the desired value.

Note: You can set a different temperature for one or more of the VeriFlex blocks, or
set each of the VeriFlex blocks to the same temperature. If neighboring VeriFlex
blocks are not set to the same temperature, the temperature difference must be
between 0.1 and 5.0 °C. The maximum temperature is 99.9 °C.

For More For more information on:

Information * The Run Method library or on completing the Run Method screen, access the
StepOne Software Help by clicking @) or pressing F1.

» Setting temperatures for the VeriFlex blocks, access the StepOne Software Help by
clicking @) or pressing FI.

» Using Advanced Setup, see “Advanced Setup Workflow” on page 116.

Review the Reaction Setup

On the Reaction Setup screen, select the assay type (if using TagMan reagents), then
review the calculated volumes for preparing the PCR reactions, standard dilution series,
and sample dilutions. If needed, you can edit the reaction volume, excess reaction
volume, component concentrations, standard concentration, and/or diluted sample
concentration.

IMPORTANT! Perform these steps for each target assay in the reaction plate.

About the In the standard curve example experiment:
Exgmple * Applied Biosystems RNase P assay is used.
Experiment The reaction volume per well is 25 pL.
» The excess reaction volume is 10%.
* The reaction components are:

TagMan® Universal PCR Master Mix (2X) or TagMan® 2X Universal PCR
Master Mix, No AmpErase® UNG

— RNase P Assay Mix (20X)
Sample or standard
— Water
» The standard concentration in stock is 20,000 copies/uL.

* The diluted sample concentration is 6.6 ng/uL.
* The sample stock concentration is 100 ng/puL.

Notes
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Complete the Complete the Reaction Mix Calculations Tab

Reaction Setup

Screen Select the Reaction Mix Calculations tab (default).

From the Select Target pane, select RNase P (default).
From the Assay Type dropdown menu, select Inventoried/Made to Order.

2
3
4. Make sure the Reaction Volume Per Well field displays 25 uL.
5. Make sure the Excess Reaction Volume field displays 10%.

6

. In the Reactions for RNase P pane:
a. Make sure the Master Mix Concentration field displays 2.0X.
b. Make sure the Assay Mix Concentration field displays 20.0X.

c. Review the components and calculated volumes for the PCR reactions:

Component Volume (pL) for 1 Reaction
Master Mix (2.0X) 12.5
Assay Mix (20.0X) 1.3
Sample (10X) or Standard 2.5%
| H,O 8.8
Total Volume 25.0

I The sample or standard volume is limited to 10% of the total reaction

volume.
2E. Set Up: Reaction Setup Reaction Setup Help @
. Foreach target assay in the reaction plzte, selectthe assay type (if using TagMan reagents), then review the calculated [olumes for preparing the standard dilution
a Instructions:  series, samples, and PCR reactions. If heeded, editthe reaction volume, exces reaction volume, compaonent concentri tions, and/or stock concentrations, Click "Print
Reaction Setup” to print instructions on pow to prepare the PCR reactions
1 CReaction Mix Calculations T Sarnple [lilution Calculations ]
Select Targ I
) Assay Type [InventoriediMade to Order » | Reaction Volurne Per Well: pL  Excess ReactionVolume: 10 % | print Reaction Setup
P
Reactions for RNase P &
6a
6b H Master Mix Concentration ¥ Assay Mix Concentration 200 | X
Component WVolume (L) for 1 Reaction
Master Mix (2.0}
6¢
Hz0
Total Valume ' =
Standard Dilution Series for RNase P
Standard Concantration in Stock: | 100.0 | g | peruL
Dilution Point Source Source Volume (L) Diluent Volume (uL) Total Volume (L) Standard Concentrati
1 (10,000) | | ‘ | ‘ v
Notes
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7. In the Standard Dilution Series for RNase P pane:
a. Click the Standard Concentration in Stock field, then enter 20000.
b. Click the units field, then enter copies per uL.

c. Review the calculated volumes for preparing the standard dilution series:

Dilution Source Diluent Total Standard_
Point Source Volume Volume Volume Conce_ntratlon
(uL) (L) (L) (copies/pL)
1(10,000) | Stock 3.6 14.5 18.2 4000.0
2 (5,000) | Dilution 1 9.1 9.1 18.2 2000.0
3 (2,500) | Dilution 2 9.1 9.1 18.2 1000.0
4 (1,250) Dilution 3 9.1 9.1 18.2 500.0
5 (625) Dilution 4 9.1 9.1 18.2 250.0
2E. Set Up: Reaction Setup Reaction Setup Help @)

For each target assay in the reaction plate, selectthe assay type (if using TagMan reagents), then review the calculated volumes for preparing the standard dilution
a Instructions: series, samples, and PCR reactions. If needed, edit the reaction volume, excess reaction volume, component concentrations, andfor stock concentrations. Glick "Print
Reaction Setup" to printinstructions on how to prepare the PCR reactions

Reaction Mix Calculations ] Sample Dilution Calculations ]

SelectTargA T | toried/Made to Ord Reaction Val Perwell 25| E Reaction Vol 10| % |FmRn1 Set |
ssay Type Inventorie ade to Order eaction Volume Perwell: H xcess Reaction Volume Eri eaction up
‘ Total Volume 25.0 U
7a ]
7b | “ H Standard Concentration in Stack: copies “ | per L
” Dilution Point Source Source Volume (uL) | Diluent Volume (uLy Total Volume {uL) Standard Concentration (copiesfuL)
110,000y Stock 3.6 145 18.2 4000.0
2(5,000) Dilution 1 9.1 a1 18.2 2000.0
7C 3(2,500) Dilution 2 9.1 a1 18.2 1000.0
4(1,250) Dilution 3 9.1 a1 18.2 500.0]
5(625) Dilution 4 9.1 a1 18.2 250.0]
Complete the Sample Dilution Calculations Tab
1. Select the Sample Dilution Calculations tab.
2. Click the Diluted Sample Concentration (10X for Reaction Mix) field, then
enter 6.6.
3. From the unit dropdown menu, select ng/uL (default).
Notes
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard 35

Curve Experiments



36

m Chapter 2 Design the Experiment
Review the Reaction Setup

4. Review the calculated volumes for the sample dilutions:

Stock . Total Volume
Sample Name Concentration VO?::::I(e ) Vollz:lmu:rzt ) of Diluted
(ng/uL) H H Sample (uL)
pop1 100.0 1.0 14.2 15.2
pop2 100.0 1.0 14.2 15.2

2E. Set Up: Reaction Setup > Reaction Mix Calculations

Reaction Setup Help n

) For each target assay in the reaction plate, select the assay type (if using TagMan reagents), then review the calculated volumes For preparing the standard dilution series, samples, and PCR
u Instructions: yeactions. If needed, edit the reaction volume, excess reaction volume, component concentrations, andjor stock concentrations. Click "Print Reaction Setup” to print instructions on how to

1 prepare the PCR reactions, )
) ” [ Reaction Mix Calculations T Sample Dilution Calculations ]
3 Diluted Sample Concentration {10 For Reaction Mix): 3 | hajut Y | print Reaction Setup |
i jamp\a Name Stock Concentration (ngfuL) Sample Volume (pL) Diluent Volume (pL) Total Volume of Diluted Sample {pL)
4 pop! [t00.0 | 1.0 14.2 15.2
pop? [t00.0 | 1.0 14.2 15.2
Print Reaction Setup Instructions
Print detailed reaction setup instructions, then save the instructions for Chapter 3,
13 s 2
Prepare the Reactions.
. . .
1. Click Print Reaction Setup.
2E. Set Up: Reaction Setup > Reaction Mix Calculations Reaction Setup Help B
For each target assay in the reaction plate, select the assay type (if using TagMan reagents), then review the calculated volumes For preparing the standard dilution series, samples, and PCR
a Instructions: reactions. If needed, edit the reaction volume, excess reaction volume, component concentrations, andjor stock concentrations. Click "Print Reaction Setup” to print instructions on how to
prepare the PCR reactions,
j Reaction Mix Calculations T Sample Dilution Calculations ]
Diluted Sample Concentration (10 For Reackion Mix): ngjpL 1

Print Reaction Setup | ii ”

2. In the dialog box, select:
* Detailed Reaction Setup Instructions
* Include Plate Layout
* Use sample color

3. Click Print to send the reaction setup instructions to your printer.

Notes
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Print Reaction Setup Instructions &
a Select the type of instructions to print

© summary Reaction Setup Instructions
m (®) Detailed Reaction Setup Instructions
2 Ineiude Plate Layout

Plate Layout Print Options

(& Use sample color

O Use task calor

Preview ‘ | Prinit | ‘ Cancel

4. Click Next >.

Design  When you design your own standard curve experiment:

Guidelines » If you are using TagMan reagents, select the type of assay you are using:

— Select Inventoried/Made to Order if you are using Applied Biosystems
TagMan® Gene Expression Assays (Inventoried or Made to Order) or Applied
Biosystems Custom TagMan® Gene Expression Assays.

— Select Custom if you are designing your own assays with Primer Express®

software.

* Enter a number from 10 to 30 for the reaction volume/well. The StepOne and
StepOnePlus systems support reaction volumes from 10 to 30 pL.

* Include excess reaction volume to account for the loss that occurs during pipetting.
Applied Biosystems recommends an excess reaction volume of at least 10%.

* Review the reaction mix concentrations for each target: If needed:
— For TagMan reagents, edit the master mix and assay mix concentrations.

— For SYBR Green reagents, edit the master mix, forward primer, and reverse
primer concentrations.

— For 1-step RT-PCR, edit the reverse transcriptase concentration.
» Review the reaction mix components for each target:

— Ifyou are running Fast PCR reactions, make sure you use Fast master mix in the
PCR reactions.

— If you are running standard PCR reactions, make sure you use standard master
mix in the PCR reactions.

— For 1-step RT-PCR, make sure you include reverse transcriptase in the PCR
reactions and use a specific buffer.

* Review the standard dilution series calculations for each target. If needed, edit the
standard concentration in stock (including units).

Note: For the Standard Concentration in Stock units field, you can select ng or ug
from the dropdown menu or you can enter another unit in the field (for example,
copies, IU, [International Units], nmol, pg, and so on). The table updates according
to your entry.

Notes
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For More
Information

» Review the sample dilution calculations for each sample. If needed, edit the diluted
sample concentration (including units) and stock concentration.

For more information on:
» Completing the Reaction Setup screen, access the StepOne Software Help by
clicking @) or pressing F1.
* Applied Biosystems assays, refer to the:
— TagMan® Gene Expression Assays Protocol

— Custom TagMan® Gene Expression Assays Protocol

Order Materials for the Experiment

Notes

38

About the
Example
Experiment

On the Materials List screen, review the list of materials recommended to prepare the
PCR reaction plate. (Optional) Print the materials list, create a shopping list, then order
the recommended materials from the Applied Biosystems Store.

Note: To access the Applied Biosystems Store, you need to have an Internet connection.
Product availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries. Contact
your local Applied Biosystems representative for help.

Note: The StepOne software recommends the materials to order based on your
experiment design. It is assumed that you will design your experiment, order your
materials, then prepare (Chapter 3) and run (Chapter 4) the reaction plate when your
materials arrive.

In the standard curve example experiment, the recommended materials are:
+ MicroAmp"™ Fast Optical 48-Well Reaction Plate
* MicroAmp"" 48-Well Optical Adhesive Film
* MicroAmp™™ 96-Well Support Base

+ TagMan® Universal PCR Master Mix (2X) or TagMan® 2X Universal PCR Master
Mix, No AmpErase® UNG

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
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* Applied Biosystems RNase P assay

Note: The human RNase P FAM™ dye-labeled MGB probe is not available as a
TagMan® Gene Expression Assay. It can be ordered as a Custom TagMan® Gene
Expression Assay (PN 4331348).

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA dye as
a reporter or quencher with the StepOne system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus system.

Note: The example experiment was created for a StepOne instrument. If you selected the
StepOnePlus instrument in the Experiment Properties screen (page 20), the 96-well
consumables (for example, the MicroAmp" Fast Optical 96-Well Reaction Plate) are
listed in place of the 48-well consumables.

Complete the 1. For the example experiment, leave the Find Assay pane empty.

Materials List The human RNase P FAM dye-labeled MGB probe is not available as a TagMan
Screen Gene Expression Assay and cannot be ordered from the Order Materials List screen.
If desired, you can order it as a Custom TagMan Gene Expression Assay
(PN 4331348). Refer to the Custom TagMan® Gene Expression Assays Protocol.

Note: When you design your own standard curve experiment, see “Design
Guidelines” on page 41 for information on how to complete the Find Assay pane.

2. From the Display dropdown menu, select All Items (default), then review the
recommended materials. If needed, use the scroll bar at right to see all items.

Note: For more information on a specific item, click the part number link. You will
be connected to the product information page on Applied Biosystems Store. To
access the Applied Biosystems Store, you need to have an Internet connection.

3. (Optional) Click Print Materials List to send the materials list to your printer.

4. (Optional) Create a shopping list:

a. Select the checkbox next to each of the following items:
+ MicroAmp"" Fast Optical 48-Well Reaction Plate
+ MicroAmp"" 48-Well Optical Adhesive Film
+ MicroAmp™™ 96-Well Support Base
+ TagMan® Universal PCR Master Mix (2X) or TagMan® 2X Universal
PCR Master Mix, No AmpErase® UNG

b. Click Add Selected Items to Shopping List.

Notes
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5. (Optional) Create a shopping basket on the Applied Biosystems Store:

Note: To access the Applied Biosystems Store, you need to have an Internet
connection. Product availability and pricing may vary according to your region or
country. Online ordering through the Applied Biosystems Store is not available in all
countries. Contact your local Applied Biosystems representative for help.

a. Check that the Experiment Shopping List contains the desired materials and
that the quantities are correct, then click Order Materials in List.

3A. Order: Matenials List (Optional) Materials List Help @

a Instructions: Review the list of matarials recommended to prepare the PCR reaction plate. To create a shopping basket onthe Applied Biosystems Store, add items o the shopping
" list, enter a name for the shopping basket, click "Order Materials in List," then log in

Find Assay

Enter Gene Name | | | Find Assay ] Sg;earya gene name, then click "Find Assay" to search the Applied Biosystems Store for a gene expression

Experiment Materials List
| - |
| Add Selected tems to Shopping List | Display: |AH ltems v| | Print Materials List |

S—

w N

[ check Al Item Part Number Description

The MicroAmp™ Fast Optical 48-Well Reaction Plate, constructed
MicroAmp™ Fast Optical 48-Well Reaction Plate... 4375816 from a single rigid piece of polypropylens ina 48-well format. =

| Increased thermal contact for faster, more uniform heating

[ nnrdicallerl e film e a1 th, inte th

Experiment Shopping List (2 items) 5
a

‘ Remove Selected tems from Shopping List J Shopping Basket Name | Standard Curve Example StepCne | ‘ Oreler Materials in List J

b

[ check Al Item Part Number Quantity

O MicroAmpT™ Fast Optical 48-Well Reaction P 4375816 1 |

O MicroAmp™ 96-Well Suppart Base (10 bases) 4379500 1 |

b. In the Order Materials - Log In dialog box, enter your user name and password
for the Applied Biosystems Store, then click Login and Submit.

Note: If you do not have an account with the Applied Biosystems Store, click
Register Now to create an account.

Order Materials - Log In fg\

Log into the Applisd Biosystems Stors to place the selected items in your shopping basket. If you do not
have a user name and password, click "Register Now” to craate a new account.

OR (
Store Log In Register

To log into the Applied Biosystems Store, enter your user Ifyou do not have

name and password then click"Log In and Submit* an Applisd
— Biosystems
UserName: | | account, clickthe
link below to
create a new
5b Password: | | account.

‘ Log In and Submit Cancel J

Register Now

[[] Remember my user name and password for fulure orders
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c. When you are connected to the Applied Biosystems Store, follow the prompts
to complete your order.

6. Go to “Finish the Design Wizard” on page 42.

Design  When you design your own standard curve experiment:

Guidelines * Select all the materials you require for your experiment and add them to your

shopping list.
» To access the Applied Biosystems Store:
— Confirm that your computer has an Internet connection.

— Applied Biosystems recommends the following browsers and Adobe® Acrobat®
Reader versions to use the Applied Biosystems web site:

Desktop ® Microsoft® . ® Adobe®
Operating "rl\le;\ffz':zr Internet Matszlar}:‘c:’ish Acrobat®
System 9 Explorer Reader
Windows® v6.x or later v6.x or later Not applicable v4.0 or later
2000/NT/XP/Vista

Macintosh® OS Not supported | Not supported | v2.0.4 or later v4.0 or later
9+ or later

Note: Make sure that cookies and Java Script are turned on for the web site to
function correctly.

* To find your assay on the Applied Biosystems Store, complete the Find Assay pane:
a. Click the Enter Gene Name field, enter the gene name, then click Find Assay.
b. In the Find Assay Results dialog box, select your assay.

c. Click Apply Assay Selection.

% Find Assay Results g|
4 Assays Found. Click the Assay 1D to view the assay in the Applied Biosysterns Store. Selectan assay to detect and quantify the target sequence. TGF
Availability Assay D Gene Symbal Gene MName RefSeq
Cdk105 CDK105 protein
Made to Order  : Rn01480030 a1  LOCEET 366 similar to TGF beta-inducible nucl XM_001081532.1
rCG44568 Gene rCG44568 Celera Annotation
Cdk105 CDK105 protein MM_134415.1
Pre made RnO0821748 g1 LOC317618 similar to TGF beta-inducible nucl ¥M_001080801.1
rCG44568 Gene rCG44568 Celera Annotation
TR 501084633 TINP1 TGF beta-inducible nuclear prote.ln 1 NM_014886.2
hCG38159 Gene hCG38198 Celera Annotation
I 500852594 g TINP1 TGF beta-inducible nuclear protein 1 NM_014886.2
hCG38199 Gene hCG38199 Celera Annotation
| || 1071 Mext> | | Last | | Apply Assay Selection | | Cancel

For More For more information on completing the Materials List screen, access the StepOne
Information  Software Help by clicking ) or pressing F1.

Notes
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Finish the Design Wizard

To finish the Design Wizard, review the plate layout, then select an exit option.

About the The StepOne software automatically selects locations for the wells in the reaction plate.

Example In the standard curve example experiment:
Experiment » The wells are arranged as shown below.
| [ showinwells ¥ | B view Legend ‘ |
i I 2 - - A R
A [ rrase e [ rase » [ rnaser m RN:::F m RN:::F‘ m RN:::P m RN:::F m RN:::F‘
n m RN:::E E RNase P E RMase P E RMNase P 5DE3 RNase P SDEB RMase P SDES RMNase P QEgNase P
o |[El ruias=p 5] rhase P [ rhase P [ rhase P 5] rhase P [ rhase P [ rhase P 5] rhase P
2.5E3 2.5E3 1.25E3 1.25E3 1.25E3 625 625 625
D
E
F
Note: The example experiment was created for a StepOne instrument. If you
selected the StepOnePlus instrument in the Experiment Properties screen (page 20),
your reaction plate layout will differ from the layout shown above. The software
displays a 96-well reaction plate layout for the StepOnePlus instrument. For an
example of the 96-well reaction plate layout, see page 11.
» The experiment is saved as is and closed.
Note: For the example experiment, do not perform the run at this time.
Finish the 1. At the bottom of the StepOne software screen, click Finish Designing Experiment.
Design Wizard . . . .
2. In the Review Plate for Experiment window, review the plate layout. Make sure
there are:
¢ 6 Unknown wells [I]
e 15 Standard wells [5]
* 3 Negative control wells []
o 24 Empty wells
Note: If the plate layout is incorrect, click Return to the Wizard and check your
entered values.
Notes
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3. Click Save Experiment.

+ Review Plate Layout for Experiment "Standard Curve Example™

a Review the plate layout, then select what you wantto do next

| Create Ancther Experiment
3 | Save Experiment Start Run for This Experiment ‘ Edclit Plate Layout ‘ Using the Design Wizard ‘ Return to the Wizard ‘
Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Continue designing this
experiment. startthe run. Make sure the the plate layout. experiment, then create experiment using the Design
reaction plate is loaded into another experiment using the Wizard
the instrument, Design Wizard.
| 0| showinwelis ¥ | [ View Legend | ‘
! \ 2 | g | 1 \ 5 | 8 | 7 \ 8 |
popl popl popil pap2 pop2
| [ Avase P [ rvase p [ Rhase P

[ rhase P RNase P RMase P [ rhase P RNase P

B pop2 [ ruase ¢ [ rhase P ] rhase P [ ruase ¢ [ rhase P ] rhase P [ ruase ¢
m RNase P

1E4 1E4 1E4 SE3 5E3 5E3 2.5E3

c E RNase P E RNase P E RNase P E RNase P E RNase P E RNase P E RNase P E RNase P

2 2.5E3 2.5E3 1.25E3 1.25E3 1.25E3 625 625 625

4. Inthe Save Experiment dialog box, click Save to accept the default file name and

location. The example experiment is saved and closed, and you are returned to the
Home screen.

Note: By default, the example experiment is saved to the <drive>:\Applied
Biosystems\<software name>\experiments folder.

Save Experiment Standard Curve Example

Save in: |@ experiments v| PEEe
My Recent

Documents

&

[=}

esktop

S

My Documents

My Computer

@

- File name ‘ Standard Curve Example.eds | | save J 4
My Network
Places Files of type: ‘Experlmem Document Single files (*.eds) V| | cancel J
Notes
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Design
Guidelines

When you design your own standard curve experiment:

* In the Review Plate for Experiment window, select the appropriate exit option:

Click

If you want to...

Save Experiment

save and close the experiment without making any
further changes or starting the run.

Start Run for This Experiment

Edit Plate Layout

Create Another Experiment Using

the Design Wizard

save the experiment and start the run. Make sure the
reaction plate is loaded in the instrument.

e use advanced setup to edit the plate layout.

e (StepOnePlus instrument only) set a different
temperature for one or more of the VeriFlex blocks
using Advanced Setup.

save and close the current experiment, then create

another experiment using the Design Wizard.

Return to the Wizard

return to the experiment to make changes using the
Design Wizard.

* By default, experiments are saved to the <drive>:\Applied Biosystems\<software
name>\experiments folder. To change the:

— Save location for a specific experiment, navigate to the desired location using the

Save Experiment dialog box.

— Default save location, select Tools » Preferences, then select the General tab
(default). In the Default Data Folder field, browse to the desired location.

For More For more information on using Advanced Setup, see “Advanced Setup Workflow” on

Information page 116.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard

Curve Experiments




Chapter 3

Prepare the Reactions

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 46
B Prepare the Sample Dilutions . . . ......... .. .. .. . 47
B Prepare the Standard Dilution Series .. ............ .. ... .. ... ... 49
B Prepare the Reaction MiX . .. ... i 51
B Preparethe ReactionPlate . ........ ... ... ... .. ... .. ... .. ... .. ... ..., 53

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

This chapter explains how to prepare the PCR reactions for the standard curve example
experiment and provides guidelines for how to prepare the PCR reactions for your own
standard curve experiment.

Example The workflow for preparing the PCR reactions for the example experiment provided with
Experiment this getting started guide is shown below.

Workflow
Start Experiment

v
Design the Experiment (Chapter 2)

v
Prepare the Reactions (Chapter 3)

Prepare the sample dilutions.

Prepare the standard dilution series.

Prepare the reaction mix for each target assay.

Eall A

Prepare the reaction plate.

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

v
End Experiment

Notes
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Prepare the Sample Dilutions

Perform sample dilutions before adding the samples to the final reaction mix. Dilute the
samples using the volumes that were calculated by the StepOne™ software (“Complete
the Sample Dilution Calculations Tab” on page 35).

About the For the standard curve example experiment:

Exa_.mple » Sample dilutions are necessary because the sample volume is limited to 10% of the
Experiment total reaction volume in the StepOne software. The total reaction volume is
25 uL/reaction, so the sample volume is 2.5 puL/reaction.

» The stock concentration is 100 ng/uL. After diluting the sample according to the
Sample Dilutions Calculations table, the sample will have a concentration of
6.6 ng/uL. This is a 10X concentration when adding 2.5 UL to the final reaction mix
volume of 25 L. You will have a 1X concentration in the final reaction.

¢ The volumes calculated in the software are:

Stock . Total Volume
. Sample Diluent .
Sample Name Concentration of Diluted
(ng/pL) Volume (pL) | Volume (uL) Sample (uL)
pop1 100.0 1.0 14.2 15.2
pop2 100.0 1.0 14.2 15.2
Required + Water to dilute the sample
Materials  Microcentrifuge tubes
* Pipettors
* Pipette tips
» Sample stock
* Vortexer
* Centrifuge
Prepare the 1. Label a separate microcentrifuge tube for each diluted sample:
Sample Dilutions « Population 1
* Population 2
2. Add the required volume of water (diluent) to each empty tube:
Tube Sample Name Diluent Volume
(L)
1 Population 1 14.2
2 Population 2 14.2
Notes
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3. Add the required volume of sample stock to each tube:

Sample Volume

Tube Sample Name
! P (WL)
1 Population 1 1.0
2 Population 2 1.0

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Preparation When you prepare your own standard curve experiment:

Guidelines » Sample dilutions may be necessary because the sample volume is limited to 10% of
the total reaction volume in the StepOne software. You must perform the sample
dilutions before adding the samples to the final reaction mix.

+ For optimal performance of TagMan® Gene Expression Assays or Custom
TagMan® Gene Expression Assays, use 10 to 100 ng of cDNA template per
20-uL reaction. For Fast reagents, Applied Biosystems recommends 10 ng.

* Use TE buffer or water to dilute the sample.

For More For more information on Applied Biosystems assays, refer to the:
Information » TagMan® Gene Expression Assays Protocol

» Custom TagMan® Gene Expression Assays Protocol

Notes
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Prepare the Standard Dilution Series

Prepare the standard dilution series using the volumes that were calculated by the
StepOne software (“Complete the Reaction Mix Calculations Tab” on page 34).

About the For the standard curve example experiment:
Example + The standard concentration in stock is 20,000 copies/uL.

Experiment * The volumes calculated in the software are:
Dilution Source Diluent Total Standard_
Point Source Volume Volume Volume Conce.ntratnon
(L) (L) (L) (copies/uL)
1 (10,000) Stock 3.6 14.5 18.2 4000.0
2 (5,000) Dilution 1 9.1 9.1 18.2 2000.0
3 (2,500) Dilution 2 9.1 9.1 18.2 1000.0
4 (1,250) | Dilution 3 9.1 9.1 18.2 500.0
5 (625) | Dilution 4 9.1 9.1 18.2 250.0

Required + Water to dilute the standards
Materials * Microcentrifuge tubes

* Pipettors

* Pipette tips

+ Standard stock

» Vortexer

* Centrifuge

Prepare the 1. Label a separate microcentrifuge tube for each standard:
Standard Dilution « RNase P Std. 1
Series for the « RNase P Std. 2
RNase P Assay
* RNase P Std. 3

e RNase P Std. 4
e RNase P Std. 5

2. Add the required volume of water (diluent) to each empty tube:

Volume of
Tube Standard Name Diluent to
Add (pL)
1 RNase P Std. 1 14.5
2 RNase P Std. 2 9.1
3 RNase P Std. 3 9.1
Notes
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8.

Volume of
Tube Standard Name Diluent to
Add (L)
4 RNase P Std. 4 9.1
5 RNase P Std. 5 9.1

Prepare dilution 1 in the RNase P Std. 1 tube:
a. Vortex the stock for 3 to 5 seconds, then centrifuge the tube briefly.
b. Using a new pipette tip, add 3.6 uL of stock to the RNase P Std. 1 tube.

c. Vortex Std. 1 for 3 to 5 seconds, then centrifuge the tube briefly.

Prepare dilution 2 in the RNase P Std. 2 tube:
a. Using a new pipette tip, add 9.1 pL of dilution 1 to the RNase P Std. 2 tube.

b. Vortex Std. 2 for 3 to 5 seconds, then centrifuge the tube briefly.

Prepare dilution 3 in the RNase P Std. 3 tube:
a. Using a new pipette tip, add 9.1 uL of dilution 2 to the RNase P Std. 3 tube.
b. Vortex Std. 3 for 3 to 5 seconds, then centrifuge the tube briefly.

Prepare dilution 4 in the RNase P Std. 4 tube:
a. Using a new pipette tip, add 9.1 pL of dilution 3 to the RNase P Std. 4 tube.
b. Vortex Std. 4 for 3 to 5 seconds, then centrifuge the tube briefly.

Prepare dilution 5 in the RNase P Std. 5 tube:
a. Using a new pipette tip, add 9.1 uL of dilution 4 to the RNase P Std. 5 tube.
b. Vortex Std. 5 for 3 to 5 seconds, then centrifuge the tube briefly.

Place the standards on ice until you prepare the reaction plate.

Preparation When you prepare your own standard curve experiment:

Guidelines .

L]

Notes

Standards are critical for accurate analysis of run data.

Any mistakes or inaccuracies in making the dilutions directly affect the quality of
results.

The quality of pipettors and tips and the care used in measuring and mixing
dilutions affect accuracy.

Use TE buffer or water to dilute the standards.
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Prepare the Reaction Mix

Prepare the reaction mix using the components and volumes that were calculated by the
StepOne software (“Complete the Reaction Mix Calculations Tab” on page 34).

Note: The software calculates the volumes for all components for the PCR reactions.
However, when you prepare the reaction mix in this section, include only the master mix,
assay mix, and water. Add the sample or standard when you prepare the reaction plate
(see “Prepare the Reaction Plate” on page 53).

About the For the standard curve example experiment:

Example  The reaction mix components are:

Experiment — TagMan® Universal PCR Master Mix (2X) or TagMan® 2X Universal PCR
Master Mix, No AmpErase® UNG

— RNase P Assay Mix (20X)
— Water
* The volumes calculated in the software are:

Component Volume (pL) for 1 Reaction
Master Mix (2.0X) 12.5
Assay Mix (20.0X) 1.3
H,O | 8.8
Total Volume | 22.6

Note: The sample or standard is not added at this time.

Required * Microcentrifuge tubes
Materials « Pipettors

* Pipette tips
» Reaction mix components (listed above)
* Centrifuge

Notes
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Prepare the _ (7:\V}i[e]{] CHEMICAL HAZARD. TagMan® Universal PCR Master Mix

Reaction Mix (2X) may cause eye and skin irritation. Exposure may cause discomfort if swallowed or
inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.

) A (7:\0}§[e]/] CHEMICAL HAZARD. TagMan® 2X Universal PCR Master

Mix, No AmpErase® UNG may cause eye and skin irritation. Exposure may cause
discomfort if swallowed or inhaled. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves.

1.
2.

3.
4,

5.

Label an appropriately sized tube for the reaction mix: RNase P Reaction Mix.

For the RNase P assay, add the required volumes of each component to the tube:

Volume (L) for Volume (pL) for

Component 1 Reaction 24 Reactions
(Plus 10% Excess)
TagMan® Universal PCR Master 12.5 330.0
Mix (2X) or TagMan® 2X
Universal PCR Master Mix, No
AmpErase® UNG
RNase P Assay Mix (20X) 1.3 34.3
Water 8.8 232.3
Total Reaction Mix Volume 22.6 596.6

Mix the reaction mix by gently pipetting up and down, then cap the tube.
Centrifuge the tube briefly to remove air bubbles.

Place the reaction mix on ice until you prepare the reaction plate.

Preparation When you prepare your own standard curve experiment:

Guidelines .

Notes

If your experiment includes more than one target assay, prepare the reaction mix for
each target assay separately.

Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers. Applied Biosystems recommends an excess
volume of at least 10%.

Include all required components.
Prepare the reagents according to the manufacturer’s instructions.

Keep the assay mix protected from light, in the freezer, until you are ready to use it.
Excessive exposure to light may affect the fluorescent probes.

Prior to use:
— Mix the master mix thoroughly by swirling the bottle.
— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.
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— Thaw any frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

For More For more information on preparing the reaction mix, refer to the protocol appropriate for
Information the reagents you are using in the PCR reactions:

» TagMan® Gene Expression Assays Protocol

» Custom TagMan® Gene Expression Assays Protocol

Prepare the Reaction Plate

Prepare the reactions for each replicate group, then transfer them to the reaction plate.
Use the plate layout displayed in the StepOne software.

About the For the standard curve example experiment:

Exqmple + A MicroAmp"™ Fast Optical 48-Well Reaction Plate is used.
Experiment The reaction volume is 25 pL/well.
» The reaction plate contains:

— 6 Unknown wells
15 Standard wells [5]

3 Negative control wells [

— 24 Empty wells
» The plate layout automatically generated by the StepOne software is used:

Notes
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Prepare the Reaction Plate

Required .
Materials .

Prepare the 1.
Reaction Plate

Notes

| EShnwinWelle | ViewLegend ‘ |

1 | ! | 3 | 4 | 5 | 6 | 7 | 8 |

popl popl popt popl popl

# | ruaser [ rheser [ rhaser [0 ~hase P [ ruase P [ rhase P [0 ~hase P [ ruase P

pap2 D RNase P D RMase P D RNase P D RNase P D RMase P D RNase P D RNase P

B
[ rhase p 1E+ 1E4 184 563 563 563 2,563

c D RNase P D RNase P D RNase P D RNase P D RNase P D RNase P D RNase P D RNase P
625

2.5E3 2.5E3 1.25E3 1,25E3 1.25E3 625 625

Note: The example experiment was created for a StepOne instrument. If you
selected the StepOnePlus instrument in the Experiment Properties screen (page 20),
your reaction plate layout will differ from the layout shown above. The software
displays a 96-well reaction plate layout for the StepOnePlus instrument. For an
example of the 96-well reaction plate layout, see page 11.

Microcentrifuge tubes

Pipettors

Pipette tips

RNase P reaction mix (from page 52)

Water

Standards (from page 49)

Samples (from page 47)

MicroAmp"™ Fast Optical 48-Well Reaction Plate
MicroAmp" 48-Well Optical Adhesive Film
Centrifuge

Prepare the negative control reactions for the target:

a. To an appropriately sized tube, add the volumes of reaction mix and water
listed below.

Reaction Mix | Water Volume

Tube Reaction Mix Volume (uL) (uL)
1 RNase P reaction 74.6 8.3
mix

b. Mix the reaction by gently pipetting up and down, then cap the tube.
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c. Centrifuge the tube briefly to remove air bubbles.

d. Add 25 pL of the negative control reaction to the appropriate wells in the
reaction plate.

2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard
listed below.

Reaction
Tube Standard Reaction Mix Standard S\;z::ld;;d
Reaction Mix Volume (uL)
(uL) "

1 RNase P RNase P 74.6 RNase P 8.3
Std 1 reaction mix Std 1

2 RNase P RNase P 74.6 RNase P 8.3
Std 2 reaction mix Std 2

3 RNase P RNase P 74.6 RNase P 8.3
Std 3 reaction mix Std 3

4 RNase P RNase P 74.6 RNase P 8.3
Std 4 reaction mix Std 4

5 RNase P RNase P 74.6 RNase P 8.3
Std 5 reaction mix Std 5

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 25 pL of the standard reaction to the appropriate wells in the reaction
plate.

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample
listed below.

Reaction Sample
Unknown Reaction Mix
Tube Reaction Mix Volume Sample Vc;Iqu)n e
(uL) "
1 RNase P RNase P 74.6 pop1 8.3
pop1 reaction mix
2 RNase P RNase P 74.6 pop2 8.3
pop2 reaction mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.
d. Add 25 pL of the unknown (sample) reaction to the appropriate wells in the

reaction plate.

Notes
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4. Seal the reaction plate with optical adhesive film.
5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect
3
Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. o Not centrifuged for enough time

7. Until you are ready to perform the run, place the reaction plate on ice in the dark.

Preparation When you prepare your own standard curve experiment:
Guidelines * Make sure you use the appropriate consumables.

» Make sure the arrangement of the PCR reactions matches the plate layout displayed
in the StepOne software. You can either:

— Accept the plate layout automatically generated by the software.
or
— Use Advanced Setup to change the plate layout in the software.

» Ifyou use optical adhesive film to seal your reaction plates, seal each reaction plate
as follows:

Example
Action
StepOne™ System StepOnePlus™ System

1. Place the reaction plate onto the center of the 96-well base. Be sure the reaction plate is flush with the top surface of the
96-well base.

2. Load the reaction plate as desired.

3. Remove a single optical adhesive film (film) from the box. PN

* For the StepOne system reaction plate, bend both end-tabs
upward. Hold the film backing side up.

* For the StepOnePlus system reaction plate, fold back one of
the end-tabs. Hold the film backing side up.

Notes
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Example
Action
StepOne™ System StepOnePlus™ System

4. In one swift movement, peel back the white protective backing
from the center sealing surface. Do not touch the center
sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may
result in haziness, but will not affect results. Haziness will
disappear when the film comes into contact with the heated cover
in the instrument.

5. Holding the film by the end-tabs, lower the film onto the
reaction plate (adhesive side facing the reaction plate). Be sure
the film is completely covering all wells of the reaction plate.

6. While applying firm pressure, move the applicator slowly
across the film, horizontally and vertically, to ensure good
contact between the film and the entire surface of the reaction
plate.

7. While using the applicator to hold the edge of the film in place,
grasp one end of the end-tab and pull up and away sharply.
Repeat for the other end-tab.

8. To ensure a tight, evaporation-free seal:
a. Repeat step 6.
b. While applying firm pressure, run the edge of the applicator along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the application of pressure to ensure a tight,
evaporation-free seal.

9. Inspect the reaction plate to be sure all wells are sealed. You should see an imprint of all wells on the surface of the film.

For More For more information on:
Information * Preparing the reaction plate, refer to the protocol appropriate for the reagents you
are using in the PCR reactions:

— TagMan® Gene Expression Assays Protocol
— Custom TagMan® Gene Expression Assays Protocol
* Consumables, see “Supported Consumables” on page 4.

» Using Advanced Setup to change the plate layout, see “Advanced Setup Workflow”
on page 116.

Notes
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Prepare the Reaction Plate

Notes
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n Run the Experiment

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 60
B Prepare forthe Run. .. ... ... ... ... . . 61
B (Optional) Enable the Notification Settings . . . ........... ... ... ... 63
B Startthe Run. . ....... ... 65
B Monitorthe Run . ... ... ... . 69
B Unload the Instrument and Transferthe Data. . ........................... 76

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems StepOne™ and
StepOnePlus™ Real-Time PCR Systems.

Example The workflow for running the example experiment provided with this getting started
Experiment guide is shown below.

Workflow
Start Experiment

h 4
Design the Experiment (Chapter 2)

v
Prepare the Experiment (Chapter 3)

h 4
Run the Experiment (Chapter 4)

Prepare for the run.
(Optional) Enable the notification settings.
Start the run.

Monitor the run.

o > 0 b=

Unload the instrument and transfer the data.

v
Analyze the Experiment (Chapter 5)

h 4
End Experiment

Notes
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Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 2,
then loading the sealed reaction plate into the StepOne™™ or StepOnePlus™ instrument.

Open the 1. Double-click g (StepOne software shortcut) or select
Example Start » All Programs » Applied Biosystems » StepOne Software »
Experiment <software name>

where <software name> is the current version of the StepOne software.
2. From the Home screen, click Open.

3. In the Open dialog box, navigate to the experiments folder (default):

<drive>:\Applied Biosystems\<software name>\experiments

4. Double-click Standard Curve Example to open the example experiment file you

created in Chapter 2.
File Edit Instrument Analysis Tools Help

2 ] MEW ER] pENmEn & Open.. H _:. JJ Send Experiment to Instrument.. L_'r Download Experiment from Instrument.. &30
Analyze
ﬁ‘ e Experiment

3 Counn ) experiments v BEEE

() examples
4 T i Standard Curve Example.eds

My Recent
Documents

My Computer

;_g File name Standard Curve Example.eds
My Network
Places Files oType: Al SDS Files (2dm; eds; edf)

Notes
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Load the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Reaction Plate temperature of the sample block(s) can exceed 100 °C. If the instrument has been used
Into the recently, keep your hands away until the sample block(s) reaches room temperature.
Instrument

# IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Open the instrument drawer.

StepOne instrument StepOnePlus
sample block instrument VeriFlex™
Sample Blocks

2. Place the reactions in the sample block(s):

» If using a reaction plate: Place the reaction plate in the sample block(s) with
well A1 at the back-left corner.

» If using reaction tube strips: Place the tray containing the tube strips in the
sample block(s).

» Ifusing reaction tubes: Place the tray containing the tubes in the sample
block(s).

Notes
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IMPORTANT! For optimal performance with partial loads:

StepOnePlus instruments - Load at least 16 tubes and arrange them in:

* Adjacent columns of 8 tubes, using rows A through H. For example, fill wells
in column 1 (rows A through H) and column 2 (rows A through H).

or

* Adjacent rows of 8 tubes, using columns 3 through 10. For example, fill wells
in row A (columns 3 through 10) and row B (columns 3 through 10).

StepOne instruments - Load at least 4 tubes in the sample block.

3. Close the instrument drawer carefully.

éCAUTION

(Optional) Enable the Notification Settings

Enable the notification settings so that the StepOne software alerts you via email when
the StepOne or StepOnePlus instrument begins and completes the run, or if an error
occurs during the run. Enabling the notifications settings feature is optional and does not
affect the performance of the StepOne™ and StepOnePlus'™ systems or the duration of
the run.

IMPORTANT! The notification settings feature is available only if the computer that you
are using is running the StepOne or StepOnePlus instrument and is connected to an
Ethernet network.

Note: The notification system is also available to computers that are monitoring a
StepOne or StepOnePlus instrument remotely. For more information, see “Remote
Monitor” on page 73.

About the In the example experiment:

Exgmple » The StepOne software is set up to send notifications to three users (scientist,
Experiment supervisor, and technician at mycompany.com) when the StepOne or StepOnePlus
system ends the run and if it encounters any errors during operation.

e The example SMTP server (www.mycompany.com) is set up for Secure Sockets
Layer (SSL) encryption and requires authentication for use.

Notes
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Set Up the 1. In the StepOne software, click @ Run in the navigation pane.
Notification

Settings Click 5 Notification Settings.

Select Yes for Enable Notifications.

P 0D

Select the events that will trigger notifications:
a. Select Instrument Error.

b. Select Run Completed.

5. In the Enter e-mail addresses for notifications field, enter:
scientist@mycompany.com, supervisor@mycompany.com,
technician@mycompany.com.

6. Inthe Outgoing Mail Server (SMTP) field, enter smtp.mycompany.com.

7. Set the authentication settings:
a. Select Yes for Server requires authentication.
b. In the User Name field, enter Example User.

c. In the Password field, enter password.

Notification Settings

3 1
Enablz Notifications: & Yes O Mo
Selectthe events to generate notifications Instrument Error
4 [J Run Startsd
Run Completed
5 Enter e-mail addresses for notifications: |scientist@mycompany.com, superisor@mycompany.com, technician@rmycompany.com
Separate e-mail addresses with commas
For example: jane_smith@mydamain.com,awong@bigmailhost.com
6 Outgoing Mail Server (SMTP): | smitp.mycormpany.com
For example: smtp.mycompany.com
7a Server requires an encrypted connection? OYes & No
|
Semer requires authentication? & Yes O No
7b (Server Authentication) User Name: | Example User
7c (Semver Authentication) Password: wnwwwwwwl

Run Guidelines When you set up the StepOne or StepOnePlus system for automatic notification:

* Your system must be set up for network use. Refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking,
and Maintenance Guide.

» Select the events for which you want to receive e-mail notifications:

— Instrument Error — When selected, recipients are e-mailed all errors
encountered by the instrument during each run.

— Run Started — When selected, recipients are e-mailed every time the instrument
starts a run.

Notes
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— Run Completed — When selected, recipients are e-mailed every time the
instrument completes a run.

¢ Obtain e-mail addresses to receive notifications.

IMPORTANT! Separate addresses with a comma (,).

* Contact your systems administrator or information technology department if you
need:

— E-mail addresses for users who will receive notifications

A network address for a simple mail transfer protocol (SMTP) server on the LAN

A user name and password for the server, if required for access

The Secure Sockets Layer (SSL) setting of the server (on or off)

Start the Run

Start the run according to the layout of your StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer to the “Colocated Startup”
instrument below
Standalone e The computer and the instrument are not “Standalone Startup”
connected, or on page 66
e The computer and the instrument are
connected to the same network.

Colocated Perform this procedure if your computer is directly connected to your StepOne or
Startup  StepOnePlus instrument by the yellow cable.

1. In the StepOne software, click % Run in the navigation pane.
2. Click START RUN g .

2

' Setup
T

1 Instrument Status: @& Connected

—
e cetio i Run Status:  Not Started Enable Notifications

Notes
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Standalone Perform these procedures if your computer and StepOne or StepOnePlus instrument are
Startup not directly connected by the yellow cable. Start with:

* “Send the Experiment to the Instrument Over the Network™ on page 66 if your
computer and instrument are connected to the same network.

or

* “Transfer the Experiment to the Instrument Using a USB Drive” on page 66 if your
computer and instrument are not connected to the same network.

Send the Experiment to the Instrument Over the Network

1. In the StepOne software, click %] Send Experiment to Instrument.

2. In the Send Experiment to Instrument dialog box:
a. Click Browse, navigate to the example experiment file, then click Open.
b. Select the instrument to receive the experiment file.
Note: If your instrument is not listed, set up the instrument for monitoring as

explained in the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time
PCR Systems Installation, Networking, and Maintenance Guide.

c. Click Send Experiment to send the experiment to the your instrument over the

network.
Send Experiment to Instrument g|
a Selectan experimentto send, selectthe instrument to receive the experiment, then click
"Send Experiment” OJ
2a —1 1 select Experiment | Browse
2b 1 2 Selectinstrument. % Local Instrument (Default) v

20 : Send Experiment | Cancel

3. When prompted, click OK to close the confirmation.

4. Go to “Start the Instrument Run Using the Touchscreen” on page 67.

Transfer the Experiment to the Instrument Using a USB Drive
1. Connect the USB drive to one of the USB ports on the computer.
2. In the StepOne software, select [ Save » Save As.

3. In the Save dialog box, navigate to the USB drive, then click Save.

Notes
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Start the Run

Remove the USB drive from your computer, then connect it to the USB port of your
StepOne or StepOnePlus instrument.

Go to “Start the Instrument Run Using the Touchscreen” below.

Start the Instrument Run Using the Touchscreen

1.

a » 0O DN

Notes

Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch @

Wait for the USB sign to appear on the touchscreen.
In the Main Menu screen, touch Browse/New Experiments.
In the Browse screen, touch {fZ) Folders.

In the Choose an Experiment Folder screen:
» Touch USB if you transferred the experiment on a USB drive.
* Touch Default if you sent the experiment over a network connection.
Before starting the run, save the example experiment to your instrument:
a. In the Browse screen, touch the example experiment name, then touch Copy.

b. In the Save Experiment screen, navigate to a destination folder, then click
Save & Exit.

In the Browse screen, touch the example experiment name, then touch
[ Start Run.
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Start the Run

( ﬁ) Browse Last Accessed Experiments (1)
4
Experiment I Folder I Last Used * D'

R o 1ple Experiment

Transfer

Page
111

6a —

LX)

r (elwlzlels] -

Start Run Mew View/Edit Copy Delete

any of the buttons to perform an action.

Touch an experiment to select it, then touch
Touch a column title to sort the table.

8. In the Run Parameters screen:

a. Touch the Reaction Volume field, use the keypad to enter the reaction volume

for the example experiment, then touch Done.

b. Touch Start Run Now.

{‘ ﬁ, Experiment Parameters

8a Reaction Volume: Iz5 uL

Cover Temperature: |105.0 o0

Experiment Name: IExampIeiExperiment

Start Run
8b Now I
Touch each field then use the keyboard
to edit the contents. When you are finished, ?
touch Start Run.
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Monitor the Run

Monitor the run according to the layout of your StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer to the “Colocated Monitoring”
instrument. below
Standalone The computer and the instrument are “Remote Monitor” on
(Networked) connected to the same network. page 73
Standalone The computer and the instrument are not “Standalone Monitoring”
(Basic) connected. on page 75

Colocated If your computer is directly connected to your StepOne or StepOnePlus instrument by the

Monitoring yellow cable, you can view the progress of the run in realtime as described below. During
the run, periodically view all three plots available from the StepOne software for
potential problems.

# To... Action

>

Stop the run 1. In the StepOne software, click STOP RUN.

2. In the Stop Run dialog, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the
current cycle or hold.

— Cancel to continue the run.

B | View amplification data | Select w Amplification Plot.

in realtime See “About the Amplification Plot Screen” on page 70.

C | View temperature data Select @ Temperature Plot.

for the run in realtime See “About the Temperature Plot Screen” on page 71.

D | View progress of the Select |: Run Method.
run in the Run Method See “About the Run Method Screen” on page 72.

screen

E | Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “(Optional) Enable the Notification Settings” on page 63.

Notes
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I Setup |
" Run
—

Amplification Plot

S| [P Temperature Plot
C ‘emperature Plo Temperature Plot Current Temperatures
D ’\ Run Method & W cover

.Samp\e
Notification Settings Temperature Plot Block

Estimated Time Remaining:56 min 22 sec Instrument Status: (}a Connected

Run Status 7 [ Enable Notifications E

110

100

o0

80

70

&0

Temperature

50

0 Temperature Plot

o
00000 000410 00320 00230 0840 002081 002500 00230 00330 OOATAD 004140 OD4ES)  0OSO00  OOS6ND OOSAZ0 View 1 Hour 3
Time

Fixed view []

About the Ampilification Plot Screen

The Amplification Plot screen allows you to view sample amplification as your
instrument collects fluorescence data during a run. If a method is set up to collect real-
time data, the Amplification Plot screen displays the data for the wells selected in the
View Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and cycle
number. The figure below shows the Amplification Plot screen as it appears during the
example experiment.

To view data in the Amplification Plot screen, select the wells that you want to view in
the View Plate Layout tab.

>
R P iy = =
Amplification Plot | 9 | showinwells ¥

SelectWells with: | Selectitem - v || |

View Legend

T
2

1 2 3 4 i} B 7 8

A DRNa DRNa DRNa mRNa RNa RNa mRNa RNa

B | wna 15 LIER S IS TS IO S ETERTS TSI S T

1E4 1E4 1E4 FE3 5E3 5E3 2 5E3

ARn

(SRS TR S ETES EIE S EIS S EIE S LR s FT

2.6E3 2 5E3 1.25E3 126E3 112563 (625 625 625

o

2 4 & A W0 12 4 1@ 1@ N B M N M N B M B B O
Cycle

[ Legend

| ENEl d bl 3 [ F

The Amplification Plot screen is useful for identifying and examining abnormal
amplification. Abnormal amplification can include the following:

* Increased fluorescence in negative control wells.

Notes
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» Absence of detectable fluorescence at an expected cycle (determined from previous
similar experiments run using the same reagents under the same conditions).

If you notice abnormal amplification or a complete absence of signal, troubleshoot the
error as explained in the StepOne Software Help (click @ or press F1).
About the Temperature Plot Screen

During a run, the Temperature Plot screen displays the temperatures of the sample
block(s), the heated cover, and samples (calculated) in realtime. The figure below shows
the Temperature Plot screen as it appears during the example experiment.

To... Action

A | Add/remove temperature plots Select Cover or Sample Block to
toggle the presence of the
associated data in the plot.

B | Change the time displayed by plot From the View dropdown menu,
select the amount of time to display
in the plot.

C | Display a fixed time window during the instrument | Select Fixed View.
run

If the entire plot does not fit in the screen, the
screen is not updated as the run progresses. For
example, if you select 10 minutes from the View
dropdown menu, the plot will show data for 10
minutes. If the run lasts more than 10 minutes:

e The plot updates as the run progresses with
Fixed View deselected.

¢ The plot does not update as the run progresses
with Fixed View selected.

Temperature Plot Current Temperatures

JEN ||_ g Mcover — A
N .Sample
Temperature Plot Black

A AR A

e Temperature Plot
o

Temperature

00:33:20 00:41:40 00:50:00 00:58:20 Tine 01:06:40 01:15.00 01:23:20 01:31: View 1 Hour v B
Fixed View [] C
The Temperature Plot screen can be useful for identifying hardware failures. When
monitoring the Temperature Plot screen, observe the Sample and Block plots for
abnormal behavior.
Notes
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Monitor the Run

Run Method Edit Run Method

* In general, the Sample and Block plots should mirror each other approximately. A
significant deviation of the plots may indicate a problem.

» The Cover plot should maintain the constant temperature specified in the method. A
departure from the constant temperature may indicate a problem.

If you notice an abnormal temperature plot, troubleshoot the error as explained in the
StepOne Software Help (click @ or press F1).

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.

About the Run Method Screen

The Run Method screen displays the run method selected for the run in progress. The
software updates the Run Status field throughout the run. The figure below shows the
Run Method screen as it appears in the example experiment.

To...

Change the number of cycles

Action

In the Adjust # of Cycles field, enter the number of
cycles to apply to the Cycling Stage.

Add a melt curve stage to the
end of the run

Select Add Melt Curve Stage to End.

Add a Hold stage to the end of

the run

Select Add Holding Stage to End.

D

Apply your changes

Click Send to Instrument.

Holding Stage

Cycling Stage

gow>

Starting Cycle

100 —|

75—

50 —|

25 —|

<

Step 1

Step 2

Step 1

Step 2

Legend
Data Collection On

Data Collection Off A AutoDelta On A AutoDelta Off

Notes

72

If an alert appears, click the error for more information and troubleshoot the problem as
explained in the StepOne Software Help (click @ or press F1).
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Remote Monitor If your StepOne or StepOnePlus instrument is connected to a network, you can use the
Remote Monitor in the StepOne software to view the progress of the run in realtime from
any computer on the network.

IMPORTANT! Networked computers cannot control the StepOne or StepOnePlus
instrument, only monitor it.

To monitor your instrument remotely:

1. In the StepOne software, select Instrument » Remote Monitor.

2. In the navigation pane, select your instrument.

If the navigation pane does not list your instrument:
a. Click Add Instrument.

b. Enter a name for the instrument profile within the Remote Monitor.

Note: Enter any name that helps you identify the instrument. The profile name
you enter will be displayed in the Remote Monitor and in the instrument
dropdown menus when you send experiments, download experiments, or
monitor instruments.

c. In the Instrument Name, Host Name, or IP Address field:
 If you know the host name, enter the host name.

» If you do not know the host name, enter the instrument name or IP
address.

Note: The instrument name and IP address are displayed on the instrument
touchscreen. Go to Settings Menu » Admin Menu » Set Instrument Name
or Set IP Address. Contact your systems administrator or information
technology department for the host name.

d. Click Save & Exit.

Add Instrument

a Enter a name for this instrument profile within the Remote Monitor. Then, enter the instrument name, host name, or IP address to connect to the instrument. | Required
Ifyour network administrator provided you with a host name, enter the host name. Ifyou do not have a host name, enter the instrument name or IP address.  — a9 &

2b T " Profile Name
2c

*Instrument Name, Host Name, or IP Address

Save & Exit | \ Save & Add Another ‘ | Cancel

2d

Note: For more information on configuring the StepOne or StepOnePlus instrument
for network use or for the Remote Monitor feature, refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking,
and Maintenance Guide.

Notes
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3. Click | % | Start monitoring the instrument for your instrument. It may take
several minutes for the instrument to send the information to your computer.

1 !
File Edit Instrument Analysis Tools Help
[] NewExperiment - 5 open.. [ 5 Close I"_—I Send Experiment to Instrument. L_|r Download Experiment from Instrument... 49 Y
Manage Instruments <«
9 strument, then click "Monitor' to monitor the instrument: Local Simulator (Default) - @J
:
& Localn [ Run Status % Profile Mame:  Local Simulator ] Enable Run Nofifications
Estimated Time Remaining: 75 min 5 sec Status: Connected = ‘m
. ©J) | Notification Settings
2 # (Default) Local Simulator A Experiment Name: dieciipey  AlnEibiock ——
Experiment Type Serial Number:
37' L) =] {H L4 || & ‘ Temperature Plot
Temperature Plot Current Temperatures
110 W cover 25.0°C
- W sample 50.0°C
Block 50.0°C
g0
80
o 70
5
E 60
2
g =0
©
LT}
30
20
10
View Chart
0 , -
00:00:00 00:01:40 00:03:20 00:05:00 00:06:40 00:08:20 00:10; Wiew |10 Minutes  » |
Time Fixed View []

4. View data as described below.

# To... Action

A | View amplification data | Click Amplification Plot.

in realtime See “About the Amplification Plot Screen” on page 70.

B | View temperature data Click Temperature Plot.

for the run in realtime See “About the Temperature Plot Screen” on page 71.

C | View progress of the Click Run Method.

run in the Run Method See “About the Run Method Screen” on page 72.
screen
D | Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “(Optional) Enable the Notification Settings” on page 63.

Notes
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[E] New Experiment ~ [55 Open.. [

_1 Close ’IJ_‘| Send Experiment to Instrument... ’—T’L Download Experiment from Instrument... .@

Manage Instruments «

Add Instrument...

then click "Monitor” to monitor the instrument: B SETE R MUEGIRBEETTNSS -

[ Run status:
Estimated Time Remaining: 75 min 5 sec
Experiment Mame
Experiment Type:

£ Local Instrument (¥)

& (Default) Local Simulator

Profile Name:  Local Simulatar
Status:

Block Type:
Serial Number:

[]Enable Run Motifications

48-Well Block G Netficaton Settings |

‘LJ |£J ‘LJ |2‘ ‘hl Temperature Plot
| |
| |
() 2N )
‘\A/ (B/ \C//

................................................. W cover 250°C
W sample 50.0°C
Block 50.0°C

Current Temperatures

Standalone If you started the run from your StepOne or StepOnePlus instrument, you can view the
Monitoring progress of the run from the touchscreen. The Run Method screen displays the method
for the experiment and highlights the thermal profile steps as the instrument performs
them.
# To... Action
A | Add a melt curve stage | Touch i{|-A. Add Melt Curve, then touch OK.
to the run
B | Display the time Touch Display Experiment Time, then touch X to return
remaining in the run to the Run Method screen.
C | Stoptherun Touch [ STOP, then touch:
e Stop to stop the run after the instrument completes the
current cycle or hold.
¢ Abort to stop the run immediately.
e X to continue the run with no changes.
D | View experiment Touch E View Experiment Information, then touch X to
information return to the Run Method screen.
E | View the Error Log Touch the status bar to display the error log.
Elle View Help
\ 50.0 °C 01:15:02
Experiment: Example Experiment
Stage 2
X 40
a
| 95.0° 95.0°
D | = B
A el B ) =) c

Feld Melt Curve ‘View Expeniment  Display Expenment
Information Time

C oo

Notes
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Unload the Instrument and Transfer the Data

Unload the Instrument

and Transfer the Data

When your StepOne or StepOnePlus instrument displays the Main Menu screen, unload
the reaction plate from the instrument and transfer the experiment data to the computer

for analysis.

Unload the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Reaction Plate temperature of the sample block(s) can exceed 100 °C. Keep your hands away until the
sample block(s) reaches room temperature.

Note: When the StepOne or StepOnePlus instrument completes a run, the system saves
the details of the run to the run history, which remains present in the system until the
instrument completes another run.

1. When the Run Report screen appears in the StepOne or StepOnePlus instrument

touchscreen,

touch (#).

2. Open the instrument drawer.

3. Remove the reaction plate from the sample block(s).

4. Carefully close the instrument drawer.

A CAUTION

Select a Data Transfer the experiment to your computer for analysis according to the layout of your
Transfer Method  StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer and “Colocated Data Transfer”
the instrument. below
Standalone The computer and the instrument are “Remote Data Transfer” on
(Networked) connected to the same network. page 77
Standalone The computer and the instrument are not “Standalone
(Basic) connected. Data Transfer” on page 78
Notes
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Colocated If your computer is directly connected to your StepOne or StepOnePlus instrument by the
Data Transfer yellow cable, no action is necessary. The StepOne software automatically transfers the
experiment data from the instrument to the computer after the run.

Note: In a colocated layout, you can start the run from the computer or from the
instrument touchscreen. However, the StepOne software only transfers the experiment
data automatically when a run is started from the computer (see “Colocated Startup” on
page 65).

Remote If your computer and StepOne or StepOnePlus instrument are connected to the same
Data Transfer Ethernet network, download the experiment from the instrument over the network:

1. In the StepOne software, click &, Download Experiment from Instrument to
open the Download Experiment from Instrument dialog box.

2. From the Select Instrument dropdown menu, select your instrument.
3. From the Experiment dropdown menu, select the example experiment file.

4. In the Download File To field:
a. Click Browse.

b. Navigate to:
<drive>:\Applied Biosystems\<software name>\experiments\
where:

<drive> is the computer hard drive on which the StepOne software is installed.
The default installation drive for the software is the D drive.

<software name> is the current version of the StepOne software.

c. Click Select.

5. Click Download Experiment to download the example experiment file from your
instrument to your computer over the network.

Download Experiment from Instrument

n Selectthe instrument with the sxperiment, select a location on this computsr for the experiment, )
then click "Download Experiment.” i

2 I « 1. 8elect Instrument: % Local Instrument (Default)y | Experiment 3
4 | - 2 Download File To; | CMpplied Biosystems\StepOne Software v2.0lexperiments | Browse...
5 | | Cancel ‘

6. When prompted, click OK to close the confirmation.

Download Complete

Notes
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Standalone If your computer is not connected to your StepOne or StepOnePlus instrument, use the
Data Transfer USB drive to transfer the experiment from the instrument to the computer:

1. Ifnot already connected to the instrument, connect a USB drive to the USB port.

I

2. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch @

3. Wait for the USB sign to appear on the touchscreen.

4. Inthe Main Menu, touch Collect Results to save the data to the USB drive.
Note: If your instrument cannot find the USB drive, remove the USB drive, then try

again. If the instrument still does not recognize the USB drive, try another USB
drive.

5. When prompted that the data has been transferred successfully, touch OK.
i‘;;)\?riem]el\;i:' | Settings Menul Tools Menu | Ig:sltzl‘é: |

& Information
RiaseP Wi RESTISLY

Experiment results reacy:
You may remave your USE storage

Shorteu Shorteut
5 oK I 8
@ 2006-11-18 | 2:15 PM ‘»
<

6. Remove the USB drive from your instrument, then connect it to one of the USB
ports on your computer.

7. In the computer desktop, use the Windows explorer open the USB drive.

Notes
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8. Copy the example experiment file to:
<drive>:\Applied Biosystems\<software name>\experiments\

where:

» <drive> is the computer hard drive on which the StepOne software is installed.
The default installation drive for the software is the D drive.

* <software name> is the current version of the StepOne software.

Notes
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Notes
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E Analyze the Experiment

This chapter covers:

B Chapter OVeIVIEW . . . o vt e ettt e e e e e e 82
B Section5.1 Review Results............. .. .. ... ... . i 83
B Section 5.2 Troubleshoot (If Needed). . ........... ... .. ... ... ......... 103

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne'" Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard 81

Curve Experiments



ﬂ Chapter 5 Analyze the Experiment
Chapter Overview

Chapter Overview

The StepOne"™ software analyzes the data using the standard curve quantitation method.
Section 1 of this chapter explains how to review the analyzed data using several of the
analysis screens and how to publish the data. If you receive questionable results,
Section 2 of this chapter explains how to perform some troubleshooting steps.

Example The workflow for analyzing the example experiment provided with this getting started
Experiment guide is shown below.
Workflow

Start Experiment
v
Design the Experiment (Chapter 2)

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

Section 1, Review Results:

. Analyze.

. View the standard curve.

. View the ampilification plot.

. View the results in a table.

. Publish the data.

Section 2, Troubleshoot (If Needed):

1. View the analysis settings; adjust the baseline/threshold.

a WO N =

. View the quality summary.
. Omit wells.

. View the multicomponent plot.

a O DN

. View the raw data plot.

End Experiment

Notes
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Section 5.1 Review Results

Section 5.1 Review Results

This section covers:

B Analyze the Experiment . .. ...t 84
B View the Standard Curve .. ........... ... . . 90
B View the Amplification Plot. .. ... ... ... ... ... ... .. ... . . . . ... 92
B Viewthe Well Table .. ....... .. ... . . . i 99
B PublishtheData ........ .. ... . . . . . . . 102
Notes
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Analyze the Experiment

Notes

84

About the
Example
Experiment

Analyze the
Example
Experiment

The StepOne software analyzes the experiment and displays results in the analysis
screens (for example, the Amplification Plot screen, QC Summary screen, and so on).

For the standard curve example experiment, use the data file that installs with the
StepOne software. The data file was created with the same design parameters provided in
Chapter 2, then run and analyzed on a StepOne™ instrument. You can find the data file
for the example experiment on your computer:

<drive>:\Applied Biosystems\<software name>\experiments\examples\
Standard Curve Example.eds

where:

—h

<drive> is the computer hard drive on which the StepOne software is installed. The
default installation drive for the software is the D drive.

<software name> is the current version of the StepOne software.

. Double-click Q' (StepOne software shortcut) or select

Start » All Pr&grams » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.
From the Home screen, click Open.

In the Open dialog box, navigate to the examples folder:

<drive>:\Applied Biosystems\<software name>\experiments\examples

Double-click Standard Curve Example to open the example experiment data file.

Note: The examples folder contains several data files; be sure to select Standard
Curve Example. For information on the other data files, see “Data Files in the
Examples Folder” on page 12.
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Analyze the Experiment

H 4 "é_“ Send Experiment to Instrument. Lf:, Download Experiment from Instrument. &m ﬂ

Analyze

ﬁl e Experiment

3 Loanin () examples v 0@

ﬂ 98-Well Genotyping Example eds
ﬂ 98-Well Multiplex Example eds

My Recent [] 96-Well Presence Absence Example eds
_ Documents | /3] gg-Well RNaseP Experiment eds
ﬂ 96-Well Standard Curve Example.eds
1] 96-Well SYBR Example eds
ﬂ Comparative CT Example eds
4 ﬂ Genotyping Example eds
ﬂ Multiplex Example.eds
ﬂ Presence Absence Example eds
My Documents ﬂ Relative Standard Curve Example. eds
—_— ﬂ RHMase P Experiment.eds
4 g ﬂ ﬂ Standard Curve Example.eds

=

m SYBR Example.eds

My Computer

":; File name:

My MNetwaork
Places | Files oftype: |a) SDS Files (edm; eds; edt)

* Home

File Edit Instrument Analysis Tools Help ‘

Experiment Menu <] Fxperime _ Standard Curve Fxample Type: Standard Curve Reagents: TagMan® Reagents @;
. _ .

6. See “Software Elements” below and “Navigation Tips” on page 88 for information
on navigating within the analysis screens.

[Z] NewExperiment ~ [55 Open.. [ Save - & Close JI_‘| Send Experiment to Instrument... Fr Download Experimentfram Instrument... | @ Export. ~ Sb Print Report... ‘ 5

Guidelines When you analyze your own standard curve experiment:

» Immediately after a run, the StepOne software automatically analyzes the data using
the default analysis settings, then displays the Amplification Plot screen on your
computer.

» To reanalyze the data, select all the wells in the plate layout, then click Analyze.

Software The StepOne software elements for the analysis screens are illustrated below.

Elements . , )
1. Menu bar — Displays the menus available in the software:

* File

« Edit

e Instrument
* Analysis
* Tools

* Help

Notes
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Analyze the Experiment

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
* Save
* Close
» Send Experiment to Instrument
* Download Experiment from Instrument
* Export
* Print Report

3. Experiment header - Displays the experiment name, experiment type, and reagents
for the open experiment.

4. Experiment Menu pane — Provides links to the following software screens:
* Setup screens
* Run screens
* Analysis screens:
* Amplification Plot
» Standard Curve
*  Multicomponent Plot
* Raw Data Plot
* QC Summary
* Multiple Plots View

5. Plot pane — Displays the selected analysis screen for the open experiment.
6. View tabs — Displays the plate layout or Well Table for the open experiment

7. Experiment tab(s) — Displays a tab for each open experiment.
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File Edit Instrument Analysis

Tools  Help

Chapter 5 Analyze the Experiment ﬂ

Analyze the Experiment

[E] New Experiment ~ (55 Open.. [ Save - £ Close ’IJ_‘| Send Experiment to Instrument... ’—T’L Download Experiment from Instrument...  &# Export.. ~ 5 PrintReport...

Ampl Plot
Standard Curve

Multicomponent Plot

\f Raw Data Plot
QC Summary

Muttiple Plots View

«

Amp
Plot Settings
PImType:IE?rCyue ~ | Graph Type: Linear V| Plat Color: wWell v ‘
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<| View Plate LayoutT View Well Table ]
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492E3 1E4 1E4 1E4 5EG] 5E3 5E3 2.5EH
CT1:27.93 C1: 2687 C1 26.83 C1 26.87' CT: 27 84 CT: 27 .91/ CT: 27.93 C1:28.87

IS LIRS TR S IS TSNS TR S IR S [T S 1T
2.5E3 2/5E8 1.25E3 [1.25E3 [1.26E3 |625 625 625
CT1:28.01/ CT:28.87 C1:28.84 Cr 2887 C1:30.05 Ct:31.05 C1:31.05 C1:31.04

>

[

@

wells: [ 6 Unknown [ 15 Standard [] 3 Negative Contral 24 Empty

Analysis Summary:  Total Wells in Plate: 4f  Wells Set Up: 24

‘Wells Omitted Manually 0

‘Wells Flagged:0  Wells Omitted by Analysis: 0  Samples Used:2  Targets Used: 1

N { (=] Standard Curve Example.eds < 3
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ﬂ Chapter 5 Analyze the Experiment

View Plate Layout | View Well Table |  — 1
i
SelectWells With: |Sample v | - Selectltem - w
| B show in Wells ¥ | ] View Legend hopt | |
pop2
e T
4 ! i 2 3 . 5 5 7 5

[ rrese » [ riase » [ #tiaser " 0l e Ll e g Ml e

Al ] : |
CT:Undetermined | CT: Undetermined | CT: Undetermined |22 - ool vk e M
RNase P D RMase P D RNase P D RNase P D RMase P D RNase P D RNase P D RMase P

B |4.92E3 1E4 1E4 1E4 5E3 SE3 SE3 2.5E3
CT.27.93 Cr:26.87 CT. 26.83 CT. 26,87 Cr:27.84 CT27.91 CT27.93 Cr:28.97
[ Rivase P [ rhase P [ rhiase P [ rhvase P [ rhase P [ rhiase P [ rhvase P [ rhase P

 |2.5E3 2.5E3 1.25E3 1.25E3 1.25E3 625 625 625
CT28.01 Cr:28.97 C1:20.94 CT 2897 Cr:30.05 C1:31.08 CT31.05 Cr:31.04

D

E

F

wells: [l 6 Unknown [5] 15 Standard [ 3 Negative Control 24 Empty

Notes

Analyze the Experiment

Navigation Tips How to Select Wells

To display specific wells in the analysis screens, select the wells in the View Plate

Layout tab as follows:

1. To select wells of a specific type, use the Select Wells With dropdown menus:
Select Sample, Target, or Task, then select the sample, target, or task name.

2. To select a single well, click the well in the plate layout.

3. To select multiple wells, click and drag over the desired wells, press CTRL+click,
or press Shift+click in the plate layout.

4. To select all 48 wells, click the upper left corner of the plate layout.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard

Curve Experiments



Chapter 5 Analyze the Experiment E

Analyze the Experiment

How To Display Multiple Plots

Use the Multiple Plots screen to display up to four plots simultaneously. To navigate
within the Multiple Plots screen:

1. From the Experiment Menu pane, select Analysis » |£%| Multiple Plots View.
2. To display four plots, click 55 Show plots in a 2 X 2 matrix.

3. To display two plots in rows, click = Show plots in two rows.

4. To display two plots in columns, click ||| Show plots in two columns.

5

. To display a specific plot, select the plot from the dropdown menu above each plot

display.
5 2 3
e N I
s m—1+——H4
I
[nmpiication Piot - ARnvs Cycle | |standard curve ~
AP B g EIE B s
Amplification Plot Standard Curve
‘ ::,‘ R
R £ e T
as T
- — B
Cyeia - Lo (@usmntity
Legend Legend
’V A cllcilcEN:=1NF ‘ ’V. standard [l Unknown Bl Unknown (Flagged)
Mutticomponent Plot v [Raw Data Piot |
g &2 =
Multicomponent Plot Raw Data Plot
Legend - ' .-..Itw
aAllcllcilcIN:1NF Legend
{ {- A slcilcIN:NF
Notes
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View the Standard Curve

View the Standard Curve

About the
Example
Experiment

View the
Standard Curve

Notes

The Standard Curve screen displays the standard curve for samples designated as
standards. The StepOne software calculates the quantity of an unknown target from the
standard curve.

In the standard curve example experiment, you review the Standard Curve screen for the
following regression coefficient values:

L]

Slope/amplification efficiency
R? value (correlation coefficient)

C; values

. From the Experiment Menu pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.

Display all 48 wells in the Standard Curve screen by clicking the upper left corner
of the plate layout in the View Plate Layout tab.

From the Target dropdown menu, select All.

From the Plot Color dropdown menu, select Default.

Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

View the values displayed below the standard curve. In the example experiment, the
values for the target (RNase P) fall within the acceptable ranges:

— The slope is —3.477.
— The R? value is 0.999.
— The amplification efficiency (Eff%) is 93.912%.

Check that all samples are within the standard curve. In the example experiment, all
samples (blue dots) are within the standard curve (red dots).

920 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard
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View the Standard Curve

3 4

Plot Setti ‘ ‘
Target Al | PiatCalor [Defautt | |

B g = S

Standard Curve

Cr

100 200 1000 10000 1000¢
Log (Quantity)

6 I Target: RNaseP Slope: -3.477 Ydnter; 40.768 g% 0998 Effti: 93.912 ‘

Legend
{. standard [l Unknown Bl Unknown (Flagged) ‘

8. Check the C; values:
a. Click the View Well Table tab.
b. From the Group By dropdown menu, select Replicate.

c. Look at the values in the C; column. In the example experiment, the C; values
fall within the expected range (>8 and <35).

8a
Wiew Plate Layout | View Well Table ]
8b SelectWalls With: - Salect fem -+ |
[ snowinTapis v [ eroupey v | Expand All | 5] Gollapse Al
' 8c
# | Well Omit Flag Sample Name | TargetMame | Task Dyes Cr CTMean CT5D GQuuantity Quantity Mean | Quantity SC
= RNase P - NTC ~
1 Al I~ | RMase P MNTC FAM-MFG-... Undetermi
2 A2 I~ | RMase P MNTC FAM-MFG-... Undetermi
3 A3 | RMase P MNTC FAM-MFG-... Undetermi
= RNase P - STANTART - 100000
4 B2 [ RMNase P STANDARD FAM-MFQ- 26 874408 26 B5865 0022 10,000
5 B3 [ RMase P STANDARD FAM-MFQ- 26834158 26 BS865 0022 10,000
B B4 [ RMase P STANDARD FAM-MFQ- 26 867206 26 B5865 0022 10,000
= RNase P - STANDART - 12500
7 c3 [ RMNase P STANDARD FAM-NFQ- . 2803535 28 085448 0.058 1,250
g c4 [ RMase P STANDARD FAM-MFQ- . 288701 20985448 0.058 1,250
] cs [ RMase P STANDARD FAM-NFG- . 30050283 28 085449 0.058 1,250
= RNase P - STANDART - 25000
10 B8 [ RMNase P STANDARD FAM-NFQ- . 28073732 28081377 0.021 2,500
1 ¢l O RMase P STANDARD FAM-NFG- . 28005375 28081377 0.021 2,500
12 c2 O RMase P STANDARD FAM-NFQ- . 28065023 28081377 0.021 2,500
= RNase P - STANDART - 50000
13 B5s [ RMNase P STANDARD FAM-NFQ- . 27 B43782 27 894388 0.045 5,000
14 BE [ RMase P STANDARD FAM-NFQ- . 27007658 27 894388 0.045 5,000
15 B7 [ RMase P STANDARD FAM-NFQ- . 270931718 27 894388 0.045 5,000
= RNase P - STANTART - 6250
16 ce [ RMNase P STANDARD FAM-MFQ- 3105265 31 04659 001 625 2
- N e e S oo o -
Notes
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View the Amplification Plot

Analysis When you analyze your own standard curve experiment, look for:

Guidelines * Slope/amplification efficiency values — The amplification efficiency is calculated

using the slope of the regression line in the standard curve. A slope close to —3.3
indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:
— Range of standard quantities — For more accurate and precise efficiency
measurements, use a broad range of standard quantities, 5 to 6 logs
(10° to 10° fold).
— Number of standard replicates — For more accurate efficiency measurements,
include replicates to decrease the effects of pipetting inaccuracies.

— PCR inhibitors — PCR inhibitors in the reaction can reduce amplification
efficiency.

+ R? values (correlation coefficient) — The R? value is a measure of the closeness of
fit between the regression line and the individual C data points of the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and the
data points. An R? value >0.99 is desirable.

* C; values — The threshold cycle (Cy) is the PCR cycle number at which the
fluorescence level meets the threshold. A C; value >8 and <35 is desirable. A C;
value <8 indicates that there is too much template in the reaction. A C value >35
indicates a low amount of target in the reaction; for C values >35, expect a higher
standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:
e Omit wells (see “Omit Wells from the Analysis” on page 108).

Or
* Rerun the experiment.

For More For more information on:

Information * The Standard Curve screen, access the StepOne Software Help by clicking g) or

pressing F1.

+ Amplification efficiency, refer to the Amplification Efficiency of TagMan® Gene
Expression Assays Application Note.

View the Amplification Plot

The Amplification Plot screen displays amplification of all samples in the selected wells.
There are three plots available:

* ARn vs Cycle — ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

Notes
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View the Amplification Plot

* Rn vs Cycle — Rn is the fluorescence signal from the reporter dye normalized to the
fluorescence signal from the passive reference. This plot displays Rn as a function
of cycle number. You can use this plot to identify and examine irregular
amplification.

* C;vs Well — C; is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays C; as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as the following graph types: linear or log10.

About the In the standard curve example experiment, you review the target in the Amplification
Example Plot screen for:
Experiment » Correct baseline and threshold values

¢ Qutliers

View the 1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Amplification Plot
Note: If no data are displayed, click Analyze.

2. Display the RNase P wells in the Amplification Plot screen:
a. Click the View Plate Layout tab.
b. From the Select Wells With dropdown menus, select Target, then RNase P.

2a———(View Plate Layout | View Well Table | —— 2b
SelectWells With: Target w | |[RNase P A
| ElShUW\HWE”S' | VwewLegend | | |
1 2 El 4 a 3] 7 8
v - 0 rrases i JH— g;g;sa P EER;ase P E:é«;se P ?!?Rggsa P ﬁER;ase P
A - i . d
Cr: Undetermined | GT. Undetermined | CT: Undetermined | 7225 walbe ks e re

m RNase P D RNase P D RNase P D RMNase P D RNase P D RNase P D RMNase P D RNase P
B |4.92E3 1E4 1E4 1E4 5E3 5E3 5E3 25E3
Cr:27.93 CT 26.87 CT: 26,83 Cr: 26.87 CT27.84 CT: 27,91 Cr:27.93 CrT28.97

[ Rhase P [ Rhase P [E] ruase ¢ [E] Rhase P [ Rhase P [E] ruase ¢ [E] Rhase P [ Rhase P

¢ |2.5E3 2.5E3 1.25E3 1.25E3 1.25E3 625 625 625
Cr 200 CT.28.97 CT:29.94 Cr:29.97 CT.30.05 CT:31.08 CT1:31.05 CT.31.04
s}
E
F
wells: [[ 6 Unknown [ 15 Standard [1] 3 Negative Control 24 Empty

3. In the Amplification Plot screen:
a. From the Plot Type dropdown menu, select ARn vs Cycle (default).
b. From the Plot Color dropdown menu, select Well (default).

Notes
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View the Amplification Plot

C.

Chapter 5 Analyze the Experiment

Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes
to Hide the plot legend.

4. View the baseline values:

a.
b.

C.

From the Graph Type dropdown menu, select Linear.
Select the Baseline checkbox to show the start cycle and end cycle.

Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is detected.
In the example experiment, the baseline is set correctly.

3a 4a 3b
Campincason it |
Plot i
Plot Type:|ARn vs Cycle | Graph Type: Linear Jr Plot Color: well \" ‘
2P oallgRE 3c
Amplification Plot
g 1.00
2 4 & 8 10 12 14 16 18 ;;OyDIE 22 24 26 28 30 az 34 38 36 40
Options
Target |RNase P+ | Threshold: [#] Auto
Show: [] Threshold — Baseline Start Well M Target & Baseline End: Well M Target 4
4b !
5. View the threshold values:
a. From the Graph Type dropdown menu, select Log.
b. From the Target dropdown menu, select RNase P.
c. Select the Threshold checkbox to show the threshold.
d. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.
Notes
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View the Amplification Plot

5a

Amplification Plot

Plot

|
Plot Type |ﬂans Cycle V‘ GraphType:‘Lug \‘v| F\otCoIor: ‘

Amplification Plot

10
1 L =
242796 —
0.1 —.

0.01

% 0.001

3 = = /_/
0.00001 {
0.000001
1z 14 16 18 20 2z

0.0000001
a

24 26 28 30 az 34 36 38 a0 4z
Cycle

Options

Show: Threshold —
]

5b
5c

‘Well M Target 4« Baseline End: Well "B Target 4.

6. Locate any outliers:
a. From the Plot Type dropdown menu, select Cy vs Well.

b. Look for outliers from the amplification plot. In the example experiment, there
are no outliers for RNase P.

6a

Plot
Plot Type:|CTvs Well q Graph Type: F\otCoIor: ‘
A P == =

Amplification Plot

400 ¥ rY -
376
350
32.5
300 A\ d - *
275
250
225
200
17.6
15.0
12.5
10.0
7.5
5.0
26

0.0
a

2 a s 8 1 1z 14 18 18 20 22 24
Well Number

Notes
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View the Amplification Plot

Analysis When you analyze your own standard curve experiment, look for:
Guidelines . Qutliers

* A typical amplification plot — The StepOne software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a #ypical
amplification plot. A typical amplification plot has four distinct sections:

a. Plateau phase
b. Linear phase

c. Exponential (geometric phase)

d. Baseline
10
1 e |
0210658 —
a1 [Threshold
ARnNn c
o.o1
0.001 !
i .I{I' / l"'f i |'/)rlll
AR VY flA \ A N
0.0001 > | 1
a (] & 10 12 | 14 1A iw® W ¥ M W W A el Sl WA SR AN AP d

Cycle

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the StepOne software. Therefore, Applied
Biosystems recommends that you examine the Amplification Plot screen and review
the assigned baseline and threshold values for each well after analysis completes.

» Correct baseline and threshold values — See the threshold examples on page 97 and
the baseline examples on page 98.

Notes
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View the Amplification Plot

Threshold Set Correctly oF

The threshold is set in the exponential phase of the .
amplification curve. |

Threshold settings above or below the optimum p.242196
increase the standard deviation of the replicate
groups.

Task Dyas (54 T Mean (58-I Quantey Quantey Quantey Commi
NTC FAMENFG-.. Uniseteami_

NTC FAMENFO-. Unidetedmi..

NTC FAM-HFG-.. Undsisimi..

UNFMOWN FAMKNFO-.. 2896287 28923796 0074 248431 2551476 1262
UNEMOWH  FAMENFG... 28 838787 28423708 0074 2887054 2EE1ATE 1282
URFEMNOWN FAM-NFG-. 2008572 20023708 0.074 2473084 255147 182

Threshold Set Too Low

The threshold is set below the exponential phase of
the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar up
into the exponential phase of the curve.

Tash Dyes (=3 CT Mgan CTE0 Quantly Quantly Cuantsy

HTC FAM-HFC-. Undstedni.

HTC FAM-NFQ-... Undstsimi..

NTC FAM-HFG-.. 38453182

UNKNOWH FAMNFO-.. 2285404 22761744 0252 2314852 2472483 400435

UNKMNOWN FAM-NFG-. 22478873 22781744 0282 2827732 2472483 400,435

URENOWH  FAMNFG-.. 22054218 22781744 0252 2AT4MIE  24T2483 400435

Threshold Set Too High

The threshold is set above the exponential phase of e
the amplification curve. The standard deviation is '
significantly higher than that for a plot where the !
threshold is set correctly. Drag the threshold bar
down into the exponential phase of the curve.

0.1 §

Task Dyas cr CT Maan CTe0 Qaansy Cuamsy Oty Commag CELE
NTC: FAM-NFO-.. Undeteimi.. ]
HTC FAN-NFQ- Unistedmi..

TG FAM-HFO-.. Undelami.

UNFNOWH  FAM-NFO-.., 3?.5&1!0?. ar.a9807 0.202 2571477 2880428 35ITTE I.II
UNKNOWH FAM-NFG-.. 37.278T1 Ir.assor 0202 3260623 2288425 383778 /
UNKMNOWN FAM-NFG-.. 37.524305 3740507 0202 :E24187 ZEBBAS 5ATTS ,-"
¢ x’{ \ I\;{I
- "1/\ = "'- = ,.'“' v ..'I % II'.;,
Cvtle- .
Notes
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View the Amplification Plot

Baseline Set Correctly

The amplification curve begins after the maximum
baseline.

Baseline Set Too Low

The amplification curve begins too far to the right
of the maximum baseline. Increase the End Cycle .
value. g,

Baseline Set Too High

The amplification curve begins before the
maximum baseline. Decrease the End Cycle value. '

If your experiment does not meet the guidelines above, troubleshoot as follows:
* Omit wells (see “Omit Wells from the Analysis” on page 108).
or

* Manually adjust the baseline and/or threshold (see “View the Analysis Settings” on
page 104).

For More For more information on the Amplification Plot screen, access the StepOne Software
Information  Help by clicking @) or pressing F1.

Notes
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View the Well Table

View the Well Table

The Well Table displays data for each well in the reaction plate, including:
* The sample name, target name, task, and dyes

* The calculated threshold cycle (C;), normalized fluorescence (Rn), and quantity
values

¢« Comments

* Flags

About the In the standard curve example experiment, you review the Well Table for:

Example * Quantity values

Experiment . Flags

» C; values (including C; standard deviation)

View the Well 1. From the Experiment Menu pane, select Analysis, then select the View Well Table
Table tab.

Note: If no data are displayed, click Analyze.

2. Use the Group By dropdown menu to group wells by a specific category. For the
example experiment, group the wells by replicate, flag, or C; value.

Note: You can select only one category at a time.

a. From the Group By dropdown menu, select Replicate. The software groups the
replicate wells: negative controls, standards, and samples. In the example
experiment, note that the quantity values within each replicate group are
similar.

Note: In the example experiment, the Quantity, Quantity Mean, and Quantity
SD columns have been moved from their default locations to the beginning of
the Well Table. To move a column, click and drag on the column heading.

Notes
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View the Well Table

[ View Plate Layout | View Well Table |

2a SelectWells With: |- Select tem -
. |
| Show in Table ¥ | Group By ¥ | Expand All Collapse All
!
#  Wwell Omit Flag Sample Name | TargetMame = Task Dyes G CTMean CTSD Quantity | Quantity Mean | Quantity SD
1 Al [ RNase P NTC FAM-NFG-.. Undstermi... ~
2 A2 [ RNase P NTC FAM-NFG-.. Undstermi...
3 A [ RNase P NTC FAM-NFG-.. Undstermi...
= RNase P - STANDARE - 10000.0
4 B2 [J RNase P STANDARD FAM-MFQ-. 26874408 2685865 0022 10,000
5 B3 [ RNase P STANDARD FAM-MFQ-.. 26834158 2685865 0022 10,000
5 B4 [ RNase P STANDARD FAM-MFQ-.. 26867206 2685865 0022 10,000
= RNase P - STANDARD - 1250.0
7 c3 [ RNase P STANDARD FAM-MFQ-. 2903505  20,085449 0053 1,250
8 ca [ RNase P STANDARD FAM-MFQ-. 290701  20,985449 0053 1,250
] cs [ RNase P STANDARD FAM-MFQ-.. 30050293 20985449 0053 1,250
= RNase P - STANDARD - 2500.0
10 Ba [ RNase P STANDARD FAM-MFQ-. 28073732 28.981377 0.021 2,500
11 ct [ RNase P STANDARD FAM-MFQ-.. 29.005375 28.981377 0.021 2,500
12 c2 [ RNase P STANDARD FAM-MFQ-.. 28065023 28.981377 0.021 2,500
= RNase P - STANDARD - 5000.0
13 Bs [ RNase P STANDARD FAM-MFQ-. 27.843782 27.894386 0045 5000
14 B6 [ RNase P STANDARD FAM-MFQ-.. 27007658 27.894386 0045 5000
15 B7 [ RNase P STANDARD FAM-MFQ-.. 27031719 27.894386 0045 5000
= RNase P - STANDARD - 625.0
16 c6 [ RNase P STANDARD FAM-MFQ-. 31.05255 3104650 0.01 625
17 c7 [ RNase P STANDARD FAM-MFQ-.. 31.052055 3104659 0.01 625 3
o= —— il b S P, s -
b. From the Group By dropdown menu, select Flag. The software groups the
flagged and unflagged wells. In the example experiment, there are no flagged
wells.
View Plate Layout | View Well Table ]
2b ‘ SelectWells With: - Selectiter -+
| Show in Table ¥ | Group By ¥ ‘ Expand Al ollapse Al
!
# | Well Omit Flag Sample Mame | TargetName = Task Dyes Cr CT1 Mean CT 8D Quantity | Quantity Mean Quantity 5D
Flagged Wells ~
= Unflagged Wells
1 Al | RNase P NTC FAM-NFQ-... Undetermi
2 A2 | RNase P NTC FAM-NFQ-... Undetermi
3 A3 | RNase P NTC FAM-NFQ-... Undetermi
4 A O popt RNase P UNKNOWN FAM-NFQ- . 2B.96287 28823796 0.074 248431 2,561 476 126
5 A5 [ popt RNase P UNKNOWN FAM-NFQ- . 28.838707 28823796 0.074 2,697.054 2,561 476 126
8 A8 [ popt RNase P UNKNOWN FAM-NFQ- . 28.96372 28823706 0.074 2473064 2,561 476 126
7 A7 O pop2 RNase P UNKNOWN FAM-NFQ- . 27.976233 27058857 0.024 4774927 4,830 585 761
8 A O pop2 RNase P UNKNOWN FAM-NFQ- . 27968481 27058857 0.024 4799501 4,830 585 761
] B O pop2 RNase P UNKNOWN FAM-NFQ- . 27.931858 27858857 0.024 4917327 4,830 585 761
10 B2 [ RNase P STANDARD FAM-NFQ- . 26874408 26 85865 0022 10,000
11 B3 [ RNase P STANDARD FAM-NFQ- . 26.834158 26 85865 0022 10,000
12 B4 [ RNase P STANDARD FAM-NFQ- . 26867206 26 85865 0022 10,000
13 Bs [ RNase P STANDARD FAM-NFQ- . 27.843782 27804386 0045 5000
14 BE [ RNase P STANDARD FAM-NFQ-. 27.907858 27804386 0045 5000
15 B7 [ RNase P STANDARD FAM-NFQ-. 27.931718 27804386 0045 5000
16 Bs [ RNase P STANDARD FAM-NFQ-. 28.973732 28881377 0.021 2,500
17 ¢t O RNase P STANDARD FAM-NFQ- . 28.005375 28081377 0.021 2,500
18 c2 O RNase P STANDARD FAM-NFQ-. 2B.965023 28081377 0.021 2,500
19 c3 O RNase P STANDARD FAM-NFQ-. 20.93505 29 085449 0059 1,250
20 ca O RNase P STANDARD FAM-NFO-. 28.8701 29085449 0059 1,250 e
————= o i Amn i aima | m armnna  mnmme s marn dlmen -
Notes
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View the Well Table

c. From the Group By dropdown menu, select Cy. The software groups the wells
by C; value: low, medium, high, and undetermined. In the example experiment,
the C values are within the expected range (>8 and <35).

[ View Plate Layout | View Well Table |

2C | SelectWells With: |- Select tem -
. ‘
[ showin Tabie v [ Grounsy v | | BS Expand an | B covapse an |
!
# | well omit | Flag | Sample Name @ TargstMame | Task Dyes cr CTMean CTSD Quantity | Quantity Mean | Quantity SD
= Unflagged Wells ~
1 Al [ RNase P NTC FAM-NFG-.. Undstermi..
2 A O RNase P NTC FAM-NFG-.. Undstermi...
3 A [ RNase P NTC FAM-NFG-.. Undstermi...
¢ A [ papi RNase P UNKNOWN FAM-NFG-.. 28.06287 28923736 0074 2484.31 2,551.476 126
5 A5 [ papi RNase P UNKNOWN FAM-NFG-.. 28.838797 28923736 0.074 2,697.054 2,551 476 126
5§ A5 [ papi RNase P UNKNOWN FAM-NFG-. 28.96972 28923736 0.074 2,473.064 2,551 476 126
7 A O pop2 RNase P UNKNOWN FAM-NFG-.. 27.676233 27.950857 0,024 4774927 4,830,585 76.1°
8 A8 [ pop2 RNase P UNKNOWN FAM-NFG-.. 27.068481 27.950857 0.024 4,798.501 4,830,585 76.1°
s B [ pop2 RNase P UNKNOWN FAM-NFG-.. 27.931858  27.950857 0,024 4917327 4,830,585 76.1°
10 B2 [ RNase P STANDARD FAM-NFG-.. 26674408 2635865 0022 10,000
11 B3 [ RNase P STANDARD FAM-NFG-.. 26834158 2635865 0022 10,000
12 B4 [ RNase P STANDARD FAM-NFG-.. 26867296 2635865 0022 10,000
17 85 [ RNase P STANDARD FAM-NFG-.. 27.843782 27.894386 0045 5000
14 B[] RNase P STANDARD FAM-NFG-.. 27.007658 27.994386 0045 5000
15 87 [ RNase P STANDARD FAM-NFG-.. 27.93719 27.894386 0045 5000
16 B8 [J RNase P STANDARD FAM-NFG-.. 28873732 28981377 0021 2500
17 ¢l O RNase P STANDARD FAM-NFG-.. 29.005375 28981377 0021 2500
18 c2 [ RNase P STANDARD FAM-NFG-.. 28.065023 28981377 0021 2500
19 c3 [ RNase P STANDARD FAM-NFG-. 2993535 29985449 0058 1,250
0 o4 [ RNase P STANDARD FAM-NFG-. 299701 29985449 0058 1,250
7 cs [ RNase P STANDARD FAM-NFG-.. 30.0502893 29985449 0058 1,250 -
- = - pipnb o bl i e o -
< >

Analysis When you analyze your own standard curve experiment, group the wells by:

Guidelines » Replicate — The software groups the wells by replicate: negative controls, standards,
and samples. Look in the Quantity columns to make sure the quantity values for
each replicate group are similar. This indicates tight precision.

* Flag — The software groups the flagged and unflagged wells. A flag indicates that
the software has found an error in the flagged well. For a description of the StepOne
software flags, see “View the QC Summary” on page 106.

* C; — The threshold cycle (Cy) is the PCR cycle number at which the fluorescence
level meets the threshold. A C; value >8 and <35 is desirable. A C value <8
indicates that there is too much template in the reaction. A C value >35 indicates a
low amount of target in the reaction; for C values >35, expect a higher standard
deviation.

For More For more information on the Well Table, access the StepOne Software Help by
Information  clicking @) or pressing F1.

Notes
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Publish the Data

Publish the Data

You can publish the experiment data in several ways:
» Save the plot as an image file
* Print the plot
* Print the plate layout
* Create slides
* Print a report
* Export data

For information on performing these procedures, access the StepOne Software Help by
clicking @) or pressing F1.

Notes
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Section 5.2 Troubleshoot (If Needed)

Section 5.2 Troubleshoot (If Needed)

This section covers:

B View the Analysis Settings . .. ...ttt 104
B View the QC SUMMATIY. . . ..ottt ettt e e e e e e e e 106
B Omit Wells from the Analysis. . ........ ... ..., 108
B View the Multicomponent Plot. .. ........ ... ... .. ... ... ... .. ... 109
M Viewthe Raw DataPlot ... ........ ... .. .. .. . . . . . . . . . . .. 112
Notes
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View the Analysis Settings

View the Analysis Settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and advanced options. If the default analysis settings in the StepOne software
are not suitable for your experiment, you can change the settings in the Analysis Settings
dialog box, then reanalyze your experiment.

About the In the standard curve example experiment, the default analysis settings are used without
Example changes.
Experiment

View the Analysis 1. From the Experiment Menu pane, select Analysis.
Settings
2. Click Analysis Settings to open the Analysis Settings dialog box.
3. In the example experiment, the default analysis settings are used for each tab:
* Cj Settings
* Flag Settings
* Advanced Settings

& Analysis Settings for Standard Curve Example

[CT Seffings | Flag Seftings | Advanced Seftings |

a Review the default settings for analysis of targets in this experiment. To edit the default settings, click "Edit Default Settings." To use different settings
for atarget, select the target from the table, deselectthe "Use Default Settings” checkbox, then change the settings that are displayed

Default Cr Settings
Default CT settings are used to calculate the CTfor targets without custom settings. To editthe default settings, click "Edit Default Settings.”

Threshold: AUTO Baseline Start Cycle: AUTO Baseline End Cycle: AUTO \ Edlit Default Settings

Select a Target Cr Settings for RNase P

Target Threshold Baseline Start Baseline End 1 Seftings 1o Use Use Default Settings
RMase P AUTO AUTO |AUTO |A

(024208 |
(=] &ne cyere: [153]

s

Revert to Original Analysis Settings ‘ Apply Analysis Settings | Cancel

Notes
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View the Analysis Settings

Analysis Unless you have already determined the optimal settings for your experiment, use the
Guidelines default analysis settings in the StepOne software. If the default settings are not suitable
for your experiment, you can change the:

* C; Settings — Use this tab to manually set the threshold and baseline. When
manually setting the threshold and baseline, Applied Biosystems recommends the

following:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.
Baseline Select the Start Cycle and End Cycle values so that the baseline

ends before significant fluorescent signal is detected.

* Flag Settings — Use this tab to:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.
* Advanced Settings — Use this tab to change baseline settings well by well.

For More For more information on the analysis settings, access the StepOne Software Help by
Information pressing F1 when the Analysis Settings dialog box is open.

Notes
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View the QC Summary

View the QC Summary

The QC Summary screen displays a list of the StepOne software flags, and includes the
flag frequency and location for the open experiment.

About the In the standard curve example experiment, you review the QC Summary screen for any
Example flags triggered by the experiment data. In the example experiment, no flags have been
Experiment triggered.

View the QC 1. From the Experiment Menu pane, select Analysis »
Summary
Note: If no data are displayed, click Analyze.

2. Review the Flags Summary. In the example experiment, there are 0 flagged wells.

3. In the Flag Details table, look in the Frequency and Wells columns to determine
which flags appear in the experiment. In the example experiment, the Frequency
column displays O for all flags.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear
in the experiment.

4. (Optional) Click each flag row to display detailed information about the flag.

QC Ssummary

Flag v
Total Wells: 48 | Processed Wells: 24 | Targets Used: 1
Wells Set Up: 24 | Flagged Wells: 0 Samples Used:
‘ 2
Flag Details
Flag Mame Frequency Wells
4 AMPINC |Amplification in negative control 0 ~
BADROX Bad passive reference signal 1]
OFFSCALE Fluorescence is offscale 1]
HIGHSD High standard deviation in replicate group 0
MNOAMP Mo amplification 1]
MNOISE INoise higherthan others in plate 0
SPIKE [oise spikes 0
MOSIGMAL Mo signal inwell 1]
OUTLIERRG Outlier in replicate group 0
EXPFAIL Exponential algarithm failed 0 -
Flag: AMPNC—Amplification in negative control
Flag Detail: A sequence amplified in a negative contral
reaction.
Flag Criteria: C1 < 35.0
Flagged Wells: None
View AMPNC Troubleshooting Information
Notes
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View the QC Summary

Possible Flags For standard curve experiments, the flags listed below may be triggered by the
experiment data.

If a flag does not appear in the experiment, its frequency is 0. If the frequency is >0, the
flag appears somewhere in the experiment; the well position is listed in the Wells

column.
Flag Description

AMPNC ' Amplification in negative control

BADROX Bad passive reference signal

BLFAIL Baseline algorithm failed

CTFAIL C; algorithm failed

EXPFAIL ' Exponential algorithm failed

HIGHSD ' High standard deviation in replicate group

MTP " Multiple Tm peaks
Note: This flag is only displayed if the experiment
includes a melt curve.

NOAMP ' No amplification

NOISE Noise higher than others in plate

NOSIGNAL No signal in well

OFFSCALE Fluorescence is offscale

OUTLIERRG ' Outlier in replicate group

SPIKE " Noise spikes

THOLDFAIL ' Thresholding algorithm failed

Analysis When you analyze your own standard curve experiment:

Guidelines * Click each flag in the Flag Details table with a frequency >0 to display detailed
information about the flag. If needed, click the troubleshooting link to view
information on correcting the flag.

* You can change the flag settings:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.

For More For more information on the QC Summary screen or on flag settings, access the StepOne
Information  Software Help by clicking ) or pressing F1.

Notes
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Omit Wells from the Analysis

4a

Notes

108

Omit Wells from the Analysis

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce C values that differ significantly from the average for the
associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure precision, omit the outliers from the analysis.

About the
Example
Experiment

Omit Wells

In the standard curve example experiment, there are no outliers; no wells need to be
removed from analysis.

From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

In the Amplification Plot screen, select C vs Well from the Plot Type dropdown

menu.

Select the View Well Table tab.

In the Well Table:

a. From the Group By dropdown menu, select Replicate.

b. Look for any outliers in the replicate group (be sure they are flagged). In the
example experiment, there are no outliers.

3

[ View Plate Layout | View Well Table |
Select Wells With

- Selectltem- w

P |
| Show in Table ¥ | Group By ¥ |
L

| BS Expand an | BS collapse an |

# | Well Omit Flag
1 Al 1
2 A2 1
E A3 1
= RNase P - STANDART -
4 Bz []
5 B3 []
6 B4 []
= RNase P - STANDART -
7 ca [
8 c4 [
9 cs [
= RNase P - STANDART -
10 Bs  []
11 C1 1
12 c2 [
= RNase P - STANDART -
13 Bs [1]
14 Bs [
15 B7 [
= RNase P - STANDART -
16 ce []
17 c7 [

Sample Name | Target Name
RMase P
RMase P
RMase P
10000.0

RMase P

RMase P

RMase P
12500

RMase P

RMase P

RMase P
2500.0

RMase P

RMase P

RMase P
5000.0

RMase P

RMase P

RMase P
625.0

RMase P

RMase P

Task
NTC
NTC
NTC

STANDARD
STANDARD
STANDARD

STANDARD
STANDARD
STANDARD

STANDARD
STANDARD
STANDARD

STANDARD
STANDARD
STANDARD

STANDARD
STANDARD

Dyes

FAM-MFQ-
FAM-MFQ-
FAM-MFQ-

FAM-MFQ-
FAM-MFQ-
FAM-MFQ-

FAM-MFQ-
FAM-MFQ-
FAM-MFQ-

FAM-MFQ-
FAM-MFQ-
FAM-MFQ-

FAM-MFQ-
FAM-MFQ-
FAM-MFQ-

FAM-MFQ-
FAM-MFQ-

Ccr

Undetermi...
Undetermi...
Undetermi...

26.874498
26.834158
26,867 296

29.93505
29.9701
30.050293

28.973732
29.005375
28.965023

27.843782
27.907658
27931719

31.05255
31.052055

CTMean

26.85865
26.85865
26.85865

29.085449
29.085449
29.085449

28981377
28981377
28981377

27.894386
27.894386
27.894386

31.04659
31.04659

CT5D

0.022
0.022
0.022

0.059
0.059
0.059

0.021
0.021
0.021

0.045
0.045
0.045

0.01
0.01

Quantity | Quantity Mean

10,000
10,000
10,000

1,250
1,250
1,250

2,500
2,500
2,500

5,000
5,000
5,000

625
625

Quantity SD
-~
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View the Multicomponent Plot

Analysis When you analyze your own standard curve experiment, carefully view the replicate
Guidelines groups for outliers. If needed, remove outliers manually using the Well Table:

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Cy vs Well from the Plot Type dropdown
menu.

3. Select the View Well Table tab.

4. Inthe Well Table:
a. From the Group By dropdown menu, select Replicate.
b. Look for any outliers in the replicate group (be sure they are flagged).

c. Select the Omit checkbox next to the outlying well(s).

5. Click Analyze to reanalyze the experiment data with the outlying well(s) removed
from the analysis.

For More For more information on omitting wells from the analysis, access the StepOne Software
Information  Help by clicking @) or pressing F1. Within the Help, search for the omit well topics:

1. Click the Search tab.
2. Enter omit well.

3. Click List Topics.

4

. Double-click the topics you want to review.

View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye
in a selected well over the duration of the PCR run.

About the In the standard curve example experiment, you review the Multicomponent Plot screen
Example for:

Experiment « ROX"™ dye (passive reference)
+ FAM™ dye (reporter)
» Spikes, dips, and/or sudden changes
+ Amplification in the negative control wells
Notes
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View the Multicomponent Plot

View the 1. From the Experiment Menu pane, select Analysis »

Multicomponent
Plot Note: If no data are displayed, click Analyze.

Multicomponent Plot.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot
screen:

a. Click the View Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.
3. From the Plot Color dropdown menu, select Dye.

4. Click !~ Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains
constant throughout the PCR process, which indicates typical data.

6. Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process, which indicates normal amplification.

3 4 2a
Multicomponent Plot _-< View Plate LayoutT View Well Table }
Plat Setti > SelectWells With: Target v -Selectitem-
Plot Color |Dye 4 ‘ - -
| B show inWells ¥ | T view Legend |
& g 2 =
1 [ 2 [ 3 T +« [ s [ &
Multicomponent Plot -~
375,000 [ vase | Rtiese ¢ | I Ritase @ [0 ruase... [T] Rnase... [T ru:

2 48E3 |2.7E3 .| 2.47E3
Cr 28096 |CT 2884 |CT 28

350,000
325,000
300,000
275,000
250,000

=

CT: Undete.. CT: Undete.. CT: Undete

[ rhase... |[E] Ruiase... [E] Riase.. [ Rhase.. | [E] ru:
|1E4 . 1E4 1E4 . 6E3 . BE3

225,000 Cr 2687 |Cr 2683 Cm2687 |Cr2784 |C1m27

»
2
8 200,000
F
5 175.000
2 150,000 [El rbiase... [ rhase... [ ruase... [E] Riase... [ rhase... [ rne
125,000 c|25E J25E3  [126E3 |125E3  [125E3 .[625
5 || : - Cr25.01 Cr 28587 |Cr2984 Cr12897 |Cr30.05 |[Cm31
100,000
6 - - 2b
50,000
25.000 o
o a 2 L] a W12 14 1B W AN X M X OB N R M ¥ N Lo
Cycle (|
Legend 3
I Rox Il Fem < 3

Wells mﬁ Unknown D 15 Standard D:i Megative Control 24 Emptly

Notes
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View the Multicomponent Plot

7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.

Plot i > SelectWells With: | Target | |- Selectitem - v
Plat Color | Dye v ‘ =
| ElshumeE”S' | VwewLegend ‘ | |
e g & =
1 : [ 3 [ 4 T 5 ] =
Multicomponent Plot ~
#5000 [ Riiase P |[1] Riase P | [1] RNase P EREN;SE g;“e E?Rl:;
350,000 Aler : b ;
Cr: Undete. |CT: Undete.. CT: Undete.. CTIB06  CT 2884 O 28
325,000
300,000
276,000 RNase. D RNase D RNase. D RNase. D RNase D RNz
250,000 B |4.92E3 1E4 1E4 1E4 L=z SE3
§ 225,000 H Cr:2793 Cm2687 |CT26.83 |Cm2687 Cm2784 |CT27.
8 200,000
o -
L 175000
£ 150,000 E ruase... [Ed rhase... | ruase... Bl rnase... [ ruase.. |E rne
1250001 — ¢ | 2.5E3 2.5E3 1.25E4] 1.25E3 1.25E3 625
7 : Cr:20.01 Cr2897 | Cr 2994 |Cr:29.97 Cm3005 |Crm3t.
T Tou oo |
75,006 =
50,000
25,000 [n]
o a 2 4 [} ] 10 12 14 1@ 1@ M 2@ M ¥ WM N ¥ M B ¥ M &2
Cycle [ |
Legend v
| &3 U < IS

wells: [[] 6 Unknown [ 15 Standard [1] 3 Negative Control 24 Empty

Analysis When you analyze your own standard curve experiment, look for:

Guidelines » Passive reference — The passive reference dye fluorescence level should remain

relatively constant throughout the PCR process.

* Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Any irregularities in the signal — There should not be any spikes, dips, and/or
sudden changes in the fluorescent signal.

» Negative control wells — There should not be any amplification in the negative
control wells.

For More For more information on the Multicomponent Plot screen, access the StepOne Software
Information  Help by clicking @) or pressing F1.

Notes
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View the Raw Data Plot

View the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each
optical filter for the selected wells during each cycle of the real-time PCR.

About the In the standard curve example experiment, you review the Raw Data Plot screen for a
Example stable increase in signal (no abrupt changes or dips) from the appropriate filter.
Experiment

View the Raw 1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Data Plot
Note: If no data are displayed, click Analyze.

2. Display all 48 wells in the Raw Data Plot screen by clicking the upper left corner of
the plate layout in the View Plate Layout tab.

3. Click = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate. In the
example shown below, Row A is red, Row B is yellow/green, Row C is green, and
S0 on.

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Notes
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View the Raw Data Plot

Raw Data Plot
3

a M=

Raw Data Plot

425,000
400,000
375,000 |
350,000 E
325,000
300,000
275,000
250,000
225,000
200,000
175,000
150,000
125,000
100,000
75,000
50,000
25,000
]

Ampitick

2 3
Filter

’— Legend ‘

Al e N c o N:

Options
Show Cycle 40 - 0 | 4
1 10 20 30 40

The filters are:

StepOne system StepOnePlus system
Filter Dye Filter Dye
1 FAM™ dye 1 AW dye
| SYBR® Green dye | | SYBR® Green dye
2 JOE™ dye 2 JOE™ dye
VIC® dye VIC® dye
3 ROX™ dye 3 TAMRA™ dye
| | " NED™ dye

4 | ROX™dye

Analysis When you analyze your own standard curve experiment, look for the following in each
Guidelines filter:

* Characteristic signal growth
* No abrupt changes or dips

For More For more information on the Raw Data Plot screen, access the StepOne Software Help by
Information clicking g) or pressing F1.

Notes
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Notes
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“ Alternate Experiment Workflows Q&

This appendix covers:

B Advanced Setup Workflow . .. ... ... ... . . . 116
B QuickStart Workflow . . ... ... . 117
B Template Workflow. . ... ... 119
B Export/Import Workflow .. ....... .. ... .. .. . . . 121

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne'" Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Advanced Setup Workflow

When you create an experiment using Advanced Setup in the StepOne”™" software, you
can set up the experiment according to your own design.

1. Double-click g- (StepOne software shortcut) or select
Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.

2. From the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

3. Complete the setup screens to set up a new experiment:

a. Click Experiment Properties (default), enter the experiment name, then
select the experiment properties.

b. Click Plate Setup:
Experiment Type Action
Genotyping Define the SNP assays, then assign them to wells in the

reaction plate.

All other experiments Define the targets, then assign them to wells in the
reaction plate.

c. Click Run Method, review the reaction volume and thermal profile, then
edit as needed.

d. Click Reaction Setup, review the components and calculated volumes for
the PCR reactions, then edit as needed.

e. (Optional) Click D Materials List, review the list of materials, then order
the materials you need to prepare the reaction plate.

4. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve Prepare the template.

. Prepare the sample dilutions.
Prepare the standard dilution series.
Prepare the reaction mix.

Prepare the reaction plate.

Standard curve

® Qoo

Notes
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QuickStart Workflow

Experiment Type Action

Comparative Ct . Prepare the template.

a

Genotyping b. Prepare the samplle dl|l:ItI0nS.
c. Prepare the reaction mix.

Presence/absence d. Prepare the reaction plate.

5. Run the experiment:

a. Load the reaction plate into the instrument.

b. Start the run

c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.
6. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

QuickStart Workflow

When you create an experiment using QuickStart, you can run the reactions on the
instrument with no reaction plate setup information.

1. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve . Prepare the template.
. Prepare the sample dilutions.

a
b
c. Prepare the standard dilution series.
d
e

Standard curve

. Prepare the reaction mix.
. Prepare the reaction plate.

Comparative Cy a. Prepare the template.
Genotyping b. Prepare the samp.le dI|L'JtI0nS.
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.
Notes
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2. QuickStart the experiment:

a. Double-click g- (StepOne software shortcut) or select
Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.
b. From the Home screen, click |=Q| QuickStart.

c. Select the Experiment Properties tab (default), enter the experiment name,
then select the experiment properties.

d. Select the Run Method tab, review the reaction volume and thermal profile,
then edit as needed.

3. Run the experiment:
a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

4. In the StepOne software, complete the plate setup:

Experiment Type Action
Genotyping a. Select and complete the Define SNP Assays and
Samples tab.
b. Select and complete the Assign SNP Assays and
Samples tab.
All other experiments a. Select and complete the Define Targets and
Samples tab.

b. Select and complete the Assign Targets and
Samples tab.

5. Analyze the data:
Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Template Workflow

You can use a template to create a new experiment. Templates are useful when you want
to create many experiments with the same setup information.

Createa 1. Double-click g (StepOne software shortcut) or select
Template Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 116).

3. Select File » Save As Template.

4. Enter a file name, select a location for the template, then click Save.

5. Click & Close.

Create an 1. From the Home screen, click Template.

Experiment with a
Template Note: If you do not see the Template icon, click the arrow beneath the Design

Wizard icon to expand the Set Up menu.

2. Locate and select the template you created in step d, then click Open. A new
experiment is created using the setup information from the template:

* Experiment properties
* Plate setup

* Run method

* Reaction setup

3. (Optional) If you want to modify the experiment, use Advanced Setup (see
page 116).

4. Click [d Save, enter a file name, then click Save to save the experiment.

5. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve Prepare the template.

. Prepare the sample dilutions.
Prepare the standard dilution series.
. Prepare the reaction mix.

Prepare the reaction plate.

Standard curve

® Qoo

Notes
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Appendix A Alternate Experiment Workflows
Template Workflow

Experiment Type
Comparative Cy
Genotyping

Presence/absence

a
b
c
d

Action

. Prepare the template.

. Prepare the sample dilutions.
. Prepare the reaction mix.

. Prepare the reaction plate.

6. Run the experiment:

a. Load the reaction plate into the instrument.

b. Start the run

c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

7. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).
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Export/Import Workflow

Export/Import Workflow

Use the Export/Import workflow to set up a new experiment using setup data exported
from another experiment. Only reaction plate setup data are exported and imported.

Note: Setup data exported from experiments in StepOne Software v1.0 can be imported
into experiments in StepOne Software v2.0 or later. However, setup data exported from
experiments in StepOne Software v2.0 or later cannot be imported into experiments in
StepOne Software v1.0.

Export Setup 1. Double-click g (StepOne software shortcut) or select
Data Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 116).
3. Select File » Export.

4. Sclect the Export Properties tab (default), then:
Select Setup.

a.
b. Select One File from the dropdown menu.

o

Enter a name, then select a location for the export file.

d. Select [} (*.txt) from the File Type dropdown menu.

IMPORTANT! You cannot export *.xml files.

5. (Optional) Click the Customize Export tab, then select the appropriate options.
6. Click Start Export,

7. When prompted, click Close Export Tool.

Create an  You can import plate setup data from an exported text file (*.txt) to complete the reaction
Experiment with  plate setup data for your experiment.
an Exported Text
File IMPORTANT! Be sure the exported text file you select contains only reaction plate setup
data and that the experiment types match.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard 121
Curve Experiments



n Appendix A Alternate Experiment Workflows

Export/Import Workflow

1. Import the reaction plate setup data from an exported text file:

a.

Using a spreadsheet application (such as Microsoft® Excel software), open an
exported text file.

Replace the parameters of the text file as needed. When finished, save the file
as a tab-delimited text file.

From the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

. Create a new experiment or open an existing experiment.

Select File » Import.

Click Browse, locate and select the text file (*.txt), then click Select.

. Click Start Import. The setup data from the exported text file is imported into

the open experiment.

Note: If your experiment already contains plate setup information, the
software asks if you want to replace the plate setup with the data from the text
file. Click Yes to replace the plate setup.

2. Use Advanced Setup to finish setting up your experiment (see page 116).

3. Prepare the PCR reactions:

Relative standard curve

Standard curve

Experiment Type Action

a. Prepare the template.

b. Prepare the sample dilutions.

c. Prepare the standard dilution series.
d. Prepare the reaction mix.

e. Prepare the reaction plate.

Comparative Cy

. Prepare the template.

a
. b. Prepare the sample dilutions.
Genotyping P p ! u !
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.

4. Run the experiment:

a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.
d. Unload the reaction plate from the instrument.
Notes
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Export/Import Workflow

5. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Notes
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Advanced Setup

AIF
allele

allelic discrimina-
tion plot

amplicon

amplification

amplification
efficiency (EFF%)

amplification plot

Glossary

In the StepOne™ software, a feature that allows you to set up your experiment according
to your experiment design. Advanced Setup provides you with maximum flexibility in the
design and setup of your experiment.

See assay information file (AIF).
For a given target, any of the different sequences that occurs in the population.

Display of data collected during the post-PCR read. The allelic discrimination plot is a
graph of the normalized reporter signal from the allele 1 probe plotted against the
normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR produces amplification of the target. For
quantitation experiments, fluorescence data collected during amplification are displayed
in an amplification plot, and the data are used to calculate results. For genotyping or
presence/absence experiments, fluorescence data collected during amplification are
displayed in an amplification plot, and the data can be used for troubleshooting.

Calculation of efficiency of the PCR amplification. The amplification efficiency is
calculated using the slope of the regression line in the standard curve. A slope close to
—3.32 indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:

* Range of standard quantities — To increase the accuracy and precision of the
efficiency measurement, use a broad range of standard quantities, 5 to 6 logs
(10° to 10° fold).

* Number of standard replicates — To increase the precision of the standard
quantities and decrease the effects of pipetting inaccuracies, include replicates.

* PCR inhibitors — PCR inhibitors in the reaction can reduce amplification and alter
measurements of the efficiency.

Display of data collected during the cycling stage of PCR amplification. Can be viewed
as:

» Baseline-corrected normalized reporter (ARn) vs. cycle

* Normalized reporter (Rn) vs. cycle

» Threshold cycle (Cy) vs. well
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Glossary

amplification stage

assay

Assay ID

assay information
file (AIF)

assay mix

AutoDelta

automatic baseline

automatic C;

Part of the instrument run in which PCR produces amplification of the target. The
amplification stage is called a cycling stage in the thermal profile and consists of
denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage
are displayed in an amplification plot, and the data are used to calculate results. For
genotyping or presence/absence experiments, fluorescence data collected during the
amplification stage are displayed in an amplification plot, and the data can be used for
troubleshooting. See also cycling stage.

In the StepOne™ and StepOnePlus™ systems, a PCR reaction mix that contains primers
to amplify a target and a reagent to detect the amplified target.

Identifier assigned by Applied Biosystems to TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays.

Data file on a CD shipped with each assay order. The file name includes the number from
the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

PCR reaction component in Applied Biosystems TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify
a target and a TagMan® probe designed to detect amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for a step
with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling
stage, the settings are indicated by an icon in the thermal profile:

e AutoDelta on: &
» AutoDelta off: A

An analysis setting in which the software calculates the baseline start and end values for
the amplification plot. You can apply the automatic baseline setting to specific wells in
the reaction plate. See also baseline.

An analysis setting in which the software calculates the baseline start and end values and
the threshold in the amplification plot. The software uses the baseline and threshold to
calculate the threshold cycle (Cy). See also threshold cycle (Cy).

baseline In the amplification plot, a line fit to the fluorescence levels during the initial stages of
PCR, when there is little change in fluorescence signal.
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baseline-corrected
normalized reporter
(ARnN)

blocked IPC

calibrator
chemistry

colocated layout

comparative C;
(AAC;) method

Cr

custom dye

cycle threshold

Glossary

The magnitude of normalized fluorescence signal generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. In the ARn vs. Cycle amplification plot, ARn is calculated at each
cycle as:

ARn (cycle) = Rn (cycle) — Rn (baseline), where Rn = normalized reporter

2. In genotyping experiments and presence/absence experiments, the difference in
normalized fluorescence signal generated by the reporter between the pre-PCR read
and the post-PCR read. In the allelic discrimination plot (genotyping experiments)
and the presence/absence plot (presence/absence experiments), ARn is calculated
as:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter
See also normalized reporter (Rn).

In presence/absence experiments, a reaction that contains IPC blocking agent, which
blocks amplification of the internal positive control (IPC). In the StepOne’" software, the
task for the IPC target in wells that contain IPC blocking agent. See also negative control-
blocked IPC wells.

See reference sample.
See reagents.

A system layout in which the StepOne™ or StepOnePlus™ instrument is directly
connected to a colocated computer by the yellow cable. In this layout, you can control the
instrument with the StepOne™ software on the colocated computer or with the instrument
touchscreen.

Method for determining relative target quantity in samples. With the comparative C;
(AAC;) method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples and in a reference sample. Measurements are normalized
using the endogenous control. The software determines the relative quantity of target in
each sample by comparing normalized target quantity in each sample to normalized target
quantity in the reference sample.

See threshold cycle (Cy).
Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in

experiments on the StepOne™ and StepOnePlus'™ systems. When using custom dyes, the
custom dye should be added to the Dye Library and a custom dye calibration performed.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne”™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus"™ system.

See threshold cycle (Cy).
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Glossary

cycling stage

data collection

delta Rn (ARN)
derivative reporter
(-Rn’)

Design Wizard

diluent

Diluted Sample
Concentration (10X
for Reaction Mix)

dilution factor
dissociation curve
EFF%

endogenous
control

endpoint read

In the thermal profile, a stage that is repeated. A cycling stage is also called an
amplification stage. For cycling stages, you can enable AutoDelta settings. See also
amplification stage.

A process during the instrument run in which an instrument component detects
fluorescence data from each well of the reaction plate. The instrument transforms the
signal to electronic data, and the data are saved in the experiment file. In the StepOne™
software, a data collection point is indicated by an icon in the thermal profile:

» Data collection on:

» Data collection off:
See baseline-corrected normalized reporter (ARn).

The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (—Rn") vs. temperature melt curve,
the derivative reporter signal is displayed in the y-axis.

A feature in the StepOne™ software that helps you set up your experiment by guiding you
through best practices as you enter your experiment design.

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The
diluent can be water or buffer.

In the StepOne™ software, a field displayed on the Sample Dilution Calculations tab of
the Reaction Setup screen. For this field, enter the sample concentration you want to use
to add to the reaction mix for all samples in the experiment. “10X for Reaction Mix”
indicates that the software assumes the sample or standard component of the reaction mix
is at a 10X concentration. For example, if the diluted sample concentration is 50.0 ng/uL
(10X), the final sample concentration in the reaction is 5 ng/uL (1X).

See serial factor.

See melt curve.

See amplification efficiency (EFF%).

A target or gene that should be expressed at similar levels in all samples you are testing.
Endogenous controls are used in relative standard curve and comparative C (AACy)
experiments to normalize fluorescence signals for the target you are quantifying.

Housekeeping genes can be used as endogenous controls. See also housekeeping gene.

See post-PCR read.
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experiment

experiment name

experiment type

forward primer

holding stage

housekeeping gene

internal positive
control (IPC)

inventoried assays

IPC

IPC blocking agent

Glossary

Refers to the entire process of performing a run using the StepOne™" or StepOnePlus"™
systems, including setup, run, and analysis. The types of experiments you can perform
using the StepOne and StepOnePlus systems:

* Quantitation - standard curve

* Quantitation - relative standard curve

* Quantitation - comparative Cy (AACy)

* Melt curve

* Genotyping

* Presence/absence

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the following
characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<),
asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), or
semicolon (;).

The type of experiment you are performing using the StepOne™™ or StepOnePlus™ system:

» Standard curve
* Comparative C; (AACy)
» Relative standard curve
* Melt curve (not available in the Design Wizard)
* Genotyping
* Presence/absence
The experiment type you select affects the setup, run, and analysis.

Oligonucleotide that flanks the 5” end of the amplicon. The reverse primer and the forward
primer are used together in PCR reactions to amplify the target.

In the thermal profile, a stage that includes one or more steps. You can add a holding stage
to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

A gene that is involved in basic cellular functions and is constitutively expressed.
Housekeeping genes can be used as endogenous controls. See also endogenous control.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. You can use the IPC to distinguish between true negative results (that is, the
target is absent in the samples) and negative results caused by PCR inhibitors, incorrect
assay setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagMan® SNP Genotyping Assays that have been
previously manufactured, passed quality control specifications, and stored in inventory.

In presence/absence experiments, abbreviation for internal positive control (IPC). In the
StepOne™ software, the task for the IPC target in wells that contain the IPC and do not
contain [PC blocking agent. See also internal positive control (IPC).

Reagent added to PCR reactions to block amplification of the internal positive control
(IPC).
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Glossary

IPC+

made-to-order
assays

manual baseline

manual Cy

melt curve

melt curve stage
melting
temperature (Tm)
multicomponent
plot

negative control

(NC)

negative control-
blocked IPC wells

negative control-
IPC wells

no amplification
control (NAC)

no template control

(NTC)

See negative control-IPC wells.

TagMan® Gene Expression Assays or TagMan® SNP Genotyping Assays that are
manufactured at the time of order. Only assays that pass manufacturing quality control
specifications are shipped.

An analysis setting in which you enter the baseline start and end values for the
amplification plot. You can apply the manual baseline setting to specific wells in the
reaction plate.

An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).

A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate
the melting temperature (Tm) of the target or can identify nonspecific PCR amplification.
In the StepOne™" software, you can view the melt curve as normalized reporter (Rn) vs.
temperature or as derivative reporter (—Rn”) vs. temperature. Also called dissociation
curve.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

In melt curve experiments, the temperature at which 50% of the DNA is double-stranded
and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the
melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over the
duration of the PCR run.

In the StepOne™ software, the task for targets or SNP assays in wells that contain water
or buffer instead of sample. No amplification of the target should occur in negative control
wells. Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of sample
in the PCR reaction. No amplification should occur in negative control-blocked IPC wells
because the reaction contains no sample and amplification of the IPC is blocked.
Previously called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.

See negative control-blocked IPC wells.

See negative control (NC).
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nonfluorescent
quencher-minor
groove binder
(NFQ-MGB)

normalized quantity

normalized reporter
(Rn)

omit well

outlier

passive reference

plate layout

point

positive control

post-PCR read

pre-PCR read

primer mix
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Molecules that are attached to the 3’ end of TagMan® probes. When the probe is intact,
the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence
signal. Because the NFQ does not fluoresce, it produces lower background signals,
resulting in improved precision in quantitation. The minor groove binder (MGB)
increases the melting temperature (Tm) without increasing probe length. It also allows the
design of shorter probes.

Quantity of target divided by the quantity of endogenous control.

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

For a set of data, a datapoint that is significantly smaller or larger than the others.

A dye that produces fluorescence signal. Because the passive reference signal should be
consistent across all wells, it is used to normalize the reporter dye signal to account for
non-PCR related fluorescence fluctuations caused by minor well-to-well differences in
concentrations or volume. Normalization to the passive reference signal allows for high
data precision.

An illustration of the grid of wells and assigned content in the reaction plate. In StepOne™
systems, the grid contains 6 rows and 8 columns. In StepOnePlus"™ systems, the grid
contains 8 rows and 12 columns.

In the StepOne™ software, you can use the plate layout as a selection tool to assign well
contents, to view well assignments, and to view results. The plate layout can be printed,
included in a report, exported, and saved as a slide for a presentation.

One standard in a standard curve. The standard quantity for each point in the standard
curve is calculated based on the starting quantity and serial factor.

In genotyping experiments, a DNA sample with a known genotype, homozygous or
heterozygous. In the StepOne™ software, the task for the SNP assay in wells that contain
a sample with a known genotype.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected during
the post-PCR read are displayed in the allelic discrimination plot and used to make allele
calls. In presence/absence experiments, fluorescence data collected during the post-PCR
read are displayed in the presence/absence plot and used to make detection calls. Also
called endpoint read.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended.
Fluorescence data collected during the pre-PCR read can be used to normalize
fluorescence data collected during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer designed to
amplify the target.
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primer/probe mix

pure dye

quantitation
method

quantity

quencher

QuickStart

R2 value

ramp

ramp speed

raw data plot

PCR reaction component that contains the primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

See custom dye and system dye.

In quantitation experiments, the method used to determine the quantity of target in the
samples. In StepOne™ and StepOnePlus™ systems, there are three types of quantitation
methods: standard curve, relative standard curve, and comparative C; (AAC).

In quantitation experiments, the amount of target in the samples. Absolute quantity can
refer to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-
difference between normalized quantity of target in the sample and normalized quantity
of target in the reference sample.

A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from
emitting fluorescence signal while the probe is intact. With TagMan® reagents, a
nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the quencher.
With SYBR® Green reagents, no quencher is used.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne"™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus"™ system.

A feature in StepOne’" and StepOnePlus'™ systems that allows you to run an experiment
without entering plate setup information. QuickStart requires a colocated layout with the
instrument powered on and an intact instrument-computer connection.

Regression coefficient calculated from the regression line in the standard curve. The R?
value indicates the closeness of fit between the standard curve regression line and the
individual C data points from the standard reactions. A value of 1.00 indicates a perfect
fit between the regression line and the data points.

The rate at which the temperature changes during the instrument run. Except for the melt
curve step, the ramp is defined as a percentage. For the melt curve step, the ramp is
defined as a temperature increment. In the graphical view of the thermal profile, the ramp
is indicated by a diagonal line.

Speed at which the temperature ramp occurs during the instrument run. Available ramp
speeds include fast and standard.

» For optimal results using the fast ramp speed, Applied Biosystems recommends
using TagMan® Fast reagents in your PCR reactions.

* For optimal results using the standard ramp speed, Applied Biosystems
recommends using standard reagents in your PCR reactions.

IMPORTANT! TagMan Fast reagents are not supported for genotyping or
presence/absence experiments.

A plot of raw fluorescence signal (not normalized) for each optical filter.
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reaction mix

reagents

real-time PCR

reference sample

refSNP ID

regression
coefficients

regression line

reject well

relative standard
curve method

Remote Monitor

Glossary

A solution that contains all components to run the PCR reaction, except for the template
(sample, standard, or control).

The PCR reaction components you are using to amplify the target and to detect
amplification. Types of reagents used on the StepOne"" and StepOnePlus™ systems:

+ TagMan® reagents
+ SYBR® Green reagents
* Other reagents

Process of collecting fluorescence data during PCR. Data from the real-time PCR are used
to calculate results for quantitation experiments or to troubleshoot results for genotyping
or presence/absence experiments.

In relative standard curve and comparative C (AAC;) experiments, the sample used as the
basis for relative quantitation results. Also called the calibrator.

Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National
Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the
Applied Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called
an rs number.

Values calculated from the regression line in standard curves, including the R? value,
slope, and y-intercept. You can use the regression coefficients to evaluate the quality of
results from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m [log (Qty)] + b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

An action that the software performs during analysis to remove one or more wells from
further analysis if a specific flag is applied to the well. Rejected wells contain results
calculated up to the point of rejection.

Method for determining relative target quantity in samples. With the relative standard
curve method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples, in a reference sample, and in a standard dilution series.
Measurements are normalized using the endogenous control. Data from the standard
dilution series are used to generate the standard curve. Using the standard curve, the
software interpolates target quantity in the samples and in the reference sample. The
software determines the relative quantity of target in each sample by comparing target
quantity in each sample to target quantity in the reference sample.

A feature in the StepOne'™ software that allows you to monitor a StepOne™ or
StepOnePlus'™ instrument over the network. With the Remote Monitor, you can monitor
the instrument status, send an experiment to the instrument, monitor amplification plots
and temperature plots in real time, and download the results to your computer. You cannot
operate the StepOne or StepOnePlus instrument using the Remote Monitor.
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replicate group

replicates

reporter

reverse primer
reverse
transcriptase
Rn

ROX™ dye

rs number

run method

sample

Sample DNA (10X)

Sample Library

Sample or Standard
(10X)

sample/SNP assay
reaction

sample/target

A set of identical reactions in an experiment.

Total number of identical reactions containing identical components and identical
volumes.

Fluorescent dye used to detect amplification. If you are using TagMan® reagents, the
reporter dye is attached to the 5" end. If you are using SYBR® Green reagents, the reporter
dye is SYBR® Green dye.

An oligonucleotide that flanks the 3’ end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR
reaction to perform 1-step RT-PCR.

See normalized reporter (Rn).

A dye supplied by Applied Biosystems and precalibrated on the StepOne"™ and
StepOnePlus™ systems. ROX dye is used as the passive reference.

See refSNP ID.

Definition of the reaction volume and the thermal profile for the StepOne"™ or
StepOnePlus'™ instrument run.

The template that you are testing.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample DNA is
added to the reaction mix at a 10X concentration. For example, if the reaction volume is
20 pL, the calculated volume of sample for 1 reaction is 2 uL.

In the StepOne™ software, a collection of samples. The Sample Library contains the
sample name and the sample color.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample or
standard is added to the reaction mix at a 10X concentration. For example, if the reaction
volume is 20 pL, the calculated volume of sample or standard for 1 reaction is 2 uL.

In genotyping experiments, the combination of which sample to test and which SNP assay
to perform in one PCR reaction. Each PCR reaction can contain only one sample and one
SNP assay.

In quantitation experiments, the combination of which sample to test and which target to

reaction detect and quantify in one PCR reaction. In the Design Wizard, you can detect and
quantify only one target in one PCR reaction. Use Advanced Setup to detect and quantify
more than one target in one PCR reaction.
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serial factor

series

slope

SNP

SNP assay

SNP Assay Library

spatial calibration

stage

standalone layout

standard

standard curve

Glossary

In the StepOne™ software, a numerical value that defines the sequence of quantities in the
standard curve. The serial factor and the starting quantity are used to calculate the
standard quantity for each point in the standard curve. For example, if the standard curve
is defined with a serial factor of 1:10 or 10X, the difference between any 2 adjacent points
in the curve is 10-fold.

See standard dilution series.

Regression coefficient calculated from the regression line in the standard curve. The slope
indicates the PCR amplification efficiency for the assay. A slope of —3.32 indicates 100%
amplification efficiency. See also amplification efficiency (EFF%) and regression line.

Abbreviation for single nucleotide polymorphism. The SNP can consist of a base
difference or an insertion or deletion of one base.

Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP
and two probes to detect different alleles.

In the StepOne "™ software, a collection of SNP assays to add to genotyping experiments.
The SNP assays in the library contain the SNP assay name, SNP assay color, and for each
allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP assays in
the library may also contain the assay ID and comments about the SNP assay.

Type of StepOne™ and StepOnePlus™ system calibration in which the system maps the
positions of the wells in the sample block(s). Spatial calibration data are used so that the
software can associate increases in fluorescence during a run with specific wells in the
reaction plate.

In the thermal profile, a group of one or more steps. There are three types of stages:
holding stage (including pre-PCR read and post-PCR read), cycling stage (also called
amplification stage), and melt curve stage.

A system layout in which the StepOne™ or StepOnePlus™ instrument is not connected to
a computer by the yellow cable. In this layout, you control the instrument only with the
instrument touchscreen, and you use a USB drive or network connection to transfer data
between the instrument and computer.

Sample that contains known standard quantities. Standard reactions are used in
quantitation experiments to generate standard curves. See also standard curve and
standard dilution series.

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C; values from the standard reactions plotted
against standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the standard
curve reactions are used to generate the standard curve. The standard curve is
defined by the number of points in the dilution series, the number of standard
replicates, the starting quantity, and the serial factor. See also standard dilution
series.
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Glossary

standard curve
method

standard dilution
series

standard quantity

starting quantity

step

SYBR® Green
reagents

Method for determining absolute target quantity in samples. With the standard curve
method, the StepOne"™ software measures amplification of the target in samples and in a
standard dilution series. Data from the standard dilution series are used to generate the
standard curve. Using the standard curve, the software interpolates the absolute quantity
of target in the samples. See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards containing a
range of known quantities. The standard dilution series is prepared by serially diluting
standards. For example, the standard stock is used to prepare the first dilution point, the
first dilution point is used to prepare the second dilution point, and so on. In the StepOne™
software, the volumes needed to prepare a standard dilution series are calculated by the
number of dilution points, the number of standard replicates, the starting quantity, the
serial factor, and the standard concentration in the stock. See also standard curve.

A known quantity in the PCR reaction.

* In standard curve experiments, the quantity of target in the standard. In the
StepOne™™ software, the units for standard quantity can be for mass, copy number,
viral load, or other units for measuring the quantity of target.

* In relative standard curve experiments, a known quantity in the standard. Standard
quantity can refer to the quantity of cDNA or the quantity of standard stock in the
PCR reaction. The units are not relevant for relative standard curve experiments
because they cancel out in the calculations.

When defining a standard curve in the StepOne"" software, corresponds to the highest or
lowest quantity.

A component of the thermal profile. For each step in the thermal profile, you can set the
ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration),
and you can turn data collection on or off for the ramp or the hold parts of the step. For
cycling stages, a step is also defined by the AutoDelta status. With StepOnePlus™
systems, which contain the VeriFlex™ blocks, each step contains 6 temperatures (1 for
each VeriFlex block).

PCR reaction components that consist of two primers designed to amplify the target and
SYBR® Green dye to detect double-stranded DNA.

138 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard

Curve Experiments



system dye

TaqMan® reagents

target

target color

Target Library

task

Glossary

Dye supplied by Applied Biosystems and precalibrated on the StepOne™ or
StepOnePlus"™ system. Before you use system dyes in your experiments, make sure the
system dye calibration is current in the Instrument Maintenance Manager.

System dyes on the StepOne system:
« FAM™ dye
+ JOE™ dye
+ ROX™ dye
+ SYBR® Green dye
+ VIC® dye
System dyes on the StepOnePlus system:
« FAM"™ dye
« JOE™ dye
« NED™ dye
+ ROX™ dye
+ SYBR® Green dye
+ TAMRA™ dye
+ VIC® dye

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne”™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus™ system.

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence that you want to amplify and detect.

In the StepOne ™ software, a color assigned to a target to identify the target in the plate
layout and analysis plots.

In the StepOne™ software, a collection of targets to add to experiments. The targets in the
library contain the target name, reporter, quencher, and target color. The target in the
library may also contain comments about the target.

In the StepOne™ software, the type of reaction performed in the well for the target or SNP
assay. Available tasks:

* Unknown

* Negative Control

 Standard (standard curve and relative standard curve experiments)
* Positive control (genotyping experiments)

+ [PC (presence/absence experiments)

» Blocked IPC (presence/absence experiments)
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Glossary

temperature plot

template

thermal profile

threshold

threshold cycle (C,)

Tm
touchscreen

unknown

unknown-IPC wells

In the StepOne ™ software, a display of temperatures for the sample, instrument cover, and
instrument block during the StepOne™ or StepOnePlus"™ instrument run.

In the Design Wizard of the StepOne"" software (and in QuickStart for quantitation
experiments), the type of nucleic acid to add to the PCR reaction. The recommended
template varies according to experiment type:

* Quantitation experiments (standard curve, relative standard curve, and comparative
C1) — cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)

For quantitation experiments, the template type selection affects the run method,
reaction setup, and materials list.

* Genotyping experiments — Wet DNA (gDNA or cDNA) or dry DNA (gDNA or
cDNA)

For genotyping experiments, the template type selection affects the reaction setup.
* Presence/absence experiments - DNA

For presence/absence experiments, Applied Biosystems recommends adding DNA
templates to the PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the StepOne™ or StepOnePlus™ instrument run.

1. In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic Cy) or can be set manually (see manual Cy).

2. In presence/absence experiments, the level of fluorescence above which the
StepOne™ software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the amplification
plot.

See melting temperature (Tm).
Instrument display that you touch to control the StepOne" or StepOnePlus™ instrument.

In the StepOne™ software, the task for the target or SNP assay in wells that contain the
sample you are testing:

* In quantitation experiments, the task for the target in wells that contain a sample
with unknown target quantities.

* In genotyping experiments, the task for the SNP assay in wells that contain a sample
with an unknown genotype.

 In presence/absence experiments, the task for the target in wells that contain a
sample in which the presence of the target is not known.

In presence/absence experiments, wells that contain a sample and internal positive control
(IPC).
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VeriFlex™
Technology

y-intercept

Zone

zone boundary

Glossary

The StepOnePlus™ instrument contains six independently thermally regulated VeriFlex
blocks, creating up to six different zones for the 96 sample wells. After you enable the
VeriFlex blocks in the StepOne™ software, you can set a different temperature for one or
more of the VeriFlex blocks.

In the standard curve, the value of y where the regression line crosses the y-axis. The y-
intercept indicates the expected threshold cycle (C;) for a sample with quantity equal to 1.

One of up to six sample temperatures among the 96 wells formed by independently
thermally regulated VeriFlex'" blocks during the StepOnePlus™ instrument run. You can
set a different temperature for one or more of the VeriFlex blocks, or you can set the same
temperature for each of the VeriFlex blocks.

Note: For melt curve steps, you need to set the same temperature for each of the
VeriFlex blocks.

The edge of a zone for samples formed by the six independently thermally regulated
VeriFlex"™ blocks. In the StepOne™ software, the zone boundaries are displayed in the
plate layout as thick red lines.
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Numerics
1-step RT-PCR 7, 24, 32, 37
2-step RT-PCR 7, 11, 24

A
Advanced Setup 9, 10, 24, 30, 56, 116

alternate experiment workflows. See workflows.

amplification efficiency 28, 92

Amplification Plot screen
monitor during a run 70
view after a run 92

amplification plot, typical 96
AMPNC flag 107

analysis screens
Amplification Plot screen 92
Multicomponent Plot screen 109
Multiple Plots screen 89
navigation tips 88
QC Summary screen 106
Raw Data Plot screen 112
software elements 85
Standard Curve screen 90
Well Table 99

analysis settings
advanced 105
baseline 105
CT 105
flag 105
threshold 105
view 104

analyze experiment
analyze 84

for more information 92, 98, 101, 105, 107, 109,

111, 113

guidelines 85, 92, 96, 101, 105, 107, 109, 111, 113

omit wells 108
publish the data 102
view Amplification Plot screen 92
view analysis settings 104
view Multicomponent Plot screen 109
view Multiple Plots screen 89
view QC Summary screen 106
view Raw Data Plot screen 112
view Standard Curve screen 90
view Well Table 99
workflow 82
Applied Biosystems
contacting xii
customer feedback on documentation xii

Index

Technical Support xii

Applied Biosystems StepOne Real-Time PCR System.

See StepOne system.
assumptions for using this guide viii

B

BADROX flag 107

baseline
correct values 96
examples 98
manually adjust 105

biohazardous waste, handling xx
BLFAIL flag 107

C

CAUTION, description xiii
chemical safety xviii
chemical waste safety xix
colocated layout
data transfer 77
monitoring 69
startup 65
consumables
Also see materials required 4
supported 4
conventions used in this guide viii
create new experiment 17
CT 101
CTFAIL flag 107
Custom assays 37

customer feedback, on Applied Biosystems
documents xii

D

DANGER, description xiii

data
about data collection 2
example experiment 9, 84
publish 102
transfer 76

design experiment
create new 17
define experiment properties 20
define methods and materials 22
finish Design Wizard 42

for more information 22, 24, 26, 28, 31, 33, 38, 41,
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Index

44

guidelines 21, 23, 26, 28, 30, 32, 37, 41, 44
order materials 38
review reaction setup 33
set up run method 31
set up samples 29
set up standards 27
set up targets 25
software elements 18
workflow 16

Design Wizard
Experiment Properties screen 20
finish 42
Materials List screen 38
Methods & Materials screen 22
Reaction Setup screen 33
Run Method screen 31
Samples screen 29
software elements 18
Standards screen 27
Targets screen 25

deviation, standard 97

documentation, related ix

E

electrical safety xx
electromagnetic compatibility standards. See EMC
standards

EMC standards xxii
ergonomics, safety xxii
example experiment

analyze 82

data 12

data location 12

description 10

design 16

name 20

prepare 46

run 60

workflow 13
Experiment Properties screen 20
EXPFAIL flag 107
Export/Import 10, 121

F

flag 101
flags
analysis settings 105
in standard curve experiments 107

G

General xxi

guidelines
analysis 85, 92, 96, 101, 105, 107, 109, 111, 113
chemical safety xviii

chemical waste disposal xix

chemical waste safety xix

design 21, 23, 26, 28, 30, 32, 37, 41, 44
preparation 48, 50, 52, 56

run 64

H

hazard icons. See safety symbols, on instruments
hazard symbols. See safety symbols, on instruments
hazards. See safety

Help system, accessing xi

HIGHSD flag 107

installation category xxi
instrument operation, safety xvii
Inventoried assays 37

L

library 32
load reaction plate 62

M

Made to Order assays 37
Materials List screen 38
materials required 47, 49, 51, 54
Methods & Materials screen 22
monitor run
Amplification Plot screen 70
colocated layout 69
Run Method screen 72
standalone layout 75
standalone layout (remote) 73
Temperature Plot screen 71
moving and lifting, safety xvii
MSDSs
description xviii
obtaining xviii
MSDSs, obtaining xii
MTP flag 107
Multicomponent Plot screen 109
Multiple Plots screen 89
multiplex PCR 6, 24

N

navigation tips
display multiple plots 89
select wells 88

negative control, component of experiment 6
NOAMP flag 107
NOISE flag 107
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Index

NOSIGNAL flag 107 alerts 72
notification settings 63 enable notification settings 63
for more information 63, 72, 73
0 guidelines 64
monitor 69
OFFSCALE flag 107 prepare for 61
omit wells 108 start 65

transfer data 76
workflow 60

Run Method library 32

Run Method screen 31
monitor during a run 72

online Help. See Help system
order materials 38

other fluorescent-based reagents 9
OUTLIERRG flag 107

outliers. See omit wells.

overvoltage category (rating) xxi S
P safety
before operating the instrument xvii

prepare experiment biological hazards xxi

for more information 48, 53, 57 chemical xviii

guidelines 48, 50, 52, 56 chemical waste xix

reaction mix conventions xiii

prepare 51 electrical xx

reaction plate 53 ergonomic xxii

sample dilutions 47 guidelines xviii, xix, xx

standard dilution series 49 Instrument operation Xxvii

workflow 46 moving and lifting instrument xvii

moving/lifting xvii
repetitive motion xxii
standards xxii

prepare for run 61
print reaction setup instructions 36

publish data 102 workstation xxii
safety labels, on instruments xvi
Q safety standards xxii
QC Summary screen 106 safety symbols, on instruments xv
QuickStart 10, 117 sample dilutions
calculated volumes 36, 47
R prepare 47
Sample screen 29
radioactive waste, handling xx samples
ramp speed 22, 24 design guidelines 30
Raw Data Plot screen 112 dilutions 47
reaction mix sample reactions (unknowns) 55
calculated volumes 34 setup 29
volumes 51 select wells 88
reaction plate singleplex PCR 6, 24
layout 42 software elements
load 62 analysis screens 85
prepare 53 Design Wizard 18
unload from the instrument 76 SPIKE flag 107
Reaction Setup screen 33 standalone layout
reagents data transfer 78
other fluorescent-based 9 monitoring 75
SYBR Green 8§ remote data transfer 77
TagMan 8§ Remote Monitor 73
repetitive motion, safety xxii startup 66
replicate, component of experiment 6 standard curve experiments
results, interpreting 83 about 6
run experiment standard deviation, effect of threshold on 97
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Standard 145

Curve Experiments



Index

standard dilution series
calculated volumes 35
component of experiment 6
prepare 49
standards
component of experiment 6
design guidelines 28
diluting 49
EMC xxii
safety xxii
setup 27
Set Up Standards checkbox 25, 26
standard reactions 55
Standards screen 27
start run
colocated layout 65
standalone layout 66
StepOne system
consumables 4
data collection 2
filters 3, 113
layouts 65, 69, 76
reagents 8§
SYBR Green reagents 3, 8, 24, 26, 37, 113

symbols, safety xv

T

TagqMan reagents 3, 8, 23, 24, 26, 37, 113
targets
design guidelines 26
setup 25
Targets screen 25
Technical Support, contacting xii
Temperature Plot screen 71
Template 10, 119
template. See samples.
text conventions viii
THOLDFAIL flag 107
threshold
correct values 96
examples 97
manually adjust 105
training, information on xii
transfer data 76
troubleshooting
adjust baseline 105
adjust threshold 105
flags 107
omit wells 108
view analysis settings 104
view Multicomponent Plot screen 109
view QC Summary screen 106
view Raw Data Plot screen 112

U

unload instrument 76
user attention words, described viii
using this guide

as a tutorial 9

with your own experiments 9

W

WARNING, description xiii

waste disposal, guidelines xx
waste profiles, description xx
Well Table 99

wells
negative control 29, 42, 53
omit 108
selecting 88
standard 29, 42, 53
unknown 29, 42, 53

workflows
Advanced Setup 116
example experiment 13
Export/Import 10, 121
QuickStart 10, 117
Template 10, 119

workstation safety xxii
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